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Preface

This IBM® Redbook focuses on the 4Gb end-to-end Fibre Channel (FC) SAN 
solution for the IBM BladeCenter® in the small to mid-sized businesses (SMB) 
and enterprise workgroup market.

In this IBM Redbook, we discuss the elements for constructing a BladeCenter 
SAN environment. We talk about the supported FC daughter cards, FC switch 
modules, external FC switches, and storage systems used in our lab 
environment. These items were used to construct an OEM environment to 
demonstrate the use of our storage vendor products and the interoperability of 
the IBM BladeCenter FC switch modules.

This IBM Redbook discusses the prerequisites, the installation, and the 
configuration of QLogic, McData, and Brocade switch modules in a 
homogeneous environment, as well as heterogeneous environments.

The team that wrote this IBM Redbook
This IBM Redbook was produced by a team of specialists from around the world 
working at the International Technical Support Organization, Poughkeepsie 
Center.

Rufus Credle is a Certified Consulting IT Specialist at the ITSO, Raleigh Center. 
In his role as project leader, he conducts residencies and develops Redbooks™ 
about network operating systems, ERP solutions, voice technology, high 
availability and clustering solutions, Web application servers, pervasive 
computing, and IBM and OEM e-business applications, all running on IBM 
System x™, xSeries®, and IBM BladeCenter. Rufus' various positions during his 
IBM career have included assignments in administration and asset management, 
systems engineering, sales and marketing, and IT services. He holds a BS 
degree in business management from Saint Augustine's College. Rufus has 
been employed at IBM for 26 years.

Khalid Ansari is the Technical Team Lead for the IBM Blade Infrastructure 
Solution Center team in Research Triangle Park, N.C. His responsibilities include 
assisting BladeCenter pre-sale customers world-wide with new proof of concepts 
and pilot testing. He has developed numerous technical documents and best 
practices procedures for BladeCenter complex technology solutions. He was a 
participant in developing the IBM Storage Networking Solutions V1 Certification. 
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Fabrics. Nikolaos has 12 years of computer and networking experience, including 
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Chapter 1. Executive summary

This IBM Redbook provides you with solutions that incorporate the advanced 
features of the IBM BladeCenter. These solutions address the most common 
objectives of today's information technology (IT) departments for the small to 
mid-sized businesses (SMB) and enterprise workgroup market.

Efficiency and managing the bottom line continue to serve as the paramount to 
success. Your IT infrastructure is required to do more than ever before under 
tighter budgets. Your IT needs to do it in less time, with less space. You need to 
meet increasing user demands for greater availability and higher quality of 
services. And you need to get it all done with a smaller and less-skilled staff. The 
BladeCenter 4Gb SAN solution helps you address all of these issues.

The IBM BladeCenter 4Gb SAN solution offers new, powerful SAN technology 
that brings further simplification and lower cost-of-ownership to the data center. 
Strategic relationships with technology providers, such as Brocade, Cisco, EMC, 
Emulex, McDATA, and QLogic, are providing customers with unparalleled 
performance as they migrate to IBM BladeCenter.

You should understand the following about IBM BladeCenter SAN technology:

� IBM BladeCenter can help customers maximize server utilization with a wide 
range of cost-effective scale-out solutions.

� With over 400 leading ISV applications for customers to choose from, IBM's 
extensive network of Business Partners makes it easy for customers to meet 
all their business and IT solution needs.
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� Because IBM BladeCenter is designed with open standards in mind, servers 
can talk to servers that can talk to printers that can talk to storage, enabling 
end-to-end integration.

� IBM BladeCenter is affordably priced and offers small and mid-sized 
companies choice, outstanding performance, and revolutionary scalability to 
help build a flexible IT environment.

� The IBM BladeCenter 4Gb SAN solution provide an infrastructure for: 

a. Fully redundant storage connectivity

b. Resilient storage requirements - hot pluggable and swappable

c. Remote management

d. Remote boot

e. Homogeneous and heterogeneous operating environment

� The 4Gbps Fibre Channel technology will be rapidly deployed in 
environments with streaming video on demand applications, medical facilities 
that exchange imagery and data over long distances, and organizations that 
require data mining and data warehousing, thus providing complete return on 
investment.

If you are interested in deploying an IBM BladeCenter SAN solution, please 
contact IBM Customer Service. 

Resources can be found at the following IBM Web sites:

� IBM BladeCenter

http://www-03.ibm.com/systems/bladecenter/

� IBM BladeCenter Alliance Program

http://www-03.ibm.com/servers/eserver/bladecenter/alliance/

� IBM Storage for IBM BladeCenter

http://www-03.ibm.com/servers/eserver/bladecenter/storage/
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Chapter 2. IBM BladeCenter

In this chapter, we discuss the IBM BladeCenter and BladeCenter H chassis, 
shown in Figure 2-1 on page 4. Both units offer an extended range of storage 
and networking options integrated into the chassis to simplify infrastructure 
complexity and manageability. As you continue to explore this IBM Redbook, you 
will see that IBM delivers a wide range of easy-to-install, high-capacity, tested 
storage products that will meet your demanding business needs. 

2
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Figure 2-1   IBM BladeCenter models

 

IBM BladeCenter H

IBM BladeCenter
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2.1  IBM BladeCenter

The BladeCenter provides the greatest density and common fabric support and 
is the lowest entry cost option. The other two members of the family, BladeCenter 
T and BladeCenter H, provide additional flexibility for difficult environmental 
needs and greater performance levels. All three chassis share a common set of 
blades and switches. For our SAN discussion, we will focus only the BladeCenter 
and BladeCenter H chassis.

The IBM BladeCenter include the following features:

� Rack-optimized, 7 U modular design enclosure for up to 14 hot-swap HS20, 
HS21, JS20, JS21, or LS20 blades and up to seven HS40 blades

� High-availability mid-plane that supports hot-swap of individual blades

� Two 2,000-watt, hot-swap power modules and support for two optional 
2,000-watt power modules; redundancy and power for robust configurations

� Two hot-swap blowers

� A new Advanced Management Module (AMM) gives you control over the 
solutions at the chassis level, simplifying installation and management of 
everything in your installation

� Support for up to four network or storage switches or pass-through modules

� Light path diagnostic panel with DVD, diskette drive, and USB port

� IBM Director and Remote Deployment Manager for easy installation and 
management 

For a complete look at the IBM BladeCenter chassis, visit this Web site:

http://www-306.ibm.com/common/ssi/rep_ca/7/897/ENUS106-117/ENUS106-117.
PDF

2.2  IBM BladeCenter H
The BladeCenter H Chassis is slightly larger than the IBM BladeCenter. It is 
designed to support new high-speed fabrics and future Ethernet and InfiniBand 
technology. The BladeCenter H supports up to 10 switch modules.

The IBM BladeCenter H include the following features:

� The rack-optimized, 9 U modular design enclosure holds up to 14 blade 
servers.
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� A high-availability, redundant midplane supports all current and future IBM 
blades.

� The chassis includes:

– Two 2,900-watt, hot-swap, redundant power modules and support for two 
additional (optional) 2,900-watt, hot-swap, redundant power modules 

– Two hot-swap, redundant blowers and 6 or 12 supplemental fans 

� The brand new Advanced Management Module (AMM) gives you control over 
the solutions at the chassis level, simplifying installation and management of 
everything in your installation.

� The chassis supports up to four traditional fabrics using networking switches, 
storage switches, or pass-through devices. The chassis also supports up to 
four new high-speed fabrics for future support of protocols like 4X Infiniband 
or 10 Gb Ethernet. The built-in media tray is client serviceable and includes 
light path diagnostics, front USB inputs, and a DVD drive.

� IBM Director and Remote Deployment Manager makes it easy to install and 
manage. 

The blades servers supported by this new BladeCenter Chassis are:

� BladeCenter HS20, BladeCenter HS21, and BladeCenter HS40

� AMD Opteron LS20 for IBM BladeCenter

� BladeCenter JS20, BladeCenter JS21 

These blades feature Xeon® DP, Xeon MP, PowerPC®, and Opteron capable 
models. 

For a complete look at the IBM BladeCenter H chassis, visit this Web site:

http://www-306.ibm.com/common/ssi/rep_ca/1/897/ENUS106-161/ENUS106-161.
PDF

2.3  The IBM ServerProven Program
The IBM ServerProven® Program is based on this simple idea: Give customers 
the confidence that all parts of their solution hardware, software, and middleware 
installs quickly, start up easily, and runs reliably. When you see the ServerProven 
emblem, you will know that the software application you are looking for is part of 
a complete business solution that has been identified, validated, optimized, and 
documented to run reliably on IBM servers. 
6 IBM BladeCenter 4Gb SAN Solution
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The ServerProven program helps you easily identify a business application that 
has been validated on IBM servers. This includes non-IBM hardware devices, 
operating systems, and middleware, such as databases and systems 
management software and popular applications.

Therefore, take a minute to visit the IBM ServerProven Program Web site as you 
plan to implement your business solution on either IBM BladeCenter or 
BladeCenter H:

http://www-03.ibm.com/servers/eserver/serverproven/compat/us/
 Chapter 2. IBM BladeCenter 7

http://www-03.ibm.com/servers/eserver/serverproven/compat/us/


8 IBM BladeCenter 4Gb SAN Solution



Chapter 3. Elements of the IBM 
BladeCenter 4Gb SAN 
solution

This chapter discusses the elements to help you implement a successful 
BladeCenter SAN business solution.

3
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3.1  Fibre Channel 4Gb expansion cards

In this section, we review the supported 4Gb Fibre Channel expansion cards for 
the IBM BladeCenter.

3.1.1  QLogic 4Gb Standard and Small Form-Factor (SFF) Fibre 
Channel Expansion Cards for IBM BladeCenter

The QLogic 4Gb Fibre Channel expansion cards provide a higher bandwidth 
connection between BladeCenter server blades and SAN switches. These 4Gb 
expansion cards allow for a true end-to-end 4Gb Fibre Channel blade server to 
SAN solution. Both expansion cards are built with QLogic ISP2422 4Gb Fibre 
Channel dual port ASIC. 

Available in two form factors, the SFF expansion card allows two drives and a 
card to coexist on the same blade server. The SFF adapter is available for the 
8843 and 8850 Blade Servers.

The 4Gb adapter provides the ability to boot from a SAN attached drive on Intel, 
AMD Opteron, and PowerPC based blade servers. The firmware contained on 
the adapter is a multi-boot option ROM that consists of BIOS, Fcode, and 
Firmware for the ISP2422 ASIC. The BIOS software is used on the HS20, HS40, 
and LS20 blades to enable the Ctrl-Q utility available during initial boot up of the 
Blade. Open Firmware Fcode is used with the JS20 Blade family to provide 
remote boot capabilities

Expansion card features:

� The Boot from SAN capabilities within the FC expansion card minimizes 
server downtime and simplifies data backup and recovery processes, thus 
lowering TCO by completely separating the server from the storage. 

� The 2-port PCI-X adapter provides a redundant connection via two 
independent FC channels from each server blade to the SAN fabric.

� Includes QLogic SANsurfer Management Suite that is used to manage both 
the FC expansion card and QLogic FC switch module for easy configuration 
and management of the SAN through a single management interface.

� Supports host-attachment to 2 and 4Gbs BladeCenter Fibre Channel Switch 
Modules. This includes all QLogic, McDATA, and Brocade switch modules.

Table 3-1 on page 11 shows the product and order information for these cards.
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Table 3-1   Product and order information

The BladeCenter switch module options shown in Table 3-2 are supported by this 
expansion card.

Table 3-2   Supported switch modules

Description Order number

QLogic 4Gb Standard Fibre Channel Expansion Card 26R0884

QLogic 4Gb Standard and Small Form-Factor (SFF) 
Fibre Channel Expansion Card

26R0890

Option part# Product name Speed support

32R1904/26R0081 QLogic 4Gb Fibre Channel 
Switch Modules 

2 Gb, 4 Gb

32R1905/32R1833 McDATA 4Gb Fibre 
Channel Switch Modules

2 Gb, 4 Gb

32R1812/32R1813 Brocade 4Gb SAN Switch 
Modules

2 Gb, 4 Gb

48P7062 IBM BladeCenter 2-Port 
Fibre Channel Switch 
Module

2 Gb

26K6477 QLogic 6-Port Enterprise 
Fibre Channel Switch 
Module

2 Gb

32R1790 McDATA 6-Port Fibre 
Channel Switch Module

2 Gb

26K5601 Brocade Entry SAN Switch 
Module

2 Gb

90P1065 Brocade Enterprise SAN 
Switch Module

2 Gb

02R9080 IBM BladeCenter Optical 
Pass-through

2 Gb
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The BladeCenter platforms shown in Table 3-3 are supported by this expansion 
card.

Table 3-3   Supported BladeCenter platforms

Driver update disks
Refer to the IBM BladeCenter Support Web site to download files and for 
installation instructions.

The Fibre Channel Expansion Card Signed device driver for Microsoft® 
Windows® 2000 and Windows Server® 2003 - BladeCenter HS20, HS40 and 
LS20 can be found at:

http://www-307.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-532
95

The 4Gb Linux® Driver Update Disks for SAN boot can also be located at this 
Web site. 

3.1.2  Emulex 4Gb SFF Fibre Channel Expansion Card

The Emulex 4Gb SFF Fibre Channel Expansion Card available for IBM 
BladeCenter is an addition to the family of IBM BladeCenter expansion cards that 
deliver a higher bandwidth connection between BladeCenter server blades and 
SAN switches, and allows for a true end-to-end 4Gb Fibre Channel blade server 

IBM BladeCenter Machine type

HS20 8843

HS20 8678 (std HBA)

HS20 8832 (std HBA)

HS20 7981

HS21 8853

LS20 8850

JS21 8844

BladeCenter 8677

BladeCenter T 8720

BladeCenter T 8730

BladeCenter H 8852
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to a storage area network (SAN) solution. It is built based on the Emulex Helios 
Fibre Channel controller.

The Emulex 4Gb 2-port SFF Fibre Channel Expansion Card is the latest Fibre 
Channel expansion card option for the BladeCenter. 

Expansion card features:

� Universal boot provides multi-platform support for remote.

� Firmware-based architecture enables host bus adapters (HBAs) to be 
updated with new features and functionality, maintaining investment value.

� Includes Emulex HBAnyware management suite, which provides discovery, 
reporting, and management of local and remote HBAs. 

� Sophisticated management capabilities, such as remote firmware upgrades 
and advanced diagnostics, are possible from a single console anywhere in 
the SAN.

Each server blade can be installed with one or more expansion cards to provide 
redundant connections to the switch modules within BladeCenter. The routing of 
the expansion card's two ports occurs through the BladeCenter's midplane to the 
switch modules. One port from the expansion card is wired via the midplane to 
one switch module bay, while the other port is wired to a second switch module 
bay to provide redundancy against a single point of failure. The expansion card 
provides support for 1Gb, 2Gb, and 4Gb data rates. 

Table 3-4 shows the product and order information for this card.

Table 3-4   Product and order information

For more information regarding the Emulex technology, visit the following Web 
site: 

http://www.emulex.com/

Description Order Number EAN Number

Emulex 4Gb SFF Fibre 
Channel Expansion Card

39Y9186 50-50689 for BladeCenter
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Table 3-5 shows the BladeCenter switch module options supported by this 
expansion card.

Table 3-5   Supported switch modules

The BladeCenter platforms shown in Table 3-6 are supported by this expansion 
card.

Table 3-6   Supported BladeCenter platforms

Option part# Product name Speed support

32R1904/26R0081 QLogic 4Gb Fibre Channel Switch 
Modules 

2 Gb, 4 Gb

32R1905/32R1833 McDATA 4Gb Fibre Channel Switch 
Modules

2 Gb, 4 Gb

32R1812/32R1813 Brocade 4Gb SAN Switch Modules 2 Gb, 4 Gb

48P7062 IBM BladeCenter 2-Port Fibre 
Channel Switch Module

2 Gb

26K6477 QLogic 6-Port Enterprise Fibre 
Channel Switch Module

2 Gb

32R1790 McDATA 6-Port Fibre Channel 
Switch Module

2 Gb

26K5601 Brocade Entry SAN Switch Module 2 Gb

90P1065 Brocade Enterprise SAN Switch 
Module

2 Gb

02R9080 IBM BladeCenter Optical 
Pass-through

2 Gb

IBM BladeCenter Machine type

HS20 8843

HS20 7981

HS21 8853

LS20 8850

JS21 8844

BladeCenter 8677

BladeCenter T 8720
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Driver update disks
Refer to the IBM BladeCenter support Web site to download files and for 
installation instructions:

http://www-307.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-630
17

3.2  Integrated Fibre Channel switch modules
In this section, we discussed the supported integrated Fibre Channel switch 
modules for the IBM BladeCenter and BladeCenter H.

3.2.1  Brocade 10-Port and 20-Port 4Gb SAN Switch Module 

The Brocade 4Gb SAN switch modules enable and enhance BladeCenter SAN 
infrastructures by building end-to-end 4Gb Fibre Channel SAN solutions with 
numerous advanced features to enhance the security, performance, availability, 
and management. The Brocade switch modules seamlessly integrate an IBM 
BladeCenter chassis into any Brocade SAN fabrics. 

The 10-port switch module allows connection for up to seven internal blade 
servers and three external ports while the 20-port switch module allows 
connection to all 14 internal ports and six external ports. The 10-port switch 
module is upgradeable to the 20-port version with a simple pay-as-you-grow 
scalability via a license key. 

Table 3-7 shows the product and order information for these modules.

Table 3-7   Product and order information

BladeCenter T 8730

BladeCenter H 8852

IBM BladeCenter Machine type

Description Order number

Brocade 10-Port 4Gb SAN Switch Module 32R1813

Brocade 20-Port 4Gb SAN Switch Module 32R1812
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Figure 3-1 shows the Brocade 10-Port and 20-Port 4Gb SAN Switch Module.

Figure 3-1   Brocade 10-Port and 20-Port 4Gb SAN Switch Module

Features
� Ports on Demand (POD) scaling from 10 to 20 ports on a pay-as-you-grow 

basis

– Ports 0, 1-7, 15, and 16 are activated by default on the 10 Port Module.

– Ports 8-14, 17-19 activated with a 10 Port Upgrade license for the 10 Port 
Module.

– Ports 0-19 are activated by default on the 20 Port Module.

� 14 internal ports (ports 1 to 14) connect to IBM BladeCenter server blades

– Auto-sensing at 2 Gbps or 4 Gbps and server blades log into the switch as 
F-ports (requires optional Fibre Channel Expansion Card installed on 
server blade).

� Six external ports (ports 0, 15, 16, 17, 18, and 19)

– Connect to existing Fibre Channel SAN switches, other Brocade FC 
Switch modules, or directly to Fibre Channel Storage devices.

– Auto-negotiate link speed (1Gbps, 2Gbps, or 4Gbps).

– U-port initialization (E-port, F-port, or FL-port).

– Can form up to two 12 Gbps ISL Trunks (requires ISL Trunking license).

– Dynamic Path Selection (DPS) for improved load balancing the 24 Gbps of 
available external bandwidth between the two ISL Trunk groups.

� Two internal full-duplex 100Mbps Ethernet interfaces, terminated at a single 
MAC

� Hot code activation
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� Frame-filtering technology that enables Advanced Zoning and Advanced 
Performance Monitoring capabilities

� Integrated security features, including SSH (secure shell), SSL/HTTPS, 
Radius Support, SNMPV3, Audit Logging, and Role Based Access Control 
(RBAC)

� Redundant power and cooling provided by IBM BladeCenter chassis 

Standard and optional features
The Brocade 4Gb FC Switch Module is based on the Brocade Fabric Operating 
System (Fabric OS) Version 5.0.x. As with all Brocade products, the switch 
module is backward and forward compatible with the entire Brocade SilkWorm 
product family, including the IBM TotalStorage® b-type SAN switches and 
directors that are built on Brocade technology. As a member of the Brocade 
product line, the switch module offers numerous advanced features and 
functionality that typically are offered only on more expensive director products, 
such as: 

� Advanced Web Tools (standard) provide a graphical interface that enables 
you to monitor and manage individual switches and ports from a standard 
workstation using a browser.

� Brocade Advanced Zoning (standard) ensures secure device connectivity 
through either domain/port or World Wide Node Name zoning enforced 
through hardware.

� Brocade 10-Port Upgrade (optional license feature 32R1822) upgrades the 
Brocade 10-port FC switch module to a 20-port module by nondisruptively 
adding 10 additional ports. 

� Brocade Advanced Performance Monitoring (optional license feature 
26K5612) allows very granular performance monitoring capabilities that 
include specific initiator-to-target traffic, SCSI Reads and Write per second, 
and CRC error tracking. 

� Brocade ISL Trunking (optional license feature 26K5607) enhances SAN 
performance, increases availability, and simplifies management by creating 
up to two 12 Gb trunks to the external SAN that provide granular frame-level 
load balancing. 

� Brocade Performance Bundle (optional license feature 26K5605) includes ISL 
Trunking and Advanced Performance Monitoring. 

� Brocade Dynamic Path Selection (standard) also enhances performance by 
performing exchange-level load balancing across the ISL Trunks. ISL 
Trunking and DPS together ensure a balanced 24 Gb bandwidth to external 
SAN.
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� Brocade Fabric Watch (optional license feature 32R1855) enhances SAN 
management and availability through client configurable monitors of critical 
security, statistics, and performance parameters, and sending alarms to the 
administrator to proactively catch potential problems.

� Brocade Extended Fabric (optional license feature 26K5613), when used with 
link extenders, enhances IBM Business Continuity solutions by allowing full 
FC bandwidth across extended distances up to 230 km. 

� Brocade Advanced SAN Security (optional license feature 26K5617) provides 
flexible security and policy administration that protect data from unauthorized 
access and corruption, thus helping organizations meet specific security 
requirements.

� Brocade Fabric Manager 5.0 (software product sold separately) is a graphical 
interface for monitoring and managing numerous IBM BladeCenters in 
multiple fabrics comprised of Brocade switches from a standard workstation. 
The GUI simplifies task administration at the fabric, switch, and port levels in a 
medium-to-large size Brocade SAN environment.

For more information regarding integrated Fibre Channel switches for 
BladeCenter, visit the following Web site:

http://www-03.ibm.com/systems/bladecenter/switch/switch_fibrechannel_ov
erview.html

3.2.2  McDATA 10-Port and 20-Port 4Gb Fibre Channel Switch Module
The McDATA 10-port and 20-port 4Gb Fibre Channel switches enable 
high-performing end-to-end SAN solutions using 4 Gbps Fibre Channel 
Technology. The McDATA switch modules provide a seamless integration of 
BladeCenter into McDATA Native SAN fabrics. The switches provide centralized 
McDATA management in McDATA fabrics and deliver McDATA-capable fabric 
services.

Available in two configurations, the 10-port switch provides the ability to connect 
up to seven internal blade server ports, and three external ports, while the 
20-port switch provides all internal 14 ports and six external ports. The 10-port 
switch delivers pay-as-you-grow scalability via a license key update allowing all 
20-ports to become active.

Table 3-8 on page 19 shows the description and order number for these 
modules.
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Table 3-8   Product and order information

Figure 3-2 shows the McDATA 10-Port and 20-Port Fibre Channel Switch 
Module.

Figure 3-2   McDATA 10-Port and 20-Port Fibre Channel Switch Module

Switch features
� The 10-port model has seven internal auto-sensing 2/4Gb F-Ports and three 

external auto-sensing 1/2/4Gb E/F/FL ports (upgradeable to 20 ports with 
10-port upgrade).

� The 20-port model has 14 internal auto-sensing 2/4Gb F-Ports and six 
external auto-sensing 1/2/4Gb E/F/FL ports. 

� Includes McDATA SANBrowser Web application

� Supports McDATA equivalent HotCAT functionality, allowing firmware to be 
downloaded and activated while the fabric switch remains operational. 

� Supports optional McDATA SANtegrity Security Suite software via a license 
key upgrade.

� Supported with QLogic 2Gb and 4Gb BladeCenter Fibre Channel expansion 
cards.

Description Order Number

McData 10-port 4Gb Fibre Channel Switch Module for 
IBM eServer™ BladeCenter

32R1905

McData 20-port 4Gb Fibre Channel Switch Module for 
IBM eServer BladeCenter

32R1833
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For more information regarding integrated Fibre Channel switches for 
BladeCenter, visit the following Web site:

http://www-03.ibm.com/systems/bladecenter/switch/switch_fibrechannel_overview.h
tml

Standard and optional features
The following is a list of optional features for the switch module:

� McDATA SANtegrity Enhanced Activation (32R1797)

� QLogic/McDATA 10-port Upgrade (PN 32R1912)

3.2.3  QLogic 10-Port and 20-Port 4Gb Fibre Channel Switch Module
The QLogic 10-port and 20-port 4Gb Fibre Channel switch modules enable 
high-performing end-to-end SAN solutions using 4Gb Fibre Channel Technology. 
These standards-based switches are affordable 4Gb Fibre Channel Switch 
modules providing interoperability with FC-SW-2 and FC-SW-3 compliant SANs. 
Available in two configurations, the 10-port switch provides the ability to connect 
up to seven internal blade server ports, and three external ports, while the 
20-port switch provides all 14 internal ports and six external ports. The 10-port 
switch delivers pay-as-you-grow scalability via a license key upgrade, allowing all 
20-ports to become active.

Table 3-9 shows the product and order information for these modules.

Table 3-9   Product and order information

Figure 3-3 on page 21 shows the QLogic 10-Port and 20-Port 4Gb Fibre Channel 
Switch Modules.

Description Order number

QLogic 10-port 4Gb Fibre Channel Switch Module for 
IBM eServer BladeCenter

32R1904

QLogic 20-port 4Gb Fibre Channel Switch Module for 
IBM eServer BladeCenter

26R0881
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Figure 3-3   QLogic 10-Port & 20-Port Gb Fibre Channel Switch Module

Switch features
� The 10-port model has seven internal auto-sensing 2/4Gb F-Ports and three 

external auto-sensing 1/2/4Gb E/F/FL ports (upgradeable to 20 ports with 
10-port upgrade).

� The 20-port model has 14 internal auto-sensing 2/4Gb F-Ports and six 
external auto-sensing 1/2/4Gb E/F/FL ports.

� Using FC SW-2 and FC SW-3 standards, this switch interoperates with other 
major SAN switch manufactures, such as Cisco and McDATA. 

� Includes QLogic SANsurfer Management Suite for configuration and 
management of the SAN.

� Supports McDATA Mode Firmware Upgrade via an optional license key to 
provide seamless integration into McDATA fabrics.
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� Supported with QLogic 2Gb and 4Gb BladeCenter Fibre Channel expansion 
cards

For more information regarding integrated Fibre Channel switches for 
BladeCenter, visit the following Web site:

http://www-03.ibm.com/systems/bladecenter/switch/switch_fibrechannel_ov
erview.html

Optional features
The following is a list of optional features for the switch module:

� QLogic/McDATA 10-port Upgrade (PN 32R1912)

� McDATA Mode Firmware Key Upgrade (PN 32R1795)

Note: There are two operational modes for McDATA switches and 
directors: Open Fabric Mode and McDATA Fabric Mode. 

McDATA Mode was developed prior to the existence of the FC-SW-2 
standard allowing McDATA Switches. In McDATA Fabric Mode, the user 
can utilize a default zone set where any node in the fabric can see any 
other node in the fabric without initiating specific zones. Also, the user can 
perform zoning on a port number and a domain number basis instead of 
using worldwide port names.

Open Fabric Mode was introduced to allow McDATA devices to openly 
operate according to the rules ratified under the FC-SW-2 standard. In 
Open Fabric Mode, Default Zone Set and zoning by Domain number and 
port number are no longer enforced.

New switching devices to be seamlessly added to an existing McDATA 
fabric running in McDATA Fabric Mode or in Open Fabric Mode, as long as 
the setting of the switch being introduced match the operational mode of 
the existing fabric. Please be sure to check the operational mode of your 
existing fabric prior to introducing your new BladeCenter to the fabric.
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3.3  External Fibre Channel SAN switches
In this section, we discuss some of the supported external Fibre Channel SAN 
switches we used during the implementation of the SAN environments 
mentioned in this IBM Redbook.

3.3.1  IBM System Storage SAN10Q

The 4Gb 10-port FC switch is a low cost, easy to use switch that extends 4Gb FC 
SAN connectivity in the SMB market. It offers both fabric and public loop modes 
of operation. This new 4Gb 10-Port Fibre Channel (FC) SAN switch option helps 
you meet the challenge of managing mission-critical data in a expanding, 
network environment. 

With a small form factor of only 0.9 kg (2 lbs) and 1U deep, the IBM System 
Storage™ SAN10Q is a true spacesaver requiring only one-half a rack slot. This 
means two Fibre Channel switches can be racked in a single slot for a total of 20 
ports. All ports are autodiscovering and self-configuring, which helps allow 
maximum port density and power with a minimum investment.

Highlights of this switch module are:

� Small and capable 1U 4 Gbps 10-port half-width rack.

� Flexible rackable or stand-alone form factor.

� Designed to improve manageability: No wait routing helps maximize 
performance independent of data traffic.

� Simple to use: Auto-sensing, self-configurating ports.

� Logical choice: Intuitive and affordable migration from direct attached storage 
to SAN.

� Complete package: SANsurfer Express software helps simplify switch 
installation, managing and fabric scaling.

Figure 3-4 shows the IBM System Storage SAN10Q switch.

Figure 3-4   IBM System Storage SAN10Q 
 Chapter 3. Elements of the IBM BladeCenter 4Gb SAN solution 23



The IBM System Storage SAN10Q (type/model 6918-10X) offers: 

� Fabric port speed: 4 Gbps, full-duplex, autonegotiating for compatibility with 
existing 2 Gbps and 1 Gbps devices

� Fabric latency: Fabric Point-to-Point Bandwidth: Up to 848 MBps full duplex 
per port

� Fabric Aggregate Bandwidth: Single chassis: Up to 80 Gbps (full duplex) 
end-to-end

� Maximum frame sizes: 2148 bytes (2112 byte payload)

� Per-port buffering: ASIC-embedded memory (nonshared) and 8-credit zero 
wait for each port

Table 3-10 shows the product information for the switch and rack kit.

Table 3-10   Product information

For more information, please visit the following Web site: 
http://www-03.ibm.com/servers/storage/san/q_type/san10q/

3.3.2  QLogic SANbox 5600 Stackable Switch
The SANbox 5600 series of stackable switches delivers the seamless scalability 
and performance of a chassis switch, in an easy-to-manage, pay-as-you-grow 
solution. With sixteen 4Gb ports plus a four-pack of high-speed 10Gb ISL ports, 
and entry as low as eight ports with 4-port software-keyed increments and 
included graphical user interface (GUI) wizards, each SANbox 5600 stackable 
switch provides maximum flexibility for configuring, managing, and scaling SANs.

It is available in two power supply configurations: single integrated (SB5600) and 
dual hot-swappable (SB5602). For our example, see 7.2, “QLogic Fibre Channel 
Switch 5602 setup and configuration” on page 171.

Figure 3-5 on page 25 shows the switch.

Description Machine Model Number

IBM System Storage SAN10Q 6918 10X 691810X

IBM SAN10Q Rack Kit 39R6523
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Figure 3-5   SANbox 5600 Stackable Switch

The SANbox 5600 Stackable Switch provides the following:

� 8, 12, or 16 auto detecting 4Gb/2Gb/1Gb device ports

� Four 10Gb ports for high speed stacking links

� 4-port 4Gb/2Gb/1Gb or 10Gb field upgrade licenses are available

� Stacking of up to four units for 64 available user ports

� Non-Disruptive Code Load and Activation (NDCLA)

� Single and dual hot-swap power supply configurations available

� Configuration, Zoning, and Extended Distance wizards to simplify switch 
installation and fabric scaling

� Interoperable with all FC-SW-2 compliant Fibre Channel switches

� Full-fabric, public-loop, or switch-to-switch connectivity on 4Gb ports

� Full-fabric or switch-to-switch connectivity on 10Gb ports

� Auto-sensing, self-configuring ports

� Fabric Tracker tool for fabric-wide snapshots and detection of configuration 
changes

� Non-blocking full-bandwidth architecture

� I/O StreamGuard for RSCN suppression

� No-Wait routing: Guaranteed maximum performance independent of data 
traffic

� Industry's lowest latency for maximum performance

� SFP (small form-factor pluggable) connectivity: 16 front ports in a 1U 
full-width rack form-factor

� SANsurfer Switch Manager open management system: Designed for 
seamless operation with higher level third-party management applications

� In-band, out-of-band, Telnet and SNMP management access
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� ASIC-embedded memory: Faster, more scalable, and more reliable than 
shared memory architecture

3.3.3  McDATA Sphereon 4400 Switch
The McDATA Sphereon 4400 is an 8- to- 16 port switch that delivers 
enterprise-level features with an entry-level price. It starts from a base of eight 
ports and grows in 4-port increments using McDATA's FlexPort technology. A 
full-featured Fibre Channel switch in a half-rack width configuration, the 4400 is 
designed to provide high performance with 4 Gbps non-blocking bandwidth on 
every port with the ability to auto-negotiate to 2 Gbps and 1 Gbps to protect 
existing investments. 

Figure 3-6 shows the switch.

Figure 3-6   McDATA Sphereon 4400 Switch

The McDATA Sphereon 4400 offers the following:

� FlexPort connectivity-on-demand: Allows for affordable and nondisruptive 
additions to port capacity.

� HotCAT (Hot Code Activation Technology): Provides nondisruptive loading 
and activation of code upgrades and feature enhancements.

� EFCM Basic (formerly SANpilot) software: Offers an integrated, 
browser-based management tool for easy, intuitive control of Sphereon 
switches and small fabrics.

� Integration with the industry's broadest array of management applications, 
including Enterprise Fabric Connectivity Manager (EFCM).

� SANtegrity Security Suite software helps customers to protect data and 
securely manage access to their SANs.
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3.3.4  IBM TotalStorage SAN32B-2 FC Switch (SilkWorm 4100)
The IBM TotalStorage SAN32B-2 (equivalent to the Brocade SilkWorm 4100) is a 
high-performance, high-availability Fibre Channel switch designed for rapidly 
growing storage requirements in mission-critical environments. With a flexible 
architecture that supports 1, 2, and 4 Gbps technology with 16, 24, or 32 ports in 
a 1U package, the SAN32B-2 provides excellent value at an affordable price 
point. As a result, even small organizations can achieve the levels of 
performance and availability typically available only to larger enterprises. These 
capabilities help make the SAN32B-2 ideal for branch offices and departments in 
large enterprises as well as for midsized organizations. It can be used as the 
foundation of small, stand-alone SANs or as an edge switch in larger 
core-to-edge SAN infrastructures for enterprise-class applications, such as ERP, 
MRP, data warehousing, billing, and e-mail.

Figure 3-7 shows the switch.

Figure 3-7   IBM TotalStorage SAN32B-2 FC Switch (SilkWorm 4100)

Highlights:

� Protects existing investments by providing 4 Gbps technology with 
auto-sensing capabilities to support earlier 1 and 2 Gbps devices

� Supports full 4 Gbps operations at distances up to 100 kilometers (or 500 
kilometers at 1 Gbps) for cost-effective business continuance

� Increases network performance with enhanced Brocade Inter-Switch Link 
(ISL) Trunking, which enables a high speed data path up to 32 Gbps

� Utilizes Ports on Demand for fast, easy, and cost-effective scalability from 16 
to 32 ports in 8-port increments 

� Meets high-availability requirements with redundant, hot-pluggable 
components, and nondisruptive software

� Leverages intelligent Brocade SAN management and monitoring tools to 
increase operational efficiency and maximize SAN investments

For our example, see 5.4, “IBM TotalStorage SAN32B-2 Switch setup and 
configuration” on page 76. 
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Standard and optional features
As with the 4Gb SAN Switch Module, the SAN32B is based on the Brocade 
Fabric Operating System (Fabric OS) Version 5.0.x. and backward and forward 
compatible with the entire Brocade SilkWorm product family. The SAN32B offers 
the following advanced features and functionality: 

� Advanced Web Tools (standard) provide a graphical interface that enables 
you to monitor and manage individual switches and ports from a standard 
workstation using a browser.

� Brocade Advanced Zoning (standard) ensures secure device connectivity 
through either domain/port or World Wide Node Name zoning enforced 
through hardware.

� Brocade 8 and 16-Port Upgrade (optional license feature FC7510/7513) 
nondisruptively adds eight or 16 additional ports to SAN32B. 

� Brocade Advanced Performance Monitoring (optional license feature 
FC7556) allows very granular performance monitoring capabilities that 
include specific initiator-to-target traffic, SCSI Reads and Write per second, 
and CRC error tracking. 

� Brocade ISL Trunking (optional license feature FC7557) enhances SAN 
performance, increases availability, and simplifies management by creating 
up to two 12 Gb trunks to the external SAN that provide granular frame-level 
load balancing. 

� Brocade Performance Bundle (optional license feature FC7555) includes ISL 
Trunking and Advanced Performance Monitoring. 

� Brocade Dynamic Path Selection (standard) also enhances performance by 
performing exchange-level load balancing across the ISL Trunks. ISL 
Trunking and DPS together ensure a balanced 24 Gb bandwidth to external 
SAN.

� Brocade Fabric Watch (standard) enhances SAN management and 
availability through client configurable monitors of critical security, statistics 
and performance parameters, and sending alarms to administrator to 
proactively catch potential problems.

� Brocade Extended Fabric (optional license feature FC7553) when used with 
link extenders, enhances IBM Business Continuity solutions by allowing full 
FC bandwidth across extended distances up to 230 km. 

� Brocade Advanced SAN Security (optional license feature FC7554) provides 
flexible security and policy administration that protect data from unauthorized 
access and corruption, thus helping organizations meet specific security 
requirements.

� Brocade Fabric Manager 5.0 (software product sold separately) is a graphical 
interface for monitoring and managing multiple fabrics comprised of Brocade 
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switches from a standard workstation. The GUI simplifies task administration 
at the fabric, switch, and port levels in a medium-to-large size Brocade SAN 
environment.

More information regarding this product can be viewed at the following Web site:

ftp://ftp.software.ibm.com/common/ssi/rep_sp/n/TSD00742USEN/TSD00742USE
N.PDF

3.4  External Storage Disk Arrays
In this section, we discuss some of the supported external Storage Disk Arrays 
we used during the implementation of the SAN environments mentioned in this 
Redbook.

3.4.1  IBM TotalStorage DS4100
The IBM TotalStorage DS4100 (formerly FAStT100) is designed to give 
cost-conscious enterprises an entry-level server that can help address storage 
consolidation and near-line application storage needs without undue expense, 
while leaving them room to grow. Single controller model supports up to 5.6 TB, 
while the dual controller model supports up to 44.8 TB of Serial ATA (SATA) 
physical disk storage with DS4000™ EXP100, provided by up to 14 internal 
400GB disk drives inside the controller, the DS4100 can provide ample yet 
scalable storage without the cost of extra expansion units. This disk system is 
designed to help consolidate direct-attached storage into a centrally managed, 
shared, or storage area network (SAN) environment. With four Fibre Channel 
ports to attach to servers on dual controller, the need for additional switches is 
reduced or eliminated for additional potential cost savings.

The DS4100 was used during our lab implementation; however, since its 
replacement has come onto the scene to provide the end-to-end 4Gb storage 
technology required at this level. The replacement for the DS4100 is the DS4700 
Express.

3.4.2  IBM System Storage DS4700 Express
The IBM System Storage DS4700 Express offering is geared toward small to 
midsize business and midrange enterprise customers. 

The IBM System Storage DS4700 Express Model supports a high-performance 
4Gb Fibre Channel interface designed for data-intensive applications that 
demand increased connectivity. The DS4700 Express supports eight 4 Gbps 
capable host channels that may be directly attached to host servers or connected 
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to a Fibre Channel storage area network (SAN). Four Gbps capable drives and 
IT infrastructure are required to achieve 4 Gbps throughput speeds.

There are two ways to measure the performance of a SAN device: megabytes 
per second (Mbps) and input/output per second (IOPS). The DS4700 Express 4 
Gbps SAN solution is designed to provide up to 1600 Mbps throughput 
(assuming a 4 Gbps capable system) with up to 125,000 IOPS. A 2 Gbps storage 
array can require up to twice as many host ports as a 4 Gbps array to deliver the 
throughput of four 4 Gbps ports. The DS4700 Express can help you free up or 
eliminate the need for additional host ports in the SAN for each array.

The DS4700 Express storage system’s four 4 Gbps drive connections are 
designed to support up to 112 disk drives with the attachment of six DS4000 
EXP810 disk enclosures. This makes the DS4700 Express a good choice for 
performance-oriented or capacity-oriented storage requirements. Models 70 and 
72 are designed to support over 33.6 TB of Fibre Channel physical storage 
capacity.

The DS4700 Express expands the DS4000’s history of flexibility with another 
configuration option: cache size. The DS4700 Express is available in two models: 
Model 70 is designed to support up to 2 GB of physical cache memory (1 GB per 
controller) and the Model 72 can support up to 4 GB of physical cache memory 
(2 GB per controller).

The IBM System Storage DS4700 Express is designed to be an affordable, 
scalable storage server for storage consolidation and clustering applications. Its 
modular architecture, which includes Dynamic Capacity Addition and Dynamic 
Volume Expansion, can support on demand business environments by helping to 
enable storage to grow as demands increase. Autonomic features such as online 
firmware upgrades and DS4000 Service Alert also are designed to help enhance 
the system’s usability.

The DS4700 Express features support the consolidation of direct-attached 
storage into a centrally managed, shared, or storage area network (SAN) 
environment. With built-in support for eight Fibre Channel–attached servers, the 
need for additional switches is reduced or eliminated, helping to make server 
clustering more cost-effective.

The 4 Gbps capable IBM System Storage EXP810 Storage Expansion Unit offers 
a new 16-bay disk enclosure for attachment to selected DS4000 mid-range disk 
systems, with up to 4.8 TB physical capacity per expansion unit using sixteen 
300 GB disk drives. The EXP810 Storage Expansion Unit is designed to 
accommodate the new optional 2 Gbps Fibre Channel Enhanced Disk Drive 
Modules (E-DDM), as well as an intermix of 4 Gbps Fibre Channel Enhanced 
Disk Drive Modules (E-DDM), all within the same enclosure. The EXP810 
contains redundant (AC or DC) power and cooling modules, and Environmental 
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Service Module (ESM) interfaces. The DS4000 EXP810 is available in a 19-inch 
rack-mount package.

Each ESM Customer Replacement Unit (CRU) contains two 2 Gbps/4 Gbps 
Fibre Channel host connections utilizing Small Form Factor Pluggable (SFP) 
connectors. The DS4000 EXP810 ESM designs support a 4 Gbps Fibre Channel 
loop. Both 2 Gbps and 4 Gbps Fibre Channel disk drives are supported. A switch 
on the front of the DS4000 EXP810 enclosure selects the speed of the entire 
enclosure—either 2 Gbps or 4 Gbps, but not both at the same time. 

Table 3-11 shows the product and order information for these units.

Table 3-11   Product and order information

Please visit the following Web site for more on the features and benefits of this 
product:

http://www-03.ibm.com/servers/storage/disk/ds4000/ds4700/index.html

3.4.3  IBM System Storage DS4800
The IBM System Storage DS4800 is the very latest and most powerful in the 
highly successful IBM System Storage DS4000 Series. Designed as an integral 
component in the IBM storage solution portfolio, the DS4800 is a key component 
of IBM business continuity solutions portfolio delivering business resilience and 
continuity of operations. Also designed to accommodate the changing value of 
data over time while maintaining data availability, DS4800 can play a leading role 
in a hierarchical storage life cycle management strategy. The DS4800, when 
ordered in combination with IBM virtualization products (SAN File System or 
SAN Volume Controller), makes an outstanding solution to help simplify your I/T 
infrastructure.

The IBM System Storage DS4800 disk storage system supports a 
high-performance 4 Gb Fibre Channel interface for increased host connectivity to 
deliver necessary bandwidth for high-throughput applications. It is designed for 
data-intensive applications that demand increased connectivity provided by eight 
4 Gbps host channels designed to provide up to 1600 MBps of sustained 
bandwidth for high-throughput applications through the eight channels directly 
attached to the host servers or connected to a Fibre Channel storage area 
network (SAN).

Description Order Number

DS4700 Express Model 70 #181470H

DS4700 Express Model 72 #181472H
 Chapter 3. Elements of the IBM BladeCenter 4Gb SAN solution 31

http://www-03.ibm.com/servers/storage/disk/ds4000/ds4700/index.html


Models 1815-80A, 1815-82A, 1815-84A, and 1815-88A

RAID controller Dual active

Cache Model 80A: 4 GB battery-backed

Model 82A: 4 GB battery-backed

Model 84A: 8 GB battery-backed

Model 88A: 16 GB battery-backed

Host interface 8 host ports: Fibre Channel (FC) Switched and FC 
Arbitrated Loop (FC-AL) standard, auto-sensing 1 
GBps/2 GBps/4 GBps

Drive interface 8 drive ports: Fibre Channel (FC) Switched and FC 
Arbitrated Loop (FC-AL) standard, auto-sensing 2 
GBps/4 GBps

Supported drives 36.4 GB, 73.4 GB, 146.8 GB, and 300 GB 10,000 rpm 
(Fibre Channel)

36.4 GB, 73.4 GB, and 146.8 GB 15,000 rpm (Fibre 
Channel)

400 GB and 250 GB 7,200 rpm (SATA)

2 Gbps FC: 15K rpm, 146 GB/73 GB/36 GB (E-DDM)

2 Gbps FC: 10K rpm, 300 GB/146 GB/73 GB (E-DDM)

4 Gbps FC: 15K rpm, 146 GB/73 GB/36 GB (E-DDM)

RAID levels 0, 1, 3, 5, and 10

Storage partitions 8, 16, or 64 storage partitions; choice of 8, 16, or 64 
required

Upgrade: 8–16, 16–64

Maximum drives Model 80A: 224 FC drives (using 14 DS4000 EXP810, or 
16 EXP710 Expansion Units)

Model 82A: 224 FC drives (using 14 DS4000 EXP810, or 
16 EXP710 Expansion Units)
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Model 84A: 224 FC drives (using 14 DS4000 EXP810, or 
16 EXP710 Expansion Units)

Model 88A: 224 FC drives (using 14 DS4000 EXP810, or 
16 EXP710 Expansion Units)

SAN Support Supported IBM FC switches and directors (product 
numbers 2005, 2006, 2109, 3534, 2031, 2032, 2034, 
2042, 2061 and 2062, and BladeCenter)

Table 3-12 shows the product and order information for the system.

Table 3-12   Product and order information

Please visit the following Web site for more on the features and benefits of this 
product:

http://www-03.ibm.com/servers/storage/disk/ds4000/ds4800/index.html

3.4.4  EMC CLARiiON CX3 UltraScale Series
The EMC CLARiiON CX3 UltraScale Series extends EMC’s leadership in 
networked Storage with the third generation of CLARiiON CX Series Systems. 
The EMC CLARiiON CX3 UltraScale Series is the industry’s only midrange 
storage solution designed from the ground up to deliver maximum business 
benefits, unprecedented application performance, the highest levels of scalability 
and reliability, and ease-of-use capabilities.

The UltraScale is a breakthrough architecture, as it is the only midrange storage 
architecture that sustains maximum throughput and performance for a wide 
variety of business applications. With a state-of-the-art I/O interconnect based on 
native PCI Express technology, UltraScale delivers high-bandwidth, low-latency 
characteristics that enable the CX3 UltraScale Series to capitalize on the 
industry’s only full 4 Gbps capabilities throughout the entire system. Processing 
power improvements deliver significant performance increases in business 
applications and array-based replication software, such as EMC SnapView, SAN 
Copy, and MirrorView functionality.

Description Order Number

IBM System Storage DS4800 Model 80 -  1815-80A
Model 82 -  1815-82A
Model 84 -  1815-84A
Model 88 -  1815-88A
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The CLARiiON CX3 UltraScale series scales from the 365 GB capacity 
entry-point CX3 model 20 up to the 239 TB capacity CX3 model 80, the world’s 
largest midrange storage platform. Customers can let their information grow as 
fast as their business, without the difficulties of data migrations of new 
management tools. 

As application requirements change, CLARiiON’s unique Virtual LUN technology 
can be used to nondisruptively move data from one tier of storage to a higher or 
lower tier and between 2 Gbps and 4Gbps drives within the same CLARiiON 
CX3 Series System to take advantage of the full UltraScale architecture. By 
matching performance and financial investment to the needs of the application or 
business process, information gets delivered as fast as it is needed, and budgets 
can go further than ever.

The EMC CLARiiON CX3 UltraScale Series includes: 

� EMC CLARiiON CX3 model 80
� EMC CLARiiON CX3 model 40
� EMC CLARiiON CX3 model 20

The entry point into the CLARiiON CX series is the EMC CLARiiON CX300 
networked storage system.

Please visit the following Web site for more on the features and benefits of the 
CLARiiON CX3 product line: 

http://www.EMC.com/CX3

"EMC Corporation, Reprinted by Permission.”
34 IBM BladeCenter 4Gb SAN Solution

http://www.EMC.com/CX3


Chapter 4. IBM BladeCenter setup and 
configuration

The IBM BladeCenter servers are designed to take less time to install, configure, 
and use fewer people to maintain. In this chapter, you will witness the preliminary 
tasks for setting up and configuring your IBM BladeCenter to support your SAN 
environment.

4
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4.1  Supported environments for Windows and Linux 
operating systems

Table 4-1 lists the hardware and operating systems with corresponding services 
packs that have been successfully tested in a Boot from SAN environment with a 
4 Gbps solution. See the IBM Server Proven Web site for more information.

Table 4-1   Supported environments

4.1.1  Firmware and drivers
Once you have installed your QLogic or Emulex 4Gb Fibre Channel HBA, you 
should ensure that you have the appropriate firmware and drivers to configure 
them. The following firmware and drivers are available on the IBM BladeCenter 
Support Web site:

http://www-307.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-458
59#fibre

4.2  Blade server F1 setup
This step should be performed when you are prepared to configure a Boot from 
SAN environment. In the following steps, you will disable the use of the IDE 
drives that may be installed in the HS20, HS40, or LS20.

1. Power on the blade server and interrupt the boot sequence to enter the HS20 
blade system BIOS by pressing the F1 key. 

2. At the Configuration/Setup Utility menu, select Devices and IO ports.

3. Select IDE Configuration Menu and press Enter.

Operating systems 8678 8832 8839
8843 8850

32 bit 64 bit 32 bit 64 bit

Windows 2000 SP4 X X X X N/A X N/A

Windows 2003 Standard X X X X X X X

Windows 2003 Enterprise X X X X X X X

SLES 9 SP1 X X X X X X X

RHEL 4 Update 1 X X X X X X X
36 IBM BladeCenter 4Gb SAN Solution

http://www-03.ibm.com/servers/eserver/serverproven/compat/us/eserver.html
http://www-03.ibm.com/servers/eserver/support/bladecenter/index.html
http://www-307.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-45859#fibre


4. Set the Primary IDE Channel and Secondary IDE Channel option on the 
HS20 to Disabled (see Figure 4-1).

Figure 4-1   IDE Configuration Menu window

Note: On the HS20 (8832, 8678, and 8839; verify on all blades) blade 
servers
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5. On the HS20 (8843 and 8850) blade servers with SCSI disks:

a. Set the Planar SCSI option to Disabled on the HS20 (8843) and LS20 
blade, as shown in Figure 4-2.

Figure 4-2   Devices and I/O Ports window

6. Press Esc to exit out of this menu and save the changes.

4.3  QLogic Fast!Util setup
This step should be performed when you are prepared to configure a Boot from 
SAN environment. 

4.3.1  Configure the HS20 blade server Fibre Channel BIOS
In this section, you will follow the steps to configure your blade server FC HBA:

1. Power on or restart the HS20 Blade.
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2. Press Ctrl-Q or Alt-Q to enter the FC BIOS configuration utility, as shown in 
Example 4-1.

Example 4-1   Ctrl-Q execute window

Broadcom NetXtreme Ethernet Boot Agent v3.1.15
Copyright (C) 2000-2002 Broadcom Corporation
All rights reserved.

Broadcom NetXtreme Ethernet Boot Agent v3.1.15
Copyright (C) 2000-2002 Broadcom Corporation
All rights reserved.

QLogic Corporation
QMC2462 PCI Fibre Channel ROM BIOS Version 1.04
Copyright (C) QLogic Corporation 1993-2005. All rights reserved.
www.qlogic.com

Press <CTRL-Q> for Fast!UTIL

BIOS for Adapter 0 is disabled
BIOS for Adapter 1 is disabled
ROM BIOS NOT INSTALLED

<CTRL-Q> Detected, Initialization in progress, Please wait...
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3. Select the first Fibre Channel adapter port (port 1 @ 4000 I/O address is 
internally connected to the top Fibre Channel Switch in slot 3 of the 
BladeCenter chassis), as shown in Figure 4-3.

Figure 4-3   Select Host Adapter window

4. Select Configuration Settings → Host Adapter Settings. 
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5. Change the Host Adapter BIOS to Enabled (Figure 4-4); the default value is 
Disabled.

6. Record the World Wide Port Name (WWPN) of this host bus adapter. It will be 
needed to define the Storage Group, Host, and Host Port on the storage 
subsystem and also for fabric Zone configuration.

Figure 4-4   FC Host Bus Adapter BIOS menu
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7. Verify and confirm that the following NVRAM definitions are applied on the 
HBA by selecting the Advance Adapter Settings, as shown in Figure 4-5.

Figure 4-5   Advanced Adapter Settings window

4.4  4Gb Fibre Channel switch module implementation

To insert the switch module into a blade server chassis:

1. Unpack the switch module from its shipping box.

2. Verify that bay 3 or 4 in the BladeCenter chassis are empty. Note that Bay 3 
and 4 locations are different for the IBM BladeCenter and BladeCenter H 
chassis.

3. Squeeze the release lever to release the insertion arm.

4. Pull the release lever away from the switch to completely open the lever. 

5. Slide the switch module into the open slot, as shown in Figure 4-6 on 
page 43.
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Figure 4-6   N-1

6. Raise the release lever until it moves from the lowered to the upright position. 
This locks the switch module into the chassis and automatically starts power 
up. The switch will run self-diagnostic tests (such as POST). 

7. Wait until the diagnostics have completed and the LEDs are stable and then 
use the BladeCenter Management Module to configure the switch.

4.4.1  FC switch module configuration through the Management 
Module 

Note: The new IBM BladeCenter Management Module firmware version that 
supports the Brocade, McDATA, and QLogic 4Gb SAN Switch Module is 
BRET82F.
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To connect to the switch module using the BladeCenter Management Module:

1. On your workstation, open a supported browser window.

2. In the address field, type the IP address of the Management Module.

3. When prompted, enter the user name and password. By default, the IBM 
BladeCenter Management Module user name is USERID and the password is 
PASSW0RD. Note that a zero is used in place of the letter O. User names and 
passwords are case sensitive. 

Figure 4-7 shows the initial AMM view.

Figure 4-7   Initial BladeCenter H Advanced Management Module view

4.4.2  Setting the switch module IP Address and enabling external 
ports

The default IP address for the switch module is 192.168.70.129 (for Bay 3) or 
192.168.70.130 (for Bay 4) of the BladeCenter chassis. To change the IP 
address, perform the following: 

1. In the I/O Module Tasks tab, click Configuration. Select Bay 3 or 4.

2. Change the IP address and click Save (see Figure 4-8 on page 45).
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Figure 4-8   Setting Switch Module IP Address 

Note: Use only the BladeCenter Management Module to set the switch 
module's IP address. Do not use the switch module’s CLI or Web tools. 
Doing so may cause a loss of connectivity between the Management 
Module and switch module. The switch module's IP address must be on 
the same IP subnet to communicate.
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3. While in the window shown in Figure 4-8 on page 45, locate and click 
Advanced Configuration for the switch module. You will see a window 
similar to Figure 4-9. Ensure that the external ports are enabled. Click Save. 

Figure 4-9   Enabling External Ports on switch module
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4. The remaining steps for configuring the switch module are performed either 
through the command line interface (CLI) via telnet or Web tools (via 
Browser). Both methods are accessible from the Management Module 
window (see Figure 4-10) or you may access outside the Management 
Module by using the switch module's IP address. 

Figure 4-10   Launching Web or Telnet Session from the Management Module
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Chapter 5. Brocade SAN configuration

In this section, we discuss the 4Gb SAN solution presented by Brocade.

5
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5.1  Building an enhanced 4Gb SAN solution on Brocade 
technology

This section of the IBM Redbook provides you with the resources to build, 
manage, and maintain a SAN solution based on Brocade technology and offering 
these advanced features:

� Superior performance: 

– 4 Gbps end-to-end bandwidth from server to storage

– Multiple 12 Gbps Inter Switch Link (ISL) Trunks connecting the 
BladeCenter to the external SAN fabric providing up to 48 Gb of total load 
balanced bandwidth 

� Simple management: 

– Single point of SAN fabric management

– Advanced performance monitoring capability

� High Availability: 

– Redundant SAN fabrics with no single point of failures

– Multi-pathing software to the DS4800 disk array

– Hot code load and activation for all switches

– Health Monitoring tools to catch marginal components before they become 
hard failures

� Advanced SAN security: 

– Hardware Enforced Zoning for both ports and WWN

– Using encryption, authentication, and access control lists to meet the 
strictest corporate security policies

� Scalability: Additional BladeCenter chassis and storage arrays may be 
connected to the core SAN32B switches without any disruption.

The solution built in this IBM Redbook consists of one BladeCenter H chassis, 
three blade servers, two Brocade 4Gb SAN Switch Modules, two TotalStorage 
SAN32B-2 FC switches, and one DS4800 (see Figure 5-1 on page 51). 
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Figure 5-1   Solution diagrams

The Brocade portion of the Redbook includes these sections:

� “Brocade 10-Port and 20-Port 4Gb SAN Switch Module” on page 15

� “IBM TotalStorage SAN32B-2 FC Switch (SilkWorm 4100)” on page 27

� “Building an enhanced 4Gb SAN solution on Brocade technology” on page 50

� “SAN design with Brocade 4Gb SAN switch modules” on page 52

� Setup of the “Brocade 4Gb SAN Switch Module configuration” on page 55

� Setup of “IBM TotalStorage SAN32B-2 Switch setup and configuration” on 
page 76

� “Building the Brocade SAN fabric” on page 101

� “Connecting storage and servers to SAN fabric” on page 111

� “Zoning to control device connectivity” on page 115

� “Mapping a logical disk to server blades” on page 135
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� “Documentation for Brocade 4Gb SAN switch module” on page 328

While this solution is using the IBM SAN32B external switch, the steps are very 
similar for other Brocade-based FC products from IBM, such as the SAN16B 
entry switch or SAN256B enterprise director.

5.2  SAN design with Brocade 4Gb SAN switch modules
In this section, we discuss the different SAN designs we are able to implement 
with the Brocade 4Gb SAN switch.

5.2.1  Small-to-medium SAN topologies
There are two huge benefits of the Brocade 4Gb SAN Switch Module compared 
to the previous 2Gb, two External Port switch module: 

� Increased bandwidth up to 24 Gb

� Increased connectivity to other devices, switches, or switch modules

While the increased bandwidth will only be needed in extreme high-performance 
application environments, the improved connectivity will benefit all customers by 
building small-to-medium SAN fabrics without external switches. By using 
cascade, mesh, or core-to-edge SAN topologies, the BladeCenter chassis can 
be interconnected through the SAN switch modules to provide fabrics with 
redundancy and excellent performance. Figure 5-2 on page 53 demonstrates 
how 3, 4, 5, and 6 chassis may be connected. 
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Figure 5-2   Dual Core-Edge Topology for five and six chassis

Each of the SAN designs above has free unused ports available on the switch 
modules that can connect to other devices, such as stand-alone servers, disk 
arrays, tapes, and virtualization engines. Note that connecting greater that six 
BladeCenter chassis increases fabric complexity and should be considered with 
care.
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5.2.2  Building medium-to-large SAN topologies using the Brocade 
4Gb SAN switch modules

Brocade products are designed with large scalability capabilities. Although the 
FC specification allows up to 239 domains (for example, switches) in a single 
fabric without routing, the practical and proven limits are lower. Brocade 
continuously tests and supports ever increasing SAN fabrics. As of 2005, 
Brocade has certified SAN fabrics of 56 domains and much greater number 
using the Brocade Multi-protocol Router. Therefore, by installing a Brocade fabric 
initially, you ensure seamless scalability to thousands of devices. 

For more than six BladeCenter chassis in a SAN, using external switches at the 
core greatly simplifies the topology and future scalability. Use redundant external 
switches to ensure full redundancy and highest availability. When all the ports of 
the core switch are used, then further scalability can be accomplished without 
downtime by swapping the core for a larger core switch or director. Figure 5-3 
shows two IBM TotalStorage SAN256B 4Gb directors as cores for numerous 
BladeCenter chassis.

Figure 5-3   BladeCenter Chassis using two SAN256Bs
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5.3  Brocade 4Gb SAN Switch Module configuration
Prior to completing the instructions in this section, please read Chapter 4, “IBM 
BladeCenter setup and configuration” on page 35 and complete the steps 
outlined there. Afterwards, return here to begin the implementation of your 
Brocade SAN environment. Figure 5-4 shows the SAN topology we used as our 
lab environment. It is assumed that LUN(s) have been created and assigned on 
the storage system prior to this SAN implementation. 

Figure 5-4   Brocade Fibre Channel SAN environment
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5.3.1  Fabric OS requirements 
At the time of its initial release, the Brocade 4Gb SAN Switch Module (SW4020) 
for IBM BladeCenter uses Fabric OS (FOS) Version 5.0.2 only. Attempts to load 
this software release on Brocade switches other than the Brocade 4Gb SAN 
Switch Module will result in File Not Found errors. Also, the SilkWorm 4020 is 
not supported by any previous versions of Brocade Fabric OS, including V5.0.1x. 
Attempts to load any release prior to Brocade Fabric OS V5.0.2 on a SilkWorm 
4020 will result in File Not Found errors. Always check the IBM BladeCenter 
support site for the latest supported firmware for the switch module. 

5.3.2  Launching Brocade Web tools for initial setup
As indicated previously, Web Tools management software can be launched from 
the Management Module or directly by using a browser and the switch's IP 
address. This section will describe how to set up the browser for best 
performance and launch Web Tools external to the Management Module. 

Web Tools requires any browser that conforms to HTML Version 4.0, 
JavaScript™ Version 1.0, and Java™ Plug-in 1.4.2_06 or higher. You can launch 
Web Tools on any workstation with a compatible Web browser installed. Web 
Tools also supports the HTTPS protocol, if that protocol is enabled for the switch. 
For more information about enabling the HTTPS protocol on your switch, refer to 
the Fabric OS v5.01 Administrator's Guide. 

1. Set browser for optimum performance. 

– The correct operation of Web Tools with Internet Explorer® requires 
specifying the appropriate settings for browser refresh frequency and 
process model. Browser pages should be refreshed frequently to ensure 
the correct operation of Web Tools. 

– To set the refresh frequency:

i. Select Tools → Internet Options in the browser.

ii. Click the General tab and click Settings (under Temporary Internet 
Files).

iii. Click Every visit to the page under Check for newer versions of stored 
pages.

2. Begin your work by establishing a Web Tools session to your Brocade SSM 
(use the assigned IP address). To do so, follow the instructions listed below.
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3. From the Internet Explorer (Windows) or Mozilla (Linux) browser, enter the IP 
address for your switch in the Address window box, then press the Enter key. 
You should see a Web Tools session open, similar to Figure 5-5. The Web 
Tools display for the SSM is somewhat different for external switches, since 
there are no Power Supply Fan buttons.

Figure 5-5   Web Tools for Brocade 4Gb SAN Switch Module
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Figure 5-6 shows the different areas of Web Tools. Become familiar with the 
different areas to simplify your SAN administration.

Figure 5-6   Brocade switch menu

4. From the Switch View Button Menu, click Status and verify that the switch 
module health is good (see Figure 5-7 on page 59). 
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Figure 5-7   Switch Module Status Window

5. From the Switch View Button menu, select the Admin button. Log in to the 
switch using the following information:

Login USERID

Password PASSW0RD (note that 0 is a zero)
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6. Set the Switch Status to Disable, as shown in Figure 5-8. You must disable a 
switch before changing Domain ID. 

Figure 5-8   Admin window

7. Select the Domain ID of the switch.

Guidelines for selecting Domain ID numbers:

– Set unique domain numbers for each switch in the SAN. This allows for 
simpler merging of fabrics if needed in the future.

– As a convention, consider setting the domain ID of each switch to the last 
octet of its IP address. 

– Be aware that the highest allowed domain number is 239. 
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– See Figure 5-9 as an example of both external switches and embedded 
switch modules. 

Figure 5-9   Selecting Domain ID numbers

8. Enter the selected number into the Domain ID field.

9. In this same window, set the switch's name to some unique and descriptive 
name. The switch name can include up to 15 characters, must begin with a 
letter, and must consist of letters, digits, and underscore characters, and no 
spaces. Setting the switch name is recommended to simplify locating switch 
module and fabric management. An example of a switch name is 
SSM47_BCH2_Bay3. 
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10.For new SAN installs, select the Configure tab (Figure 5-10) and verify that 
Switch PID Format is set to Format 1. Occasionally, when connecting to older 
external switches, you may need to change the Switch Port ID format. Refer 
to “Building the Brocade SAN fabric” on page 101 for more details.

Figure 5-10   Verify Switch PID Format

11.Set Switch Status to Enable. Click Apply.

Caution: Do not change the other configuration values unless instructed by 
your SAN supplier. They must match for every switch in the fabric and altering 
them may prevent the switch module from merging with other switches (called 
segmentation).
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12.Go to the Ports tab and ensure that the proper ports are licensed and have 
been enabled (see Figure 5-11).

– For the 10-port module, ports 0-7, 15, and 16 should be both licensed and 
enabled. 

– For the 20-port module, all ports 0-19 are licensed and enabled.

Figure 5-11   Brocade 4Gb Switch Admin window

13.Pay particular attention to the external port Enable Port setting. If the external 
ports 0, 15-19 are not enabled, then return to the Management Module GUI to 
enable them. 
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14.Set the switch time and date using the command-line interface (CLI). 
Switches maintain the current date and time in flash memory and because 
the date and time are used for logging, you should set them correctly.

a. From the Switch View Button Menu (Figure 5-6 on page 58), click the 
Telnet button.

b. Log in as USERID with correct password. 

c. Enter the date command using this syntax: 

date mmddHHMMyy

Where:

mm: Month (01-12)

dd: Day (01-31)

HH: Hour (00-23)

MM: Minute (00-59)

yy: Year (00-99)

For example: 

Brocade4Gb:USERID> date

Fri Jan 29 17:01:48 UTC 2000

Brocade4Gb:USERID > date "0227123003"

Thu Feb 27 12:30:00 UTC 2003

Brocade4Gb:USERID >

d. Enter the tsTimeZone command to set the time zone using the syntax 
tsTimeZone [houroffset[,minuteoffset]]. The default time zone is 
Universal Time Conversion (UTC), which is eight hours ahead of Pacific 
Standard Time (PST). Determine your time zone offset. Below are some 
examples. 

• For Pacific Standard Time, enter tsTimeZone -8,0.

• For Central Standard Time, enter tsTimeZone -6.0.

• For Eastern Standard Time, enter tsTimeZone -5,0.

Note: If you enable/disable the externals the ports using Brocade Web 
Tools or CLI, then the ports will operate correctly until the next switch 
module reboot/power-cycle, while the external ports will default to the 
Management Module's setting. Therefore, it is important to enable/disable 
external ports using the BladeCenter Management Module.
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15.To synchronize your time with an external source such as an NTP server, 
enter the tsclockserver command using the syntax tsclockserver ipaddr, 
where ipaddr is the IP address of the NTP server that the switch must be able 
to access. 

Adding optional licenses to the Brocade Switch Module
This section shows you how to add optional licenses to the Brocade 4Gb SAN 
Switch Modules. 

Brocade products in general offer several optional licensed features to improve 
performance, security, manageability, and availability. The Brocade 10 Port 4Gb 
SAN Switch Module for IBM BladeCenter (feature code 32R1813) is shipped with 
the following licenses:

� Advanced Web Tools (Web)

� Advanced Zoning (Zoning)

� Full Fabric License (Fabric)

The unlicensed ports can be activated by upgrading with a 10-Port 
(Ports-on-Demand) Upgrade license (option 32R1822). This license may be 
purchased from your switch supplier.

The second Brocade 20 Port 4Gb SAN Switch Module for IBM BladeCenter 
(feature code 32R1812) is shipped with the following licenses:

� Advanced Web Tools (Web)

� Advanced Zoning (Zoning)

� Full Fabric License (Fabric)

� Full Ports on Demand license (additional 10 port upgrade)

The following software features are optional:

� Brocade Fabric Watch for IBM BladeCenter (option 32R1855)

� Brocade ISL Trunking for IBM BladeCenter (option 26K5607)

� Brocade Advanced Performance Monitoring for IBM BladeCenter (option 
26K5612)

� Brocade Performance Bundle for IBM BladeCenter (includes ISL Trunking 
and Advanced Performance Monitoring) (option 26K5605)

� Brocade Extended Fabrics for IBM BladeCenter (option 26K5613)

� Brocade Advanced Security (Secure OS) for IBM BladeCenter (option 
26K5617)
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� Brocade Fabric Manager V5.x for IBM BladeCenter (stand-alone application, 
must be purchased separately)

� Brocade Fabric Watch for IBM BladeCenter (option 32R1855). See 
Figure 5-12 for optional software features.

Figure 5-12   Option License Paper-Pak example

Do the following steps:

1. Access and record the LicenseID (same as the World Wide Name WWN) 
from the Brocade SAN switch module. The LicenseID is in the form 
10:00:xx:xx:xx:xx:xx:xx, where xx values are unique to each switch module. 

2. Using Brocade Advanced Web Tools, look underneath the illustration of the 
switch to find the LicenseID of the switch module (see Figure 5-13 on 
page 67). 
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Figure 5-13   Locating License ID

3. Go to the following Web site to get feature activation key for your switch 
module:

http://www.ibm.com/storage/key
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4. Enter your e-mail address, switch module license ID, and the transaction key 
on the Web page shown in Figure 5-14. Please note that the LicenseID 
should be entered into the WWN field. 

Figure 5-14   IBM License Key activation window

5. After submitting your information, the Web site will provide you a feature 
activation key and send you an e-mail with the information. Write the feature 
activation key in the space provided on your Paper-Pak for future reference. 
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6. Use Web Tools to enable the licensed feature. Under the Switch Admin 
Window (Figure 5-15), select the License tab and use the Add button to add 
the License Keys.

Figure 5-15   License management window
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7. The Add License dialog box appears (Figure 5-16), and you should type or 
paste the Feature Activation License Key in the field. Next, click Add License.

Figure 5-16   Add License dialog window

8. You will receive a confirmation dialog box (Figure 5-17). Click the appropriate 
option to either add more licenses or close the window. 

Figure 5-17   License Addition Confirmation window

9. Click Refresh (Figure 5-18 on page 71) and verify that all new Licenses have 
been added to the Feature List. 
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Figure 5-18   Confirm all licenses have been added

10.If installing the 10-Port (Ports-on-Demand) Upgrade license (option 32R1822) 
onto the 10-Port switch module, then you must take additional steps to enable 
the newly added ports.

a. Verify that the Management Module Advanced IO setting for the External 
Ports is set to Enable. 
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b. Go to Brocade Web Tools and the Ports tab (Figure 5-19) under Admin.

c. Ports 8-14, 16-19 will not be enabled. Check all boxes under the Enable 
Port column for each new port that you wish to enable. 

d. Click Apply. 

Figure 5-19   Enabling newly added Ports

Important: You should securely store the LicenseID and all the License Keys 
for every switch. This information helps recover licenses if licenses are 
accidentally removed. Also, you or service personnel will need the licenses to 
reinstall these features in the event that a field replacement unit (FRU) 
SHNS1C44 is required.
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Below are the best practices for storing license information. 

a. Keep hard copies of licenses and store them securely:

i. Writing License Activation Keys on the original Paper-Pak forms. 

ii. Printing a screen capture of the licenses from Web Tools.

iii. Telnet into the switch module and issue the licenseShow command and 
then print the results. 

iv. Remove the white labels from the Paper-Paks and add to the front or 
side of the switch module. Adding labels to the side of switch module 
requires a power down and should be performed before going into 
production. 

v. Print a copy of the switch configDownload file.
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vi. Keep softcopy files of licenses and other critical switch information by 
using the configUpload/Download function found in the Configure tab 
(Figure 5-20). The configUpload option will save (upload) the switch 
information and settings to a config file on a server. The 
uconfigDownload option will restore (download) a previously save 
config file onto the switch module. Note that Figure 5-20 shows 
configDownload selected. To perform a configUpload, select the 
configUpload option.

Figure 5-20   Perform Config Upload of switch information

Clear zone database
Zoning is a feature of FC switches that allow the SAN administrator to control 
device connectivity using zones (small private SAN groups). A single SAN fabric 
may contain none to many zones. Multiple zones may be grouped into a zone 
configuration (or zone config). Brocade switches allow multiple zone config 
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groups to be defined, but only one zone config group may be active within that 
SAN fabric. 

Switches that have conflicting active zone configs or definitions will not merge to 
become one fabric. The switch modules are shipped with no zone definitions. 
However, if the switch module was used in a pre-production or lab SAN 
environment, then often there are zone definitions on the switch modules. 
Therefore, it is important to clear all zone data from switches before adding them 
to an existing SAN fabric. 

1. Ensure that the switch module is not connected to any other switch. 
Otherwise, you may accidentally clear zone configuration for the entire fabric.

2. Open Web Tools and launch the Zone Administration module. Click the 
Zoning icon located in the Fabric Toolbar in the lower left corner of Web Tools 
window. You may need to log in to the switch if you are not already logged in.

3. Select Actions → Clear All.

4. The Disable Config warning displays. Click Yes to do all of the following:

a. Disable the current configuration. 

b. Clear the entire contents of the current Web Tools Zone Admin buffer. 

c. Delete the entire persistent contents of the fabric zoning database.

Brocade SAN Switch Module setup is complete
Repeat the setup process for all switch modules. For this solution, there are two 
switch modules in one BladeCenter chassis. Each switch module will connect to 
an external TotalStorage SAN32B-2 4Gb switch to provide full path redundancy.

Next, set up the external SAN32B, as described in 5.4, “IBM TotalStorage 
SAN32B-2 Switch setup and configuration” on page 76.

Note: This action is not recoverable.
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5.4  IBM TotalStorage SAN32B-2 Switch setup and 
configuration

In this section, we discuss the configuration of the external switch used in our lab 
environment. The switch is the IBM TotalStorage SAN32B-2 Switch, shown in 
Figure 5-21.

Figure 5-21   IBM TotalStorage SAN32B-2 Switch 

5.4.1  Installing the SAN32B-2 in an EIA cabinet
Refer to the Fixed Rack Mount Kit Installation Procedure that shipped with your 
unit for instructions on installing the SilkWorm 4100 in a fixed rack.
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5.4.2  Configuring the SAN32B-2 
The SAN32B-2 must be configured correctly before it can operate within a 
network and fabric. The following items are required for configuring and 
connecting the switch for use in a network and fabric:

� The switch connected to a power source

� A workstation computer that has a terminal emulator application (such as 
HyperTerminal for Windows)

� An unused IP address and corresponding subnet mask and gateway address

� The serial cable provided with the switch

� An Ethernet cable

� SFP transceivers and compatible fibre cables, as required

� Access to an FTP server, for backing up the switch configuration

To configure the TotalStorage SAN32B-2, you must perform the following tasks:

1. “Providing power to the switch” on page 78

2. “Creating a serial connection” on page 78

3. “Connecting to the switch using the serial connection” on page 79

4. “Setting the switch IP address” on page 79

5. “Setting the SAN32B as the principal switch (optional)” on page 80

6. “Setting the time and date (optional)” on page 80

7. “Creating an Ethernet connection” on page 81

8. “Launching Brocade Web tools” on page 81

9. “Configuring SAN32B” on page 83

10.“Installing optional Feature Licenses” on page 85

11.“Clearing the zone database” on page 92

12.“Building a dummy zone (optional)” on page 93

Caution: Do not connect the switch to the network until the IP address is 
correctly set. For instructions on how to set the IP address, see “Setting the 
switch IP address” on page 79.
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Providing power to the switch
To provide electrical power to the SAN32B-2, perform the following:

1. Connect the power cords to both power supplies and then to power sources 
on separate circuits to protect against AC failure. Ensure that the cords have a 
minimum service loop of six inches available and are routed to avoid stress.

2. Power on the power supplies by flipping both AC switches to 1. The power 
supply LED lights up green, and the switch begins running POST. The switch 
requires a minimum of three minutes to boot and complete POST.

3. After POST is complete, verify that the switch power and status LEDs on the 
left of the port side of the switch are green.

Creating a serial connection
To create a serial connection to the SAN32B-2, perform the following:

1. Remove the plug from the serial port and insert the serial cable provided with 
the SAN32B-2.

2. Connect the serial cable to the serial port on the switch and to an RS-232 
serial port on the workstation. If the serial port on the workstation is RJ-45 
instead of RS-232, you can remove the adapter on the end of the serial cable 
and insert the exposed RJ-45 connector into the RJ-45 serial port on the 
workstation.

3. Disable any serial communication programs running on the workstation.

4. Open a terminal emulator application (such as HyperTerminal for Windows or 
TERM in a UNIX® environment) and configure the application as follows:

– In a Windows 95, 98, 2000, or NT environment:

• Bits per second: 9600

• Data bits: 8

• Parity: None

• Stop bits: 1

• Flow control: None

• In a UNIX environment, enter the following string at the prompt:

tip /dev/ttyyb -9600

Note: Power is supplied to the switch as soon as the first power supply is 
connected and turned on.
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Connecting to the switch using the serial connection
To log in to the switch through the serial connection:

1. Verify that the switch has completed POST. When POST is complete, the port 
status and switch power and status LEDs return to a standard healthy state; 
for information about LED signals, refer to the SAN32B-2 Users Guide.

2. When the terminal emulator application stops reporting information, press 
Enter to display the login prompt.

3. Log into the switch (Example 5-1) using admin with password password. You 
will be prompted to change all the default passwords, or you can hit Ctrl-C and 
escape to a prompt. If you do change the passwords, then please record the 
changes and store securely. Recovering lost passwords may be disruptive to 
operations. 

Example 5-1   Serial connection login

Fabric OS (IBM_2005_B32)

IBM_2005_B32 console login: admin
Password:********
Please change your passwords now.
Use Control-C to exit or press 'Enter' key to proceed.

Password was not changed. Will prompt again at next login
until password is changed.
IBM_2005_B32:admin>

Setting the switch IP address
To replace the default IP address and related information:

1. Enter the ipAddrSet command (Example 5-2) at the terminal emulator 
application prompt, and enter the requested information at the prompts.

Example 5-2   ipAddrSet command

IBM_2005_B32:admin> ipaddrset
Ethernet IP Address [9.42.17.9]: 9.42.171.9
Ethernet Subnetmask [255.255.255.0]:
Fibre Channel IP Address [0.0.0.0]:
Fibre Channel Subnetmask [0.0.0.0]:
Gateway IP Address [9.42.171.3]:
Issuing gratuitous ARP...Done.
2006/02/17-15:12:03, [WEBD-1007], 1,, INFO, IBM_2005_B32, HTTP server will be 
re
started due to change of IP Address
IP address is being changed...Done.
Committing configuration...Done.
 Chapter 5. Brocade SAN configuration 79



IBM_2005_B32:admin>

2. Optionally, verify that the address was correctly set by typing the ipAddrShow 
command at the prompt.

3. Record the IP address on the pull out tab (see Figure 5-21 on page 76) 
provided for this purpose on the port side of the SAN32B-2.

Setting the SAN32B as the principal switch (optional)
When the SAN32B is used as the core switch for connecting multiple 
BladeCenter chassis and other external switches then an optional step is to set 
the SAN32B (or other core switch) as the principal switch. There is always one 
principal switch in a FC fabric and its primary responsibility is to manage 
domains IDs and rebuild the fabric when necessary. Typically, either the switch 
that is first powered up or (in the case where all switches are powered 
simultaneously) the switch with the lowest WWN will become the principal switch. 
Another best practice is to perform all fabric management activity (for example, 
zoning, and security changes when using the Advanced Secure option) from the 
core switch regardless if the core switch is principal one.

While logged into the SAN32B using the serial port, use the fabricPrincipal 
command (Example 5-3) to set the principal switch selection mode. 

Example 5-3   fabricPrincipal command

IBM_2005_B32:admin> fabricprincipal 1
Principal Selection Mode enabled 
IBM_2005_B32A:admin>

Setting the time and date (optional)
Set the switch time and date using the command-line interface (CLI). Switches 
maintain the current date and time in flash memory and because the date and 
time are used for logging, you should set them correctly.

1. Enter the date command using this syntax:

date "mmddHHMMyy"

Where:

– mm: Month (01-12)

– dd: Day (01-31)

– HH: Hour (00-23)

– MM: Minute (00-59)

– yy: Year (00-99)
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An example is shown in Example 5-4.

Example 5-4   date syntax

IBM_2005_B32:USERID> date
Fri Jan 29 17:01:48 UTC 2000
Brocade4Gb:USERID > date "0227123003"
Thu Feb 27 12:30:00 UTC 2003
IBM_2005_B32:USERID >

2. Enter the tsTimeZone command to set the time zone using the syntax 
tsTimeZone [houroffset[,minuteoffset]]. The default time zone is 
Universal Time Conversion (UTC), which is 8 hours ahead of Pacific Standard 
Time (PST)

– For Pacific Standard Time, enter tsTimeZone -8,0.

– For Central Standard Time, enter tsTimeZone -6.0.

– For Eastern Standard Time, enter tsTimeZone -5,0.

3. To synchronize time with an external source such as an NTP server: 

– Enter the tsclockserver command with the syntax tsclockserver ipaddr, 
where ipaddr is the IP address of the NTP server that the switch must be 
able to access. 

4. The serial port is no longer required. Log out of the serial console, remove the 
serial cable, and replace the plug in the serial port.

Creating an Ethernet connection
To create an Ethernet connection to the SAN32B:

1. Remove the plug from the Ethernet port.

2. Connect an Ethernet cable to the switch Ethernet port and to the workstation 
or to an Ethernet network containing the workstation.

Launching Brocade Web tools 
Web Tools requires any browser that conforms to HTML Version 4.0, JavaScript 
Version 1.0, and Java Plug-in 1.4.2_06 or higher. You can launch Web Tools on 
any workstation with a compatible Web browser installed. Web Tools also 
supports the HTTPS protocol, if that protocol is enabled for the switch. For more 
information about enabling the HTTPS protocol on your switch, refer to the Fabric 
OS Administrator's Guide v5.0.1. 

Note: At this point, the switch can be accessed remotely, by command line, or 
by Brocade Advanced Web Tools. Ensure that the switch is not being modified 
from any other connections during the remaining tasks.
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1. Set the browser for optimum performance. 

– Correct operation of Web Tools with Internet Explorer requires specifying 
the appropriate settings for browser refresh frequency and process model. 
Browser pages should be refreshed frequently to ensure the correct 
operation of Web Tools. 

– To set the refresh frequency:

i. Select Tools → Internet Options in the browser.

ii. Click General tab and click Settings (under Temporary Internet Files).

iii. Click Every visit to the page under Check for newer versions of stored 
pages.

2. From Internet Explorer (Windows) or Mozilla (Linux) browser, enter the IP 
address for your switch in the Address window box, then press the Enter key. 
You should see a Web Tools session open that is similar to Figure 5-22. 

Figure 5-22   Web Tools initial window
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Configuring SAN32B
The default domain ID for every switch is 1. All Domain IDs in a FC fabric must be 
different and range from 1-239. One naming convention is to use the last three 
digits of the switch's IP address as the domain ID (assuming the address is less 
that 239). 

1. from the Switch View Button menu, select the Admin button. Log in to the 
switch using the following information: 

Login admin

Password password

Figure 5-23   Setting Domain ID and Switch Name

2. Set Switch Status to Disable (Figure 5-23). You must disable a switch before 
changing the Domain ID. 

3. Select the Domain ID of the switch.
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Guidelines for selecting Domain ID Numbers:

– Set unique domain numbers for each switch in the SAN. This allows for 
simpler merging of fabrics if needed in the future.

– As a convention, consider setting the domain ID of each switch to the last 
octet of its IP address. 

– Be aware that the highest allowed domain number is 239. 

– See Figure 5-24 as an example of both external switches and embedded 
switch modules. 

Figure 5-24   Selecting Domain ID numbers

4. Enter this new Domain ID into the Domain ID field.

5. Set the switch's name to some unique and descriptive name. The switch 
name will display in fabric views and event logs and simplify management. 
The name can include up to 15 characters, must begin with a letter, and must 
consist of letters, digits, and underscore characters, and no spaces. Setting 
the switch name is recommended to simplify locating switch module and 
fabric management. For example, the switch name Sw9_B32_A indicates 
Switch Domain 9 is a B32 in Fabric A.
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6. Go to the Configure tab (Figure 5-25) and ensure that the Switch PID Format 
field is set to Format 1. Switch PID is the default setting for all Brocade 
products and is recommended for all new SAN installs. All switches in the 
SAN fabric must use the same Switch PID format. If the SAN32B is being 
connected to an existing SAN Fabric that is not using Switch PID 1, then see 
“Building the Brocade SAN fabric” on page 101". 

Figure 5-25   Verifying Switch PID Format window

7. Return to the Switch tab and set Switch Status to Enable. Click Apply.

Installing optional Feature Licenses
Install any additional Feature Licenses, if necessary. For the SAN32B the 
optional licensed features include Extended Fabrics, ISL Trunking, Advanced 
Performance Monitoring, Advanced SAN Security, and CUP (used for Mainframe 
environments only).
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1. Access and record the LicenseID (Figure 5-26) (same as the World Wide 
Name (WWN) from the Brocade SAN32B switch module). The LicenseID is in 
the form 10:00:xx:xx:xx:xx:xx:xx, where xx values are unique to each switch 
module. 

Figure 5-26   Option License Paper-Pak example

2. Using Brocade Advanced Web Tools, look in the switch information window to 
find the LicenseID (see Figure 5-22 on page 82). 

3. Go to the following Web site to get feature activation key for your switch 
module: 

http://www.ibm.com/storage/key

a. Enter your e-mail address, switch module license ID, and the transaction 
key below on the Web page. Please note that the LicenseID should be 
entered into the WWN field. 
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b. The Web site (Figure 5-27) will provide you a feature activation key and 
send you an e-mail with the information. Write the feature activation key in 
the space provided on your Paper-Pak for future reference. Store the 
Paper-Pak in a secure location.

Figure 5-27   Brocade Feature Activation Web page
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4. Use Web Tools to enable the licensed feature. Under the Admin Window, 
select the License tab and use the Add button to add the License Keys (see 
Figure 5-28).

Figure 5-28   License Management window

5. The Add License dialog box appears and you should type or paste the 
Feature Activation License Key in the field (see Figure 5-29 on page 89).
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Figure 5-29   Adding a License Key

6. Select Please click here to add more licenses and continue adding 
licenses keys until complete (Figure 5-30).

Figure 5-30   Adding more licenses
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7.Click Refresh on License tab to verify that the new License has been added to 
the Feature List (see Figure 5-31). 

Figure 5-31   Verify licenses

7. If installing a Ports-on-Demand Upgrade license onto the B32 switch, then 
you must take additional steps to enable the newly added ports.

a. Go to the Ports tab under Admin.

b. The newly added ports will be licensed but not enabled. Check all boxes 
under the Enable Port column for each new port that you wish to enable. 

c. Click Apply (see Figure 5-32 on page 91).
90 IBM BladeCenter 4Gb SAN Solution



Figure 5-32   Enabling newly licensed ports

Below are the best practices for storing license information. 

1. Keep hard copies of licenses and store them securely:

a. Writing License Activation Keys on the original Paper-Pak forms. 

b. Printing a screen capture of the licenses from Web Tools.

c. Telnet into the switch module and issue the licenseShow command and 
then print the results. 

Important: You should securely store the LicenseID and all the License Keys 
for every switch. Keeping this information available helps recover licenses if 
licenses are accidentally removed. Also, you or service personnel will need 
the licenses to reinstall these features in the event that a field replacement unit 
(FRU) is required.
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d. Remove the white labels from the Paper-Paks and add them to the front, 
side, top, or bottom of the switch. Adding labels to the side of switch 
module requires a power down and should be performed before going into 
production. 

e. Print a copy of the switch configDownload file (see Figure 5-33). 

Figure 5-33   Downloading Switch configuration

f. Keep softcopy files of licenses and other critical switch information by 
using the configDownload function in the Configure tab under Admin. 

Clearing the zone database
Zoning is a feature of FC switches that allow the SAN administrator to control 
device connectivity using zones (small private SAN groups). A single SAN fabric 
may contain none to many zones. Multiple zones may be grouped into a zone 
configuration (or zone config). Brocade switches allow multiple zone config 
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groups to be defined, but only one zone config group may be active within that 
SAN fabric. 

Switches that have conflicting active zone configs or definitions will not merge to 
become one fabric. The SAN32B is shipped with no zone definitions. However, if 
the switch was used in a pre-production or lab SAN environment, then often zone 
definitions are on the switch. Therefore, it is important to clear all zone data from 
switches before adding them to an existing SAN fabric. 

1. Ensure that the switch is not connected to any other switch. Otherwise, you 
may accidentally clear zone configuration for the entire fabric.

2. Open Web Tools and launch the Zone Administration module. Click the 
Zoning icon located in the Fabric Toolbar in the lower left corner of Web Tools 
window. You may need to log in to the switch if you are not already logged in.

3. Select Actions → Clear All.

4. The Disable Config warning displays. Click Yes to do all of the following:

a. Disable the current configuration. 

b. Clear the entire contents of the current Web Tools Zone Admin buffer. 

c. Delete the entire persistent contents of the fabric zoning database. 

5. Next, determine if you need to build a dummy zone on the SAN32B.

Building a dummy zone (optional)
Brocade products by default allow all devices full connectivity when there are no 
zone definitions. A good practice during the initial building of the SAN fabric is to 
create a dummy zone that prevents all device connectivity until you define the 
necessary zones. In our solution here, the SAN32B acts as the core switch for 
SAN switch modules. So we will create a dummy zone on the SAN32B before 
connecting the SAN switches modules or other devices. The dummy zone will 
consist only of the WWN of the SAN32B and thus preventing all other devices 
access until proper zones can be defined. 

1. Open Web Tools and launch the Zone Administration module. Click the 
Zoning icon located in the Fabric Toolbar in the lower left corner of Web Tools 
window. You may need to log in to the switch if you are not already logged in.

Note: This action is not recoverable.
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2. While in the Alias tab (Figure 5-34), click Create to create an Alias with the 
name of the switch, for example, Sw9_B32_A. You will see the new Alias 
name in the window. 

Figure 5-34   Zone Management window

3. Select the Alias you just created. It should be seen in the Name box. Then 
click the Add Other button.
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4. Enter the WWN of the device and click OK (Figure 5-35). The window shown 
in Figure 5-36 should appear.

Figure 5-35   Creating an Alias

Figure 5-36   Defining the Alias
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5. Enter the WWN (License ID) (Figure 5-37) of the SAN32B and click OK.

Figure 5-37   Entering the WWN of the switch to define the alias
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6. Go to the Zone tab (Figure 5-38) and click Create. Name the zone Fabric_A 
Dummy Zone for Fabric A or Fabric_B_Dummy_Zone for fabric B.

Figure 5-38   Creating a new zone
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7. Expand the Aliases folder (Figure 5-39) in the left side of window. Find and 
highlight the alias with the switch WWN and click Add Member. 

Figure 5-39   Mixed Zoning 

8. Click the Config tab (Figure 5-40 on page 99) and create a new Config titled 
Fabric_A_Zones (or B).
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Figure 5-40   Creating a new zone config

9. Expand the Zones folder (Figure 5-40) on left side of window, highlight the 
dummy zone (Fabric_A_Dummy_Zone), and click Add Member. 

10.Click Action in the top toolbar of the Zone Management window and select 
Enable Config. Then select Fabric_A_Zones (Figure 5-41) and click OK.

Figure 5-41   Enabling a zone config
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11.Watch the window and wait for zone commit to complete. It may take several 
seconds. In the Zone window, verify that Fabric_A_Zones is the Effective 
Config (Figure 5-42). 

Figure 5-42   Viewing Effective Config

SAN32B setup is complete
Repeat the setup process for all external switches. For this solution, there are 
two SAN32B switches, one each for Fabric A and B.

Once the SAN32B switches are setup, connect the Brocade 4Gb SAN Switch 
Modules in the BladeCenter, as described in 5.5, “Building the Brocade SAN 
fabric” on page 101. 
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5.5  Building the Brocade SAN fabric
This section details steps for connecting the FC switches to build a SAN fabric. 
Since this solution has redundant SAN fabrics for increased availability, you must 
repeat the steps for the second fabric. No optional licenses are required to 
connect the Brocade switch module to the SAN32B. You may start with a single 
switch and then scale. 

For this specific solution, we are using the optional advanced feature ISL 
Trunking and building 8Gb Trunks between the switch module to the SAN32B. 
Using ISL Trunking enhances the performance, availability, and manageability of 
the SAN fabric. However, ISL Trunking licenses are not required to build this or 
any SAN solution. 

If you are not using ISL Trunking feature, then simply skip the Brocade ISL 
Trunking section and proceed to 5.5.4, “Connecting Brocade 4Gb SAN Switch 
Module to SAN32B” on page 105. 

5.5.1  Brocade ISL Trunking
ISL Trunking optimizes network performance, availability, and manageability by 
merging multiple ISLs (inter-switch links) into a single logical entity called the 
trunk group. The trunk group offers these beneficial characteristics: 

� Enhanced Performance: ISL Trunking distributes FC traffic at the frame level 
across the shared bandwidth of all member links with in-order delivery.

� Simplified ISL Management: ISL Trunking reduces or eliminates situations 
that require individual ISL configuration to achieve optimal performance and 
also simplifies fabric design and management (for example, one 12Gb Trunk 
is simpler to manage than three 4Gb ISLs). 

� Increased SAN Availability: ISL Trunking enhances ISL availability by 
reducing the effects of ISL failures propagating within the SAN fabric. Since 
the trunk entity is comprised of multiple ISL links, then the failure of one 
member link does not cause a fabric re-route to occur. 

� Lower Total Cost of Ownership: By improving SAN performance, availability, 
and manageability, ISL Trunking requires fewer ISLs, thus freeing FC ports 
and lowers the TCO of the SAN solution. 
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The Brocade 4Gb SAN Switch Module ISL Trunking feature allows for two trunk 
groups with up to three ISL connections each between itself and any other 
Brocade switch that has an ISL Trunking license installed. Each trunk group 
allows for three ISLs to merge logically into a single 12 Gbps link between 
switches (Figure 5-43). It is compatible with both short wavelength (SWL) and 
long wavelength (LWL) fiber optic cables and transceivers.

Figure 5-43   Six ISLs become two 12Gb ISL Trunks

5.5.2  Dynamic Path Selection (DPS) 
The Brocade 4Gb SAN Switch Module also offers a performance enhancing 
feature called Dynamic Path Selection (DPS). DPS is a routing scheme that 
optimizes fabric-wide performance by automatically routing data to the most 
efficient available path in the fabric. While ISL Trunking can balance traffic at the 
most granular level (the FC frame) DPS balances loads at the FC Exchange level 
such as a SCSI read or write. DPS augments ISL Trunking to provide more 
effective load balancing in certain configurations, such as routing data between 
multiple trunk groups. As a result, a combination of DPS and ISL Trunking 
provides the greatest design flexibility and the highest degree of load balancing 
(see Figure 5-44 on page 103). 
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Figure 5-44   DPS with ISL Trunking offers 24 Gb of balanced performance

5.5.3  Trunking criteria
On the Brocade 4Gb SAN Switch Module, all trunking ports must meet the 
following criteria for standard distance trunking:

� There must be a direct connection between participating switches.

� Trunk ports must reside in the same port group (see Figure 5-45 on page 104 
and Figure 5-46 on page 104). 

� Trunk ports must run at the same speed (either 2 Gbps or 4 Gbps).

� Trunk ports must be E_Ports.

� Cable lengths for participating links should differ by no more than 550 meters.

� Trunk ports must be set to the same ISL mode (L0 is the default).

� This feature is not supported in interoperability mode.

For more information about ISL Trunking in general or Trunk Groups on other 
Brocade switch models, refer to the Brocade Fabric OS Administrator's Guide.

Brocade 4Gb SAN Switch 
Module with ISL Trunking 
License. 
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The diagrams in Figure 5-45 and Figure 5-46 shows the possible Trunk Groups 
on the Brocade 4Gb SAN Switch Module and the SAN32B.

Figure 5-45   ISL Trunk Groups for 4Gb SAN Switch Module

Figure 5-46   SL Trunk Groups for SAN32B
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5.5.4  Connecting Brocade 4Gb SAN Switch Module to SAN32B
In this section, we will connect the 4Gb SAN switch module to the TotalStorage 
SAN32B.

1. Power off all server blades in BladeCenter before connecting the switch 
module to the external SAN Fabric to minimize port logins. 

2. Install the SFP transceivers in the Fibre Channel ports, as required. All SFP 
transceivers must be 4Gb capable for 4Gb end-to-end bandwidth. Otherwise, 
the switches will negotiate to the highest, common supported speed (for 
example, 1Gb or 2Gb).

You should connect the switches as though you are using the ISL Trunking 
feature. This allows you to add ISL Trunking in the future without rearranging 
the cables. 

Installing SFP transceivers:

a. Remove the plugs from the FC ports to be used.

b. Position a transceiver so that it is oriented correctly and insert it into a port 
until it is firmly seated and the latching mechanism clicks. 

c. Repeat steps a and b for the remaining ports, as required.

3. Connect one fiber cable between the SAN switch module and the SAN32B.

4. Observe the LED to ensure the link initializes correctly. The Port Status LED 
should be solid green for both the SAN32B and switch module. Figure 5-47 
on page 106 shows the LED definition for the switch module.

Note: The transceivers are keyed to ensure correct orientation. If a 
transceiver does not install easily, ensure that it is correctly oriented.

Orient a cable connector so that the key (the ridge on one side of 
connector) aligns with the slot in the transceiver. Then, insert the cable into 
the transceiver until the latching mechanism clicks.

Caution: A 50 micron cable should not be bent to a radius less than 2 
inches under full tensile load and 1.2 inches with no tensile load.

Tie wraps are not recommended for optical cables because they are easily 
over-tightened.
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Figure 5-47   Brocade 4Gb Switch Module LED definitions

If the link does not come online, here are some simple steps to troubleshoot:

– Check the SFP transceiver and cable seating. 

– Check that the switch modules external ports are enabled in the 
Management Module GUI.

– If that does not correct the issue, then disconnect the switch module and 
try the following steps:

i. Using the Zone Management tool, clear the zone configuration.

ii. Using the Admin tool under the Configure Fabric tab, verify the Switch 
PID formats for the switch module and SAN32B match (Format 1).

iii. Using the Admin tool under the Switch tab, verify that the Switch 
Domain ID is different from the SAN32B match.

iv. Using the Admin tool under the Ports tab and Speed column, ensure 
that the switch module and SAN32B ports are set for AN 
(auto-negotiate). 

v. Using the Admin tool under the Ports tab and Long Distance column, 
ensure that the switch module and SAN32B port settings match (the 
default is L0). 

vi. Open the Management Module GUI and Power Down switch module.

vii. Reconnect the cable between the SAN32B and switch module.

viii.In the Management Module GUI, power on the switch module.

– If these steps do not correct the problem, you can refer to the 
Troubleshooting chapter in the Brocade Fabric OS Administrator's Guide 
that is included on the SAN Switch Module Documentation CD.

1 - System Status OK
2 - System Status Fault
3 - Port Speed
4 - Port Status
5 - Port Diagnostics
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– If you cannot determine the issue, then contact your SAN or BladeCenter 
supplier for support.

5. Once the first link is online, repeat the steps to connect the remaining links 
between the switch module and external switch. 

6. Open Web Tools and click the Topology icon in the Fabric Toolbar in lower 
left of window. Verify that the switch module has merged with the external 
fabric.

7. For the switch module, go to the Web Tool Switch View and verify that the 
effective zone configuration transferred from the SAN32B. In our case, the 
effective zone configuration is Fabric_A_Zones. 

8. This completes building Fabric A. Repeat these steps for building Fabric B.

9. Proceed to 5.6, “Connecting storage and servers to SAN fabric” on page 111. 

5.5.5  Using ISL Trunking (optional)
If an ISL Trunking licenses is installed on both the switch module and external 
switch, then ISL Trunks should form when connecting the two switches. Review 
the criteria for building ISL Trunks at the beginning of this section and then use 
these steps to verify that the trunk groups form correctly. 
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Building ISL Trunks with an initial SAN setup
If ISL Trunking licenses are installed on switches before the SAN fabric is built, 
then follow these steps:

1. Follow steps 1-4 in “Connecting Brocade 4Gb SAN Switch Module to 
SAN32B” on page 105 to connect the initial link between the switch module 
and external switch. 

2. Verify that a Trunk group has been formed. In Web Tools, click the Admin 
button and log in. 

3. Select the Trunking tab and verify that the trunk group has formed (see 
Figure 5-48).

Figure 5-48   Viewing Trunk groups

4. Connect additional links between the switch module and external switch trunk 
port groups. Allow the links to establish.
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5. On the Admin Trunking window, click the Refresh button and view the 
Member Ports column. Verify that the new link is now a member of the same 
Trunk group (see Figure 5-49).

Figure 5-49   Viewing a two member trunk

6. Repeat, adding cables and verifying trunk members as necessary. The SAN 
32B supports trunk groups up to eight members and up to 32 Gb of 
bandwidth. The Brocade 4Gb SAN Switch supports up to two three-member 
trunk groups of 12 Gb each. 

7. This completes building Trunks for Fabric A. Repeat the steps for Fabric B.

8. Proceed to 5.6, “Connecting storage and servers to SAN fabric” on page 111. 
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Adding ISL Trunks to an existing SAN fabric
If ISL Trunking licenses are added to Brocade switches in an existing fabric (for 
example, the switches are already connected), then follow the following steps to 
enable ISL trunks groups:

1. Add ISL Trunking licenses to the switches.

2. Initialize the ports being used for ISLs so that they recognize that trunking is 
enabled. This procedure only needs to be performed one time from either the 
switch module or the external switch.

Enabling Trunk Groups from the 4Gb SAN switch module
1. Reinitialize the external ports from the Management Module GUI. Simply 

disable and then re-enable the External Ports (see Figure 5-50).

Figure 5-50   Disabling/Enabling External SAN Switch Module Ports

2. Verify that trunk members have been formed by viewing the Admin Trunking 
tab.
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Enabling Trunk Groups from the external switch
1. Using Web Tools, go to the Admin Port window. Uncheck the Enable Port 

check box for all ports that are ISLs (E-Ports). 

2. Click Apply. The ports are now disabled.

3. Check the Enable Port check boxes for these same ports and click Apply. 
The ports are now enabled.

4. Click the Trunking tab and verify that these ports have become members of 
the trunk groups.

This completes adding ISL Trunking for Fabric A. Repeat for Fabric B.

5.6  Connecting storage and servers to SAN fabric
This section details the recommended steps for connecting server and storage 
devices to your redundant SAN fabrics. Other than cabling the devices to the 
SAN fabric, all these steps are best practice procedures and not firm 
requirements. 
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5.6.1  Connecting DS4800 to SAN fabric
The DS4800 is configured with dual redundant controllers (A and B). Each 
controller has four channels to external servers or SAN fabrics. We recommend 
connecting at least two channels per controller to the redundant fabrics. This 
allows access to each controller if there is a link failure (see Figure 5-51).

Figure 5-51   Fully redundant 4Gb SAN Solution

The ideal steps for connecting devices to SAN fabric are the following:

1. Ensure that proper SFP transceivers are firmly seated in the switch ports. For 
end-to-end 4Gb solutions, 4Gb SFP transceivers must be used and the 
connecting device must be 4Gb capable. Otherwise, the devices will negotiate 
to the highest, common supported speed (for example, 1Gb or 2Gb).
112 IBM BladeCenter 4Gb SAN Solution



2. For the external switches, pre-assign ports to specific devices. 

An example for the SAN32B is shown in Figure 5-52. Here ports 0-7 are 
pre-assigned to Storage Devices. Ports 8-15 are pre-assigned for non-bladed 
servers. Ports 24-31 are pre-assigned for ISLs from other switches or switch 
modules. Ports 16-23 are unused and may be assigned as the SAN grows. 

Figure 5-52   Port assignment for SAN32B

3. Power down the storage device (for example, the DS4800).

4. Connect the fiber cables between the switch and the ports on the storage 
controller. Listen for the latching mechanism to click and lock into the 
transceiver.

5. Power up the storage device to add one device. 

Note: If powering down the storage device is not possible, then disable the 
switch ports assigned to the storage device.

Note: Ensure that you connect cables from DS4800 Controller A to 
SAN32B in Fabric A and Controller B to SAN32B in Fabric B.

Note: Enable the switch port if the storage was connected while powered 
up.
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6. Verify that the device successfully logged into the switch. 

a. The Port Status LED should be solid green.

b. Check the Name Server table for the device information. The Name Server 
table is accessed by clicking on the Name Server icon at the bottom of the 
Fabric Toolbar area in Web Tools. The Name Server table will list the 
devices logged into the fabric, as shown in Figure 5-53.

Figure 5-53   Viewing devices in the Name Server Table

7. Check proper device connectivity on both Fabric A and B.

8. The storage devices are now connected to the SAN fabric. Next, connect the 
server blades to the SAN fabric.

5.6.2  Connecting server blades to the SAN fabric
In this section, we discuss connecting the server blades to our SAN fabric.

1. Ensure that proper SFP transceivers are firmly seated in the switch ports. For 
end-to-end 4Gb solutions, 4Gb SFP transceivers and the FC daughter card 
must be used.
114 IBM BladeCenter 4Gb SAN Solution



2. Install the 4Gb FC daughter card into the server blades if you have not done 
so.

3. Configure the daughter card. 

4. Install and power up the server blade. Allow it to fully boot.

5. Check the switch modules Web Tools window to ensure that the server blade 
successfully logs into the switch module. The Port Status LED should be solid 
green to indicate a good connection. 

6. Verify that it successfully logged into the switch module. From Web Tools, 
check the Name Server in the Fabric Toolbar and check that the blade 
server's FC daughter card WWN is listed. Repeat for switch modules A and B.

7. Power up and verify each blade server one at a time. 

8. Once the blade servers and associated storage devices are powered up and 
connected to the SAN fabric, you may create zones to allow proper device 
connectivity. See “Zoning to control device connectivity” on page 115 for more 
information. 

5.7  Zoning to control device connectivity
In this section, we establish zoning to control the fabric and storage connectivity.

5.7.1  Zoning overview
Advanced Zoning is a licensed Brocade product that allows partitioning of a 
storage area network (SAN) into logical groupings of devices that may access 
each other. These logical groupings are called zones. Zoning definition may be 
managed from any Brocade switch in the fabric and all changes are propagated 
to the rest of fabric. As a best practice, manage zones from the switch with the 
latest FOS version. If all switches have same FOS versions, then manage the 
zones from the core switch. 

You can use Advanced Zoning to customize environments and optimize 
resources:

� Customize environments: You can use zones to create logical subsets of the 
fabric to accommodate environments, such as closed user groups or 
functional areas within the fabric. For example, you can identify selected 
devices within a zone for the exclusive use of zone members, or you can 
define a zone to create separate test or maintenance areas within the fabric.

� Optimize resources: You can use zones to logically consolidate equipment for 
efficiency or to facilitate time-sensitive functions; for example, to create a 
temporary zone to back up non-member devices.
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A zone is a specified group of fabric-connected devices, also called zone objects, 
which communicate to one another. Any zone object connected to the fabric can 
be included in one or more zones.

Zones can overlap, that is, a zone object can belong to more than one zone and 
a fabric can have multiple zones.

Multiple zones may be grouped into a zone configuration (also called a config). A 
fabric can have any number of resident zone configurations; however, only one 
active configuration can be enabled at a time.

Individual zones cannot be enabled. Only one zone configuration may be 
enabled within a SAN fabric.

From previous steps in the SAN32B setup and configuration, there is an Effective 
Config called Fabric_A_Zones. This config consists only of a dummy zone that 
prevents all devices from seeing each other. The upcoming steps will add useful 
zones to this configuration so that the servers can access the storage.

5.7.2  Managing zones with Web Tools
You can monitor and manage zoning through the Web Tools Zone Admin module. 

1. Ensure that server and storage devices are connected and logged into the 
SAN fabric.

2. From the SAN32B in Fabric A, click the Zone Administration icon in the 
Fabric Toolbar to access the Zone Admin module, as shown in Figure 5-54 on 
page 117. 

Note: After a zone configuration is enabled, if a device is not explicitly defined 
in a zone, that device is isolated and inaccessible by other devices in the 
fabric.
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Figure 5-54   Zone Administration window

5.7.3  Building zone aliases 
A zone alias is a name assigned to a device or a group of devices. By creating an 
alias, you can assign a familiar name to a device or group multiple devices into a 
single name. This simplifies cumbersome data entry and allows an intuitive 
naming structure for non-descriptive items, such as port numbers or a WWN. For 
example, you can use the name BC7_Blade3_Win2K_A as an alias for the FC 
daughter card port WWN 21:00:00:80:33:3f:aa:11.

1. Select the Alias tab and click Create.
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2. Create a unique Alias name for port A of the FC daughter card server blade. 
Here we used BCH2_Blade7_FabricA (see Figure 5-55).

Figure 5-55   Creating an Alias name server blade 7

3. On the left hand side of window, fully expand the Port & Attaching Devices 
tree. All switches in the fabric will be shown. Find and expand the SAN Switch 
Module. If there are multiple switch modules, then they can be differentiated 
by their switch name (if you assigned them unique switch names) or domain 
IDs.

4. Find the correct port on the switch module. In this case, we are looking for 
port 7 that is connected to blade 7. Expand port 7 until the WW Port Name 
(WWPN) is shown. For each device, the WWPN will be the second (inner) 
WWN shown in the Port tree. The first (outer) WWN is called the WW Node 
Name (WWNN). Always use the WWPN for the most secure zoning (see 
Figure 5-56 on page 119).
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Figure 5-56   Finding WW Port Names of devices

5. Highlight the WWPN and click Add Member. Now the Alias is assigned the 
WWPN for the server blade. 

6. Repeat these steps for all server blades in Fabric A. Assign each server port a 
unique and descriptive name.
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7. Next, click Create to create Alias names for the storage ports. Here, we 
create the Alias name DS4800_Ctrl_A_Ch3 and will assign it the WWPN for 
channel 3 on the DS4800 controller A, as shown in Figure 5-57

Figure 5-57   Creating the Alias name for the storage port

8. From the Zone Administration window under Ports and Attaching Devices, 
find the SAN32B and expand the port connected to Channel 3 of Controller A 
of the DS4800. 

9. Highlight the WWPN for the storage port and click Add Member (see 
Figure 5-58 on page 121).
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Figure 5-58   x-x. Assigning WWPN of storage port to Alias

10.Repeat assigning alias names for all storage ports in Fabric A. 

5.7.4  Building zones 
Once the alias are created, we can now build zones. Useful zones may be as 
small as two devices or as large as all the devices in the fabric. Zones may be 
based on operating systems, departments, applications, or any other scheme. 
The best zoning practice is building zones based on single FC adapter ports, 
commonly known as Host Bus Adapter (HBA) zones.

Zoning by single HBA most closely re-creates the original SCSI bus. Each zone 
created has only one HBA (initiator) in the zone; each of the target devices is 
added to the zone. Typically, a zone is created for the HBA and the disk storage 
ports are added. If the HBA also accesses tape devices, a second zone is 
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created with the HBA and associated tape devices in it. In the case of clustered 
systems, it could be appropriate to have an HBA from each of the cluster 
members included in the zone; this is equivalent to having a shared SCSI bus 
between the cluster members and presumes that the clustering software can 
manage access to the shared devices. In a large fabric, zoning by single HBA 
requires the creation of possibly hundreds of zones; however, each zone 
contains only a few members. Zone changes affect the smallest possible number 
of devices, minimizing the impact of an incorrect zone change. This zoning 
philosophy is the preferred method.

1. Select the Zone tab.

2. Click Create and enter a unique zone name for a specific server-storage 
combination (see Figure 5-59). Here we name the new zone Zn_ 
BCH2_Blade7_DS4800_A. We use the prefix Zn to designate that this name 
is a zone name. The BCH2 represents the specific BladeCenter chassis; 
Blade7 the blade server and DS4800 the storage device. 

Figure 5-59   Creating a new zone name
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3. Expand the Alias tree in the left hand side of the zone window. Highlight the 
Alias name for correct server blade and click Add Member. Also add to the 
zone the Alias names for the DS4800 ports (see Figure 5-60).

Figure 5-60   Adding Members to a zone

4. Repeat the steps to create and populate zones for each blade server. The 
DS4800 ports should be included in the zone if that server blade will need to 
access storage on the array.

5. Once all the zones are built, we need to create a zone configuration.
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5.7.5  Building and enabling zone configurations
As discussed earlier, a zone configuration (also called a config) consists of zone 
definitions. There many be multiple zone definitions defined, but only one config 
may be enabled within the fabric. This enabled zone configuration is called the 
effective config. In this case, the Effective Config is Fabric_A_Zones, which 
currently consists only of the Fabric_A_Dummy_Zone. We will now add the newly 
created zones to this zone configuration.

1. Select the Config tab and ensure that Fabric_A_Zones is in the Name box. 
Then expand the Zones tree, as shown in Figure 5-61. 

Figure 5-61   Zone config window
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2. Highlight and add the server blade zones to the config (see Figure 5-62).

Figure 5-62   Adding members to a zone config
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3. Enable the zone config with the new zone definitions. From the upper tool bar, 
select Actions and Enable Config (see Figure 5-63).

Figure 5-63   Options for zone actions

4. The Enable Config dialog box will appear. Select the proper zone config name 
and click OK (see Figure 5-64 on page 127). 
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Figure 5-64   Enable Config dialog box

5. A warning dialog box will appear. Click Yes (see Figure 5-65).

Figure 5-65   Enable Config warning

6. The activity window in the lower portion of window will inform you when the 
zone config commit is successful. Wait until the commit is complete before 
attempting other activities.

7. The new zone config is now effective.

To save your changes, select Actions → Save Config Only. 

Note: If you do not enable the new config, then you should save the 
changes you have made. Any changes you make in the Zone Admin 
module are held in a buffered environment and does not update the zoning 
database until you save the changes. If you close the Zone Admin module 
without saving your changes, your changes are lost.
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8. Select File → Print Summary from the upper toolbar. Use the resulting 
printout to help the map server’s WWNs to Storage Volumes (see 
Figure 5-66). 

Figure 5-66   Zoning configuration summary

9. Repeat these steps for Fabric B. 

a. Under Admin tools, select the Configure tab.

b. Select the Upload/Download subtab.

c. Insert the proper FTP server information. 

d. Click Apply (see Figure 5-67 on page 129).

Note: You can also print out helpful device information from the switch 
Name Server window.

Recommended: Back up each switch and switch module configuration. 
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Figure 5-67   Download the switch information

10.Once you have completed Fabric A and B zoning, you can then use the 
storage management software to build and map storage volumes to specific 
servers. See “Mapping a logical disk to server blades” on page 135 for more 
information.

5.7.6  Using additional zoning tools
Brocade offers the administrator numerous tools to simplify the management of 
zones. Below are descriptions of some of these zoning management tools. 
Please reference Brocade Web Tools Administrators Guide for more detailed 
descriptions.
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Zoning Wizards
There are several Zoning Wizards under the Tools menu in the upper tool bar 
that simplifies common zoning activities (see Figure 5-68). Often, SAN admins 
will forget to clean up the SAN database as devices are removed or replaced and 
the zone database will grow and include unnecessary definitions:

� Adding Un-zoned Devices to a zone. This is useful when you connect a new 
device to the SAN fabric.

� Removing Offline Devices from the zone database. This is useful when 
devices have been removed from the fabric due to failure or replacement. 

� Replace Offline Devices simplifies replacing a device that may be included in 
many alias and zone definitions. An example would be when a FC Daughter 
card failed and was replaced. 

� Define Device Alias steps an administrator through the steps to create new 
alias definitions. 

Figure 5-68   Wizards for common zone activities
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Displaying an effective zone configuration
The enabled zone configuration window displays the actual content of the single 
zone configuration that is currently enabled on the fabric, whether it matches the 
configuration that was enabled when the current zone admin session was 
launched or last refreshed. The zones, QuickLoops, and FA zones are displayed, 
and their contents (ports, WWNs, and AL_PAs) are displayed next to them. 
Aliases are not displayed in the enabled zone configuration. If there is no active 
zone configuration enabled on the switch, a message is displayed to that effect.

To view detailed information about the enabled zone configuration:

11.Launch the Zone Admin module. The zone configuration in effect at the time 
you launched the Zone Admin module is identified in the top right corner. This 
information is automatically updated every 15 seconds. It is also updated if 
you manually refresh the Zone Admin module contents by clicking the refresh 
icon at the bottom right corner of the Zone Admin module, or when you 
enable a configuration through the Zone Admin module.

12.Use one of the following methods to identify the most recently effective zone 
configuration without saving or applying any changes you have made in the 
Zone Admin module:

a. Select File → View Effective Configuration in the Zone Admin module.

b. Click the enabled configuration button in the Zone Admin module.
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Both of these actions display the Effective Configuration window 
(Figure 5-69). If no zone is enabled, a message is displayed, indicating that 
there is no active zoning configuration on the switch.

13.Optional: Click Print to print the enabled zone configuration details. This 
launches the print dialog.

Figure 5-69   View Effective configuration window

Displaying the zone configuration summary
The zone configuration summary hierarchically lists all defined zoning elements 
known to the current Zone Admin session, whether any of the listed 
configurations has been enabled, and whether any of the lower level elements 
has been added as members of the higher level (aliases, zones, QuickLoops, 
and FA zones) structures. The zone configuration summary displays the entire 
contents of the fabric zoning database as it was at the time the Zone Admin 
session was launched, or the most recently saved or refreshed information, and 
any unsaved changes you make since the time the Zone Admin session is 
launched. It provides the name of the zone configuration that was enabled at the 
time you launched the Zone Admin session; however, keep in mind that the 
enabled configuration might have changed since then and that this window will 
not reflect those changes.
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To view a zone configuration summary report:

1. Launch the Zone Admin module.

2. Select File → Print Summary.

The Zone Configuration Summary window displays, as shown in Figure 5-70.

It is important to note that the summary displays the information based on the 
changes just made. If current Zone Admin session changes have not yet been 
saved to the fabric, the information displayed here is different from what is 
seen from the switch.

Figure 5-70   Zoning Configuration summary window

3. Optional: Click Print to print the zone configuration summary. This launches 
the print dialog.

Creating a configuration analysis report
The configuration analysis report lists the following:

� SAN components (ports, WWNs, and AL_PAs) that are not included in the 
configuration.

� SAN components (ports, WWNs, and AL_PAs) that are contained in the 
configuration but not in the fabric.
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To create a configuration analysis report:

1. Launch the Zone Admin module.

2. Click the Config tab. Select a configuration to be analyzed from the Name 
drop-down list.

3. Click Analyze Config. 

A dialog displays, asking if you want to refresh the fabric before running the 
analysis. Click Yes. 

4. The configuration analysis window displays.

Displaying the Initiator/Target Accessibility Matrix
The Initiator/Target Accessibility Matrix shows a list of initiators and a list of 
targets and indicates which initiator can access which target, as shown in 
Figure 5-71 on page 135.

To display an Initiator/Target Accessibility Matrix:

1. Launch the Zone Admin module, as described in “Zoning overview” on 
page 115.

2. Click the Config tab.

Select a configuration to be analyzed for device accessibility from the Name 
drop-down list.

3. Click Device Accessibility.

The Initiator/Target Accessibility Matrix for Config- Device Selection dialog 
displays.

4. Select the devices you want displayed in the accessibility matrix; click the 
radio button to select all devices in the fabric or to select a subset of the 
devices.

If you select a subset, you must click the devices from the Select Devices list 
and click Add to move them to the Evaluate for Accessibility list.

5. Click OK.

The Initiator/Target Accessibility Matrix displays (Figure 5-71 on page 135). 
You can mouse over a target to display the symbolic name of the device. In 
addition, you can right-click the device nodes and click View Device Detail to 
display detailed information about the selected device.
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Figure 5-71   Initiator/Target Accessibility Matrix for Config: Fabric_A_Zones

5.8  Mapping a logical disk to server blades
The following section covers the host configuration procedure on the DS4800 
storage subsystem. The DS4800 storage subsystem must be accessible out of 
band over the TCP/IP network; connect to the DS4800 storage subsystem using 
Storage Manager 9.15. The DS4800 software downloads are available at:

http://www-307.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-621
61

5.8.1  Host definition
Once the logical disks have been built using the storage management software, 
you must define host groups to represent the server blades and map these to 
their respective logical disks on the DS4800.
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Figure 5-72 shows three logical disks that have been created, one for each blade 
server. 

Figure 5-72   View of the storage volumes

For organizational purposes, we will create a group of servers called a host 
group. In our case, we will create a host group to represent all the blade severs in 
our specific BladeCenter chassis BCH. Select Mappings under the Host Group; 
we will create one host to represent each blade server within the BladeCenter 
chassis.

Note: Prior to defining your host definition, appropriate zoning should have 
been performed. See “Zoning” on page 275 or 5.7, “Zoning to control device 
connectivity” on page 115.
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5.8.2  Defining a host group
In this section, perform the following steps to define a host group:

1. View and right-click the storage subsystem icon (Figure 5-73) to define a Host 
Group. The Host Group name and how you group are your choices.

Figure 5-73   Define host group
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5.8.3  Defining hosts
In this section, you will define a host:

1. Right-click the BladeCenter Host Group and select Define Host, as shown in 
Figure 5-74.

Figure 5-74   Define the host

2. Name the host to reflect one of the server blades, as shown in Figure 5-75 on 
page 139. 
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Figure 5-75   Naming the host

3. The server blades use dual ported FC daughter cards that have two WWPNs. 
Select the two WWPNs associated with the specific blade server and click 
Add.
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4. Create a descriptive Alias for each WWPN. Make sure to differentiate 
between the two ports (for example, Port 1 and Port 2), as shown in 
Figure 5-76.

Figure 5-76   Naming the WWN for the server blades

5. Specify the host OS type and click Next, as shown in Figure 5-77.

Figure 5-77   Define the Host OS Type
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6. A dialog box will ask you if the host will share the logical drive with other 
hosts. Answer Yes or No depending on your solution. Typically, only clustered 
servers share logical drives. 

7. Verify the final configuration and select Finish to complete the host definition, 
as shown in Figure 5-78.

Figure 5-78   Finalizing the host configuration
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8. Repeat the steps for both FC ports for each server blade. See Figure 5-79 for 
an example.

Figure 5-79   All host ports have been defined
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5.8.4  Define storage partitioning
In this section, perform the following steps to define the storage partition:

1. Right-click one of the server blade hosts to define the Storage Partitioning, as 
shown in Figure 5-80.

Figure 5-80   Defining storage partitions
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2. Select the logical drive that is to be mapped to the server blade and click Add. 
Assign a LUN number to the logical drive. Then click Finish (see 
Figure 5-81).

Figure 5-81   Mapping logical drives to Blade Server hosts

3. Repeat the steps to map the logical disks to each server blade. 

4. Take the necessary steps within the blade server OS to discover and format 
the logical drives. Figure 5-82 on page 145 shows an example of a Windows 
2003 server blade.
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Figure 5-82   Discovering the logical drives

5. Repeat the mapping of the logical disks for each server blade.
 Chapter 5. Brocade SAN configuration 145



146 IBM BladeCenter 4Gb SAN Solution



Chapter 6. McDATA SAN configuration

In this chapter, we discuss how to set up and configure the McDATA 4Gb Fibre 
Channel Switch Modules to attach to a SAN storage environment.

6
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6.1  IBM BladeCenter configuration

In this section, we begin with the setup and configuration of our IBM 
BladeCenter. To do so, please refer to Chapter 4, “IBM BladeCenter setup and 
configuration” on page 35 and follow the instructions prior to completing the 
steps in the following sections. Figure 6-1 shows the SAN topology we used in 
our lab environment. It is assumed that LUN(s) have been created and assigned 
on the storage system prior to this SAN implementation. 

Figure 6-1   IBM BladeCenter utilizing McDATA 4Gb FCSM and McDATA 4400 Fabric attached DSxxxx

6.2  McDATA 4Gb Fibre Channel Switch Modules setup
In this section, we will configure our McDATA 4Gb Fibre Channel Switch Module.

1. Point your browser to the IP Address of the McDATA FCSM. You will need to 
make sure your current Java version is at or above 1.4.2.

2. Log in to the device.
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3. Click OK to the Certificate dialog prompt to continue. 

4. Click the Add button to display your fabric (see Figure 6-2).

Figure 6-2   McDATA SANbrowser window
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5. Enter the IP Address, Login Name, and Password. Click Add Fabric to 
continue (Figure 6-3). 

Figure 6-3   Add a New Fabric window
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6. From the Topology window in the left pane, click the drop-down tree and 
double-click the IP address. Next, select your switch (in our example, 
McDATA4Gb). Select Switch → Switch Properties... (Figure 6-4). 

Figure 6-4   McDATA SANbrowser - Faceplate window
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7. From the Switch Properties dialog (Figure 6-5), enter a symbolic name for 
your switch. Click the Enable radio button next to Domain ID lock (1). Enter a 
Unique Domain ID ranging from 1-31 (2). In our example, we selected 2 for 
the DID. Click OK to continue. 

Figure 6-5   Switch Properties window

8. Click OK when the Updating Switch Properties dialog box appears.

Note: Domain ID lock on a McDATA BladeCenter switch is the same as the 
Insistent Domain ID setting on McDATA Sphereon switches and Intrepid 
Directors. This setting will allow the switch to maintain its configured domain 
ID during a fabric merge or rebuild. 
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9. From the McDATA SANbrowser - Faceplate window, select your desired 
E-Port. Next, select Port → Port Properties (Figure 6-6). In our example, we 
designated port 19. 

Figure 6-6   McDATA SANbrowser - Faceplate window
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10.From the Port Properties dialog box (Figure 6-7), verify the following settings 
are true for port 19:

a. Port State = Online

b. Port Speed = Auto-detect

c. Port Type = G-port

d. I/O Stream Guard = Auto

e. Device Scan = Enable

11.Click OK. 

Figure 6-7   Port Properties window
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12.From the Faceplate, select the Configured Zoneset tab (Figure 6-8). Verify 
there are no zones configured on the switch. If there are zones configured, 
see the manufacturer user's guide for instructions on how to remove the zone 
set and zones. 

Figure 6-8   McDATA SANbrowser - Faceplate window
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6.3  McDATA Edge Switch Sphereon 4400 configuration
In this section, we will perform the configuration for the Sphereon 4400. Please 
complete the following steps:

1. Launch your switch's IP address from your browser. Log in using your User ID 
and password (see Figure 6-9).

Figure 6-9   Edge Switch Sphereon 4400 login window

2. During the initial log-in to the switch, you will be required to change the 
password. Record your new password and store it. Click Activate to initiate 
new password.

3. From the initial window, click View Details to view the switch details.
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Port configuration
4. From the action menu, select Configure → Ports → Basic Info 

(Figure 6-10).

Figure 6-10   SAN16M window
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5. In the port configuration dialog window, you may optionally assign a name to 
the port and define the connection type. In this example, we assigned port 0 
to an E_Port type. By assigning the port type to be specifically an E_Port, no 
N_Ports are allowed to log in to the switch (see Figure 6-11).

Figure 6-11   Port configuration dialog window
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Domain ID configuration
6. Set the switch offline. Select Configure → Switch Online. Uncheck the 

check box (see Figure 6-12).

Figure 6-12   SAN16M window
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7. Select Configure → Switch → Parameters (Figure 6-13). 

Figure 6-13   Configure dialog window
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8. From the Configure → Switch → Parameters settings window (Figure 6-14), 
select Insistent Domain ID (1). Next, define a unique ID ranging between 1 
and 31 (2). In our example, we use Domain ID 3. Click OK. 

Figure 6-14   Configure → Switch → Parameters settings window

 

 

 Chapter 6. McDATA SAN configuration 161



9. To set the switch back to an online state, select Configure → Switch Online 
and check the check box (Figure 6-15). 

Figure 6-15   Configure window
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Connect cables- ISL Verification
10.From the action menu, select Fabric → Fabric View (Figure 6-16).

Figure 6-16   Fabric window
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11.From the Fabric View windows, verify all switches are visible in the topology. 
Only switches that have successfully merged into the same fabric will be 
displayed on the Topology window (Figure 6-17). 

Figure 6-17   Topology window

12.From the Fabric View window, click View Details to view the switch details.
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Zoning configuration
13.From the action menu, select Configure → Zoning (Figure 6-18).

Figure 6-18   Configure window
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14.Define a name for the zone set and select Update (Figure 6-19).

Figure 6-19   Configure → Zoning window
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15.Define a zone name (1). Highlight the desired members (2) and click the right 
arrow button (3) to add the members to the zone and the zone to the zone set 
(see Figure 6-20).

Figure 6-20   Configure → Zoning window
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16.Once you have completed creating the desired zones with their members, 
click Activate to activate your zone set and zones, as shown in Figure 6-21.

Figure 6-21   Configure → Zoning window
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Chapter 7. QLogic SAN configuration

In this chapter, we discuss how to set up and configure the QLogic 4Gb Fibre 
Channel Switch Modules to attach to a SAN storage environment. You will note 
that we have included the configuration of two QLogic external switch modules, 
the QLogic Fibre Channel 5602 and 1404. For more information about each 
switch, please visit the respective Web sites.

7
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7.1  IBM BladeCenter configuration

In this section, we begin with the setup and configuration of our IBM 
BladeCenter. To do so, please visit Chapter 4, “IBM BladeCenter setup and 
configuration” on page 35 and follow the instructions outlined in the chapter. 
Afterwards, return to this section to begin the implementation of your QLogic 
SAN environment. Figure 7-1 shows the SAN topology we used as our lab 
environment. It is assumed that LUN(s) have been created and assigned on the 
storage system prior to this SAN implementation. 

Figure 7-1   IBM BladeCenter utilizing QLogic 4Gb FCSM and QLogic 5602 Fabric attached DSxxxx
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7.2  QLogic Fibre Channel Switch 5602 setup and 
configuration

To begin the setup of our QLogic Fibre Channel Switch 5602, we must install the 
SANsurfer Switch Manager on the server or workstation that will be managing 
the switch. 

In our example, we installed on a workstation. Perform the following steps: 

1. Once SANsurfer is installed, click Start → Programs → 
SANsurfer_Switch_Manager to launch the SANsurfer application.

2. The Initiate Start Dialog dialog box will appear. Click Open Existing Fabric 
and click Proceed to continue (see Figure 7-2).

Figure 7-2   SANsurfer Switch Manager initial option window

Note: There is an embedded GUI in the switch that one can use to manage 
the switch, so you do not have to install the SANsurfer switch manager 
application.
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3. Enter the IP Address for the switch in the IP Address field (Figure 7-3). Enter 
the user name and password and click Add Fabric to continue. 

Figure 7-3   Add a New Fabric window

4. Click OK when the Non secure connection check dialog appears (Figure 7-4). 

Figure 7-4   Non secure connection check window
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Naming the switch and setting the Domain ID
5. From the Topology window in the left pane, click the drop-down tree. Click to 

select your switch (in our example, QL5602-1). Select Switch → Switch 
Properties... (Figure 7-5).

Figure 7-5   SANSurfer Switch Manager- Faceplate window

QL5602-1

Q
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6. From the Switch Properties dialog (Figure 7-6), enter a symbolic name for 
your switch. Enter a Unique Domain ID ranging from 97-127 (1). Click the 
Enable radio button next to Domain ID lock (2). In our example, we selected 
98 for the DID. Click OK to continue. 

Figure 7-6   Switch Properties window

7. Click OK when the Updating Switch Properties dialog box appears.

2
1
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Verify port settings
8. From the SANsurfer Switch Manager Faceplate, select your desired E-Port. 

Next, select Port → Port Properties (Figure 7-7). In our example, we 
designated port 7. 

Figure 7-7   SANsurfer Switch Manager - Faceplate window
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9. From the Port Properties dialog box (Figure 7-8), verify the following settings 
are true:

a. Port State = Online

b. Port Speed = Auto-detect

c. Port Type = G-port

d. I/O Stream Guard = Auto

e. Device Scan = Enable

10.Click OK.

Figure 7-8   Port Properties window
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Configure storage ports
11.On the Faceplate, select the port to which you will connect your storage. 

Select Port → Port Properties (Figure 7-9). In our example, we selected 
port 0. 

Figure 7-9   Port Properties window
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12.Verify the following are true for port 0 (Figure 7-10):

a. Port State = Online

b. Port Speed = Auto-detect

c. Port Type = GL-port

d. I/O Stream Guard = Auto

e. Device Scan = Enable

13.Click OK.

Figure 7-10   Port Properties settings window

14.Connect the storage to the port you configured in step 12.
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15.Verify that a successful login occurs by checking for device registration in the 
nameserver. Observe that the port login indicator in the Faceplate image is 
green. Select the port and in the devices tab verify the PortWWN of the 
device appears (Figure 7-11). 

Figure 7-11   PortWWN window
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16.From the Faceplate, select the Configured Zoneset tab (Figure 7-12). Verify 
there are no zones configured on the switch. If there are zones configured, 
see manufacturer user's guide for instructions on how to remove the zone set 
and zones. 

Figure 7-12   SANsurfer Switch Manager

This switch is now configured to work with other fabrics.
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7.3  QLogic 4Gb FCSM connectivity to 5602 and SAN 
environment

In this section, we discuss the configuration of the QLogic 4Gb Fibre Channel 
Switch Module and establish connectivity to our SAN environment via the QLogic 
5602. Perform the following steps:

1. Launch your switch’s IP address from your browser. Enter the IP Address, 
Login Name, and Password. Click Add Fabric to continue (Figure 7-14 on 
page 182).

Figure 7-13   Add a New Fabric window
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2. From the Topology window in the left pane, click the drop down tree and 
double-click the IP address. Next, select your switch (in our example, 
QL_FCSM4Gb). Select Switch → Switch Properties... (Figure 7-14). 

Figure 7-14   SAN Browser - Faceplate window

3. From the Switch Properties dialog (Figure 7-15 on page 183), enter a 
symbolic name for your switch. The Unique Domain ID ranges from 97-127 
(1). Click the Enable radio button next to Domain ID lock (2). In our example, 
we selected 99 for the DID. Click OK to continue.
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Figure 7-15   Switch Properties window

4. Click OK when the Updating Switch Properties dialog box appears.
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5. From the Faceplate window, select your desired E-Port. Next, select Port → 
Port Properties (Figure 7-16). In our example, we designated port 19.

Figure 7-16   SANBrowser - Faceplate
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6. From the Port Properties dialog box (Figure 7-17), verify the following settings 
are true for port 19:

a. Port State = Online

b. Port Speed = Auto-detect

c. Port Type = G-port

d. I/O Stream Guard = Auto

e. Device Scan = Enable

7. Click OK.

Figure 7-17   Port Properties window
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8. From the Faceplate, select the Configured Zoneset tab (Figure 7-18). Verify 
there are not zones configured on the switch. If there are zones configured, 
see the manufacturer user's guide for instructions on how to remove the zone 
set and zones.

Figure 7-18   SAN Browser - Faceplate window
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Connect FC cable from FCSM to 5602
9. Verify the E-Port (ISL) connection was successful. In the left panel, select the 

IP Address to obtain the Topology view window (Figure 7-19). Verify that both 
switches in the Topology viewing pane are visible. Optionally, you can telnet 
into the switch and type the command show fabric and verify that you can 
see both switches. 

Figure 7-19   SAN Browser Topology window
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Create a zone set and zone
10.From the Faceplate dialog window, select Zoning → Edit Zoning 

(Figure 7-20).

Figure 7-20   SAN Browser - Faceplate window

11.From the Edit Zoning dialog window, select Edit → Create Zone Set 
(Figure 7-21 on page 189).
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Figure 7-21   Edit Zoning - SAN Browser window

12.In the Create a zone set dialog box (Figure 7-22), enter a name in the Zone 
Set Name field and click OK. 

Figure 7-22   Create a zone set window
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13.Highlight the Zone Set you just created. From the Edit Zoning - SAN Browser 
action menu (Figure 7-23), select Edit → Create a Zone. 

Figure 7-23   Edit Zoning - SAN Browser window

14.In the Create a zone dialog box (Figure 7-24), enter a name in the Zone 
Name field and click OK. In our example, we typed BCS_4100.

Figure 7-24   Create a zone window
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15.In the Edit Zoning - SAN Browser window (Figure 7-25), highlight the zone 
you created. Select the members you want to be included in the zone. You 
may use the Control key to select more than one member. Select Edit → 
Add Members. 

Figure 7-25   Edit Zoning - SAN Browser window

16.To create more zones, repeat steps 10 on page 188 through 12 on page 189.
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17.Once your zones have been created (Figure 7-26), click Apply to save your 
configuration.

Figure 7-26   Edit Zoning - SAN Browser window

18.From the Save Zoning and Error Check dialog box (Figure 7-27 on page 193), 
select Perform Error Check. 
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Figure 7-27   Save Zoning & Error Check window

19.Once the Error Check is complete and no errors appeared (Figure 7-28), click 
Save Zoning. 

Figure 7-28   Save Zoning & Error Check window

20.Select Yes to activate your zone set(s) (Figure 7-29) once the save is 
complete. You should select No if you are not prepared to activate the zone 
set. 

Figure 7-29   Zone set activation window
 Chapter 7. QLogic SAN configuration 193



21.Select the zone set you want activated and click OK. In our example, we 
selected IBM ITSO (Figure 7-30).

Figure 7-30   Select Zone set to be activated window

22.Click the Close button to complete the saving and activation of your zone 
(see Figure 7-31).

Figure 7-31   Save Zoning & Error Check window

23.Click the Close button to exit the Edit Zoning dialog window (Figure 7-32 on 
page 195).
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Figure 7-32   Edit Zoning - SAN Browser window

Perform a SAN check (referenced in the Switch Interoperability Guide v6.0 and 
located at the following Web site: http://qlogic.com/interopguide/info.asp).

Note: The Successful Integration Checklist in the Switch Interoperability 
Guide v6.0 is located on page 44. 
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7.4  IBM System Storage SAN10Q (QLogic SB1404) 
setup/configuration

To begin the setup of our IBM System Storage SAN10Q (SB1404), we must 
install the SANsurfer Switch Manager on the server or workstation that will be 
managing the switch. In our example, we installed on a workstation. 

Perform the following steps to configure the QLogic 1404: 

1. Once SANsurfer is installed, select Start → Programs → 
SANsurfer_Switch_Manager to launch the SANsurfer application.

2. The Initiate Start Dialog dialog box will appear. Click Open Existing Fabric 
and click Proceed to continue (see Figure 7-33).

Figure 7-33   SANsurfer Switch Manager initial option window

3. Enter the IP Address for the switch in the IP Address field (Figure 7-34 on 
page 197). Enter the user name and password and click Add Fabric to 
continue. 

Note: The 1404 is only allowed one ISL from the switch; however, the switch 
you connect to can be connected to many other switches. Thus, you can be in 
a larger than two switch fabric. 

At this stage, we have assumed that you have all the upgrade licenses 
installed on the 1404.
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Figure 7-34   Add a New Fabric window

4. Click OK when the Non secure connection check dialog appears. 

Figure 7-35   Non secure connection check window
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Naming the switch and setting the Domain ID
5. From the Topology window in the left pane, click the drop down tree. Click to 

select your switch. Select Switch → Switch Properties... (Figure 7-36).

Figure 7-36   SANsurfer Switch Manager - Faceplate window

6. From the Switch Properties dialog (Figure 7-37 on page 199), enter a 
symbolic name for your switch (for example, QL_1400). Enter a Unique 
Domain ID ranging from 97-127 (1). Click the Enable radio button next to 
Domain ID lock (2). In our example, we selected 102 for the DID. Click OK to 
continue. 
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Figure 7-37   Switch Properties window

7. Click OK when the Updating Switch Properties dialog box appears.
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Verify port settings
8. From the SANsurfer Switch Manager Faceplate, select your desired E-Port. 

Next, select Port → Port Properties (Figure 7-38). In our example, we 
designated port 0.

Figure 7-38   Port Properties window
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9. From the Port Properties dialog box (Figure 7-39), verify the following settings 
are true:

a. Port State = Online

b. Port Speed = Auto-detect

c. Port Type = G-port

d. I/O Stream Guard = Auto

e. Device Scan = Enable

10.Click OK.

Figure 7-39   Port Properties window
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Configure storage ports
11.On the Faceplate, select the port you will connect your storage. Select Port 

→ Port Properties (Figure 7-40). In our example, we selected port 5. 

Figure 7-40   Port Properties window

12.Verify the following are true for port 5 (Figure 7-41 on page 203):

a. Port State = Online

b. Port Speed = Auto-detect

c. Port Type = GL-port

d. I/O Stream Guard = Auto

e. Device Scan = Enable

13.Click OK.
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Figure 7-41   Port Properties settings window

14.Connect the storage to the port you configured in step 12 on page 202.
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15.Verify that a successful login occurs by checking for device registration in the 
nameserver. See if the port login indicator in the Faceplate image is green. 
Select the port and, in the Devices tab, verify the PortWWN of the device 
appears. (Figure 7-42).

Figure 7-42   PortWNN window

16.From the Faceplate, select the Configured Zoneset tab. Verify there are no 
zones configured on the switch. If there are zones configured, see 
manufacturer user's guide for instructions on how to remove a zone set and 
zones.
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Figure 7-43   SANsurfer Switch Manager window

This switch is now configured to work with other fabrics.
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7.5  QLogic 4Gb FCSM connectivity to 1404 and SAN 
environment

In this section, we discuss the configuration of the QLogic 4Gb Fibre Channel 
Switch Module and establish connectivity to our SAN environment via the QLogic 
1404. Perform the following instructions:

1. Launch your switch’s IP address from your browser. Enter the IP Address, 
Login Name, and Password. Click Add Fabric to continue (Figure 7-44). 

Figure 7-44   Add a New Fabric window

1. From the Topology window in the left pane, click the drop-down tree and 
double-click the IP address. Next, select your switch (in our example, the 
default is FCSM4Gb). Select Switch → Switch Properties... (Figure 7-45 on 
page 207).
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Figure 7-45   SAN Browser - Faceplate window

2. From the Switch Properties dialog (Figure 7-46), enter a symbolic name for 
your switch. Click the Enable radio button next to Domain ID lock (1). Enter a 
Unique Domain ID ranging from 97-127 (2). In our example, we selected 99 
for the DID. Click OK to continue. 

Figure 7-46   Switch Properties window
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3. Click OK when the Updating Switch Properties dialog box appears.

4. From the Faceplate window, select your desired E-Port. Next, select Port → 
Port Properties (Figure 7-47). In our example, we designated port 19.

Figure 7-47   SAN Browser - Faceplate window

5. From the Port Properties dialog box (Figure 7-48 on page 209), verify the 
following settings are true for port 19:

a. Port State = online

b. Port Speed = auto-detect

c. Port Type = G-port

d. I/O Stream Guard = Auto

e. Device Scan = Enable

6. Click OK.
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7. When the Updating Port Properties - SAN Browser dialog box appears, click 
OK (see Figure 7-48).

Figure 7-48   Port Properties window
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8. From the Faceplate, select the Configured Zoneset tab (Figure 7-49). Verify 
there are no zones configured on the switch. If there are zones configured, 
see manufacturer user's guide for instructions on how to remove the zone set 
and zones. 

Figure 7-49   SAN Browser - Faceplate window
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Connect FC cable from FCSM to 1404
9. Verify the E-Port (ISL) connection was successful. In the left panel, select the 

IP address to obtain the Topology view window (Figure 7-50). Verify both 
switches in the Topology viewing pane are visible. Optionally, you can telnet 
into the switch and type the command show fabric and verify that you see 
both switches.

Figure 7-50   SAN Browser Topology window
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Create a zone set and zone
10.In the left panel, highlight QL_FCSM4Gb. From the Faceplate dialog window, 

select Zoning → Edit Zoning (Figure 7-51). 

Figure 7-51   SAN Browser - Faceplate window

11.From the Edit Zoning dialog window, select Edit → Create Zone Set 
(Figure 7-52 on page 213).
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Figure 7-52   Edit Zoning- SAN Browser window

12.In the Create a zone set dialog box (Figure 7-53), enter a name for the Zone 
Set Name field and click OK. In our example, we typed IBM_ITSO.

Figure 7-53   Create a zone set window
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13.Highlight the Zone Set you just created. From the Edit Zoning - SAN Browser 
action menu (Figure 7-54), select Edit → Edit Menu. 

Figure 7-54   Edit Zoning - SAN Browser window

14.In the Create a zone dialog box (Figure 7-55), enter a name in the Zone 
Name field and click OK. In our example, we typed BCS_4100.

Figure 7-55   Create a zone window
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15.In the Edit Zoning - SAN Browser window (Figure 7-56), highlight the zone 
you created. Select the members you want to be included in the zone. You 
may use the Control key to select more than one member. Select Edit → 
Add Members. 

Figure 7-56   Edit Zoning - SAN Browser window

16.To create more zones, repeat steps 11 on page 212 through 13 on page 214. 
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17.Once your zones have been created (Figure 7-57), click Apply to save your 
configuration.

Figure 7-57   Edit Zoning - SAN Browser window

18.From the Save Zoning and Error Check dialog box (Figure 7-58 on page 217), 
select Perform Error Check. 
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Figure 7-58   Save Zoning & Error Check window

19.Once the Error Check is complete and no errors appeared (Figure 7-59), 
select Save Zoning. 

Figure 7-59   Save Zoning & Error Check window

20.Select Yes to activate your zone set(s) (Figure 7-60) once the save is 
complete. You should select No if you are not prepared to activate the zone 
set. 

Figure 7-60   Zone set activation window
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21.Select the zone set you want activated and click OK (Figure 7-61). 

Figure 7-61   Select Zone set to be activated window

22.Click the Close button to complete your Zoning save (Figure 7-62).

Figure 7-62   Save Zoning & Error Check window

23.Click the Close button to exit the Edit Zoning dialog window (Figure 7-63 on 
page 219).
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Figure 7-63   Edit Zoning - SAN Browser window

Perform a SAN check (referenced in the Switch Interoperability Guide v6.0, 
located at the following Web site: http://qlogic.com/interopguide/info.asp).

7.6  QLogic licenses
The following is the specific part numbers you should reference during purchase:

� QLogic 20-port 4Gb FC Switch Module (PN 26R0881)

� QLogic 10-port 4Gb FC Switch Module (PN 32R1904)

� QLogic/McDATA 10-port Upgrade (PN 32R1912)

� McDATA Mode Firmware Key Upgrade (PN 32R1795)

QL_1400
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Chapter 8. EMC Boot from SAN

This chapter illustrates the detailed configuration procedure necessary to 
implement the Boot from SAN (storage area network) solution using the IBM 
BladeCenter blade servers with Linux and Windows 2000/2003 operating 
systems, QLogic 4Gb FC HBAs, McDATA 4Gb Fibre Channel Switch Modules, 
ISL through McDATA 4700 and Intrepid, and the EMC CLARiiON CX700 storage 
subsystem. The Boot from SAN configuration procedure is similar for the HS20, 
LS20, and HS40 blade servers. The only exception is for the HS40 blade that 
requires the boot device to be selected under the startup sequence options in the 
setup menu (accessed by breaking the boot sequence using the F1 key). Thus, 
the procedure explained in this chapter can be applied to the HS20, LS20, and 
HS40 blade servers. 

8
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8.1  Boot from SAN overview

Boot from SAN allows for the deployment of diskless servers in an environment 
where the boot disk is located on the RAID (redundant array of independent 
disks) capable storage server connected to the SAN. The server (Initiator) 
communicates with the storage device (target) through the SAN using the Fibre 
Channel host bus adapter (HBA). The software configuration parameters in FC 
BIOS of the HBA allow the server to identify and map the boot disk on the SAN. 
The Boot from SAN function allows for consolidation of the server and storage 
hardware and facilitates a central point of management. 

The system downtime is greatly minimized in case a critical component such as a 
processor or host bus adapter fails and needs to be replaced. The system 
administrator only needs to swap the hardware and reconfigure the FC HBA 
BIOS, fabric zoning, plus change the host port definitions on the storage 
subsystem. The system image still exists on the logical drive and the server is 
operational once the hardware swap and configuration change is completed. 

Because the EMC CLARiiON storage subsystem is configured with dual 
redundant Service Processors for fault tolerance, high availability, and load 
balancing, it is critical for the initial install of the operating system that only a 
single and unique path from the blade to the logical drive (boot LUN) on the 
storage subsystem is configured. As such, the secondary path via the second 
Service Processor must be disconnected or isolated by excluding the second 
port on the HS20 FC HBA card and the EMC CLARiiON Service Processor B in 
the initial zone configuration. The second path is included in the active zone 
configuration after the operating system is successfully installed and it has been 
verified that the HS20/HS40 blade successfully boots from the logical drive on 
the SAN.

Table 8-1 lists the hardware and software components used in implementing the 
lab setup to test Boot from SAN for Linux and Windows 2000/2003 operating 
systems.

Table 8-1   Hardware and software for SAN solution

Hardware configuration Quantity Software configuration

HS20 Blade (8832) 1 BIOS 1.10, FC BIOS 1.04.

HS40 Blade (8839) 1 BIOS 1.62, FC BIOS 1.04.

HS20 Blade (8843) 2 BIOS 1.08, FC BIOS 1.04.

LS20 Blade (8850) 1 BIOS 1.08, FC BIOS 1.04.
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8.2  Pre-configuration checklist
Before proceeding to implement the Boot from SAN environment, ensure that the 
following tasks are completed:

1. Fibre Channel Switch Fabric

– Refer to the Switch User Guide for configuration details.

– Ensure that the unique Domain ID and IP address are configured on all 
the switches.

– Verify the switch external port settings are enabled from the BladeCenter 
Management Module Advance setup menu. See “Setting the switch 
module IP Address and enabling external ports” on page 44.

– Back up the switch fabric configuration.

– Configure fabric Zoning using the McDATA SANbrowser.

2. CX700 Storage

– Refer to the latest EMC CLARiiON Release Notes and Installation and 
User Guide for configuration details.

– Obtain the IP addresses of the EMC CLARiiON storage subsystem.

– Ensure that the EMC CLARiiON storage service processors and drives 
are cabled correctly.

– Verify and create the new logical drive, if needed.

3. Remote Management Setup via TCP/IP

– Verify and install the necessary Java plug-in 1.4.2_03 or above to access 
the McDATA Web Interface on the Remote Management workstation. 

– Install the Navisphere Management Agent and CLI application required to 
access the EMC CLARiiON storage server. Install it after the HBA has 
completed registration. 

McDATA Fibre Channel Switch 
Module

2 Firmware 5.5.0.22

EMC CLARiiON 700 Storage 
Server

1 Note: The EMC support matrix the 
HBA BIOS levels should be "1.13".

Hardware configuration Quantity Software configuration
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8.3  Configuring Boot from SAN

In this section, we begin discussing the specific activities necessary to implement 
a Boot from SAN using EMC technology.

8.3.1  Configure the Primary Boot Path from the HS20 blade BIOS 
The following steps illustrate the procedure for booting an IBM BladeCenter 
blade server from an EMC CLARiiON storage device. Either Linux or the 
Windows 2000 and Windows 2003 Advance Server or Server Edition can be 
loaded once the environment is configured. 

1. Perform the physical connectivity for the EMC CLARiiON storage subsystem 
and the switch fabric, as shown in the EMC CLARiiON CX700 and Fibre 
Channel Switch Installation and User Guides. 

2. Perform the blade BIOS configuration, as shown in “Blade server F1 setup” on 
page 36.

3. Perform the Fibre Channel HBA configuration, as shown in “QLogic Fast!Util 
setup” on page 38.

8.3.2  Fabric Zoning configuration
The Fabric Zone configuration consists of the following tasks:

� Access the switch management interface and log in with Administrator 
privileges.

� Select the Zoning menu.

� Create a zone.

� Add member(s) to a zone.

� Create a new zone set if there no active zone set.

� Add zone(s) to a zone set

� Activate the zone set

� Verify the active zone set

Note: Notice in Figure 8-1 that there is only one path from the blade server to 
the EMC CLARiiON Service Processor A. This is essential to successfully 
installing the OS on the boot disk mounted on the EMC CLARiiON CX700. 
The second path to the Service Processor B is purposely excluded for OS 
installation through the single path.
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Figure 8-1   Blade server boot from CX700 primary path 

The following steps illustrate the zone configuration for the primary path from the 
EMC CLARiiON Service Processor A and the first port on the HS20 blade host 
bus adapter, which corresponds to the IRQ address 2400. 

1. Identify and record the WWNs of the EMC CLARiiON Service Processor A 
port 1 and the first FC port on the host to be used in the new active zone set. 
Verify the nameserver table for the hosts and storage ports login status.

2. Zoning.

Note: For a detailed procedure to configure zoning, refer to the 
corresponding switches’ (Brocade, Cisco, McDATA, or QLogic) User Guide.

In an interoperable fabric, we highly recommend not using multiple Zone 
management interfaces. For example, in a intermix fabric with QLogic and 
McDATA; zone management can be done exclusively from McDATA tools, 
such as EFCM, QLogic SANpilot interface, or from the CLI.
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Zoning configuration steps:

a. Create a Zone: I82bi46_qla1_CX3_4D_3_SPA0.

b. Add the WWNs of the HBA 0 and the CX700 SP-A port1.

c. Add the Zone: I82bi46_qla1_CX3_4D_3_SPA0 as a member of the active 
zone set or create a new zone set and insert the zone into the new zone 
set.

d. Activate the zone set.

8.4  Blade server F1 setup 
This step should be performed when you are prepared to configure a Boot from 
SAN environment. Perform the instructions in 4.2, “Blade server F1 setup” on 
page 36 to disable the use of the IDE or SCSI drives that may be installed in the 
HS20, HS40, or LS20.

8.5  Configure a startup device for an HS40 blade only
Following the reboot initiated in the preceding step, you should carefully watch 
the boot sequence for the Setup menu, 

a. Press the F1 key to enter the setup menu.

b. Select Startup options.

c. Select Startup sequence options.

d. Select Second Startup Device and press Enter to list all the startup 
devices, as shown in Figure 8-2 on page 227.

e. The Fibre device will be listed as one of the startup device, assuming the 
FC BIOS is enabled and the boot device is mapped correctly from 
Fast!UTIL menu.

f. Select the fibre device and press Enter. You will see a window similar to 
Figure 8-3 on page 227.

g. Save and exit.
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Figure 8-2   Startup Sequence options window

Figure 8-3   Startup Sequence options window
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8.6  Blade server - QLogic HBA setup
This section discusses our setup of the QLogic Fibre Channel HBA establishing 
a connection with the EMC CLARiiON CX700 WWN (world wide name).

1. Start the BladeCenter HS20 to configure the QLogic HBA. When you reach 
the Ctrl-Q application (Example 8-1), type Ctrl-Q and press Enter to access 
the QLogic Fast!UTIL.

Example 8-1   Ctrl-Q execute window

Broadcom NetXtreme Ethernet Boot Agent v3.1.15
Copyright (C) 2000-2002 Broadcom Corporation
All rights reserved.

Broadcom NetXtreme Ethernet Boot Agent v3.1.15
Copyright (C) 2000-2002 Broadcom Corporation
All rights reserved.

QLogic Corporation
QMC2462 PCI Fibre Channel ROM BIOS Version 1.04
Copyright (C) QLogic Corporation 1993-2005. All rights reserved.
www.qlogic.com

Press <CTRL-Q> for Fast!UTIL

BIOS for Adapter 0 is disabled
BIOS for Adapter 1 is disabled
ROM BIOS NOT INSTALLED

<CTRL-Q> Detected, Initialization in progress, Please wait...
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The window shown in Figure 8-4 should then appear.

Figure 8-4   Select I/O Address window
 Chapter 8. EMC Boot from SAN 229



2. Select the 0 ID and press Enter. You will see a window similar to Figure 8-5.

Figure 8-5   Fast!UTIL Options window
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3. Select Configuration Settings. You will see a window similar to Figure 8-6.

Figure 8-6   Configuration Settings window
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4. Under Configuration Settings, click Adapter Settings. You will see a window 
similar to Figure 8-7.

Figure 8-7   Adapter Settings WWN info and enable BIOS window
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5. Ensure that the Host Adapter BIOS is Enabled, the Hard Loop ID is set to 
125, and the Data Rate is set to 2 (auto detect). Press Enter to change 
settings and Esc to exit. Next, you will see a window similar to Figure 8-8.

Figure 8-8   Configuration Settings window
 Chapter 8. EMC Boot from SAN 233



6. Select Selectable Boot Settings and press Enter. You will see a window 
similar to Figure 8-9.

Figure 8-9   Selectable Boot Settings window

7. In the Selectable Boot Settings window, ensure Selectable Boot is set to 
Enabled (Do not press Enter). Stop at this point. Go to Configure McDATA 
Fibre Channel Switch Module. You will resume this step in “Blade server - 
QLogic HBA setup continuation” on page 262.

8.7  Configure McDATA Fibre Channel Switch Module
In this section, we will access the McDATA SANbrowser to begin the configuring 
of zones for accessing storage LUNs on the EMC CLARiiON CX700.

1. To begin, enter the IP address of the McDATA Fibre Channel Switch Module 
for the IBM eServer BladeCenter into your favorite Web browser. You will see 
the Java Plug-in Version Check and after several seconds a window similar to 
Figure 8-10 on page 235.
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Figure 8-10   Add a New Fabric window

2. Enter a Fabric Name, then proceed with typing in the login name and 
password and click Add Fabric. You will see a window similar to Figure 8-11.

Figure 8-11   Non-secure connection verification window
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3. Select Yes to establish a non-secure connection. You will see a window 
similar to Figure 8-12.

Figure 8-12   Topology window - Linux environment

In this topology, a large Fibre Channel SAN environment is displayed. The 
McDATA Fibre Channel Switch Module for IBM BladeCenter is circled. This is the 
switch module we utilize to create our zone sets. In the left panel, double-click 
Linux_environment to see the IBM_McDATA4Gb_Top settings. 

Note: Depending on your fabric environment, there are other products you 
can use to configure your zones, for example, Connectrix Management.
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The window shown in Figure 8-13 should appear.

Figure 8-13   Switch faceplate window
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4. Highlight IBM_McDATA4Gb_Top. You will see a window similar to 
Figure 8-14.

Figure 8-14   McDATA SAN Browser - Faceplate window

5. Select Switch → Advanced Switch Properties. You will see a window 
similar to Figure 8-15 on page 239.
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Figure 8-15   Advanced Switch Properties window

The McData Switch Module defaults to the McDATA Fabric Mode when originally 
configured. For our environment, we must be in Standard mode. 

Note: Default mode: Select this mode if the fabric contains only McData 
switches and directors operating in McData Fabric 1.0 mode.

If the switch is in McDATA Fabric Mode and you change the Default Zone 
setting, the new setting is propagated to all switches in the fabric. If the switch 
is in Standard mode and you change the Default Zone setting, the new setting 
is not propagated to any other switches in the fabric.
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In our example, we have different types of switches in our fabric. Ensure 
Standard mode has been selected and click OK. Next, select Switch → Switch 
Properties. You will see a window similar to Figure 8-16.

Figure 8-16   Switch Properties window

6. From the Switch Properties dialog (Figure 8-16), enter a symbolic name for 
your switch. For our example, the name is IBM_McDATA4Gb_Top. Click 
Enable for the Domain ID lock radio button to ensure that the switch always 
has that Domain ID. In the Domain ID box, type a unique Domain ID in the 
97-127 range for the switch (2). In our example, we selected 109 for the DID. 
Click OK to continue. 

1
2
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The window shown Figure 8-17 in should appear.

Figure 8-17   McDATA SANbrowser Faceplate window
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7. At this stage, we need to configure our ports. Select Port → Port Properties. 
You will see a window similar to Figure 8-18.

Figure 8-18   Port Properties window

8. From the Port Properties dialog box, verify the following settings are true for 
port 2:15:

a. Port States = online

b. Port Speed = auto-detect

c. Port type = G - port

d. Device Scan = Enable

9. Click OK. 

10.From the McDATA SANbrowser Faceplate window, select Zoning → Edit 
Zoning. You will see a window similar to Figure 8-19 on page 243.

Note: G-Ports (General ports): Automatically configured to E or F ports to 
support switches or fabric devices. All switch ports should be set to G-port, 
except for tape libraries that do not support F-port; see GL ports below. 
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Figure 8-19   Edit Zoning - McDATA SANbrowser window

11.Click the Zone Set icon to create a zone set. You will see a window similar to 
Figure 8-21 on page 244. 

Figure 8-20   Create a zone set window
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12.Type in a zone set name. For our example, we typed Linux_text. Click OK. 
The window shown in Figure 8-21 should appear.

Figure 8-21   Zoning switches listed window

13.In the left panel, right-click ZoneSet: Linux_text and select Create a Zone.... 
You will then see a window similar to Figure 8-22.

Figure 8-22   Create a zone window

I82bi46_qla1_CX3_4D_3_SPA0
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14.in the Create a zone dialog box, enter a name in the Zone Name field. In our 
example, we typed I82bi46_qla1_CX3_4D_3_SPA0. Click OK. You will then 
see a window similar to Figure 8-23.

Figure 8-23   Creating I82bi46_qla1_CX3_4D_3_SPA0 zone window
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15.In the right panel, add the QLogic HBA to Zone: 
I82bi46_qla1_CX3_4D_3_SPA0. Hold down mouse button and drag the 
member to the zone. In our example, this is WWN: 
21:00:00:09:6b:36:e1:b2(IBM Corporation).You will see a window similar to 
Figure 8-24.

Figure 8-24   I82bi46_qla1_CX3_4D_3_SPA0 zone window
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16.In the right panel, locate the Storage WWN that will be utilized for the Boot 
from SAN configuration (see Figure 8-26 on page 248).

Figure 8-25   I82bi46_qla1_CX3_4D_3_SPA0 zone window
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17.From the right panel, add the Storage WWN to the 
I82bi46_qla1_CX3_4D_3_SPA0 zone. Hold down the mouse button and drag 
the member to the zone. In our example, this is WWN: 
50:06:01:60:41:e0:04:76 (CLARIION). You will see a window similar to 
Figure 8-26.

Figure 8-26   I82bi46_qla1_CX3_4D_3_SPA0 zone window

18.Both HBA and Storage WWN are within the I82bi46_qla1_CX3_4D_3_SPA0 
zone. Click Apply.
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Figure 8-27   Perform error check and save zoning

19.Click Save Zoning. You will see a window similar to Figure 8-28.

Figure 8-28   Zone set activation window
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20.Click Yes to activate the zone set. You will see a window similar to 
Figure 8-29.

Figure 8-29   Select Zone set to be activated window

21.Select the zone set. In our example, we select Linux_test. Click OK. Click 
Save Zoning and then Close.

8.8  EMC CLARiiON storage configuration
In this section, we discuss the configuration of our storage device and making 
LUNs available for our boot system. In this example, we used the CLARiiON 
CX700 (the top-of-the-line CX series model). The CX700 scales up to 117 TB. 
For more information regarding the CLARiiON products, visit 
http://www.emc.com/CX3. 

Configure storage group
The EMC CLARiiON storage configuration should be performed from the 
Remote Management workstation using the EMC CLARiiON Storage Manager 
Client utility. The EMC CLARiiON Storage server is accessed from the 
Out-of-Band Ethernet over TCP/IP connection.

1. Launch the Web browser (Internet Explorer 6.0 or higher) and point to the IP 
address of the EMC CLARiiON CX700 Storage device. The menu in 
Figure 8-30 on page 251 is displayed.

Linux_test
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Figure 8-30   Enterprise Storage 1 window

2. From the Enterprise Storage menu, right-click the CX3-40-3[04:76][CX700] 
device. Next, click Create Storage Group. You will see a window similar to 
Figure 8-31.

Figure 8-31   Create Storage Group window
 Chapter 8. EMC Boot from SAN 251



3. From the Create Storage Group menu, define the name of the group and click 
Apply and OK. In our example, we typed I82bi46. You will see a window 
similar to Figure 8-32.

Figure 8-32   Create Storage Group window

4. Click Yes to create the storage group. 

Figure 8-33   Create Storage Group window
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5. Click OK. You will see a window similar to Figure 8-34.

Figure 8-34   Enterprise Storage 1 window

CX700 
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6. Define the devices for the first Fibre Channel port on the blade server by 
selecting the Storage Group created. Right-click the group (I82bi46) and click 
Select LUNs. You will see a window similar to Figure 8-35.

Figure 8-35   I82bi46: Storage Group Properties window

7. Search and select the LUN to be mapped to the host and press the right 
arrow key to move it under Selected LUNs. 

Figure 8-36   Selected LUNs window

8. Under Selected LUNs, scroll to the right of the Capacity column until you see 
the Host column. Assign the Offset value of zero (0) to the boot LUN 
(Figure 8-36). It is required that the boot LUN gets the lowest LUN ID value 
and additional LUNs can have values higher than the boot LUN. Click Apply 
and OK. You will see a window similar to Figure 8-37 on page 255.
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Figure 8-37   I82bi46:Storage Group Properties window

9. Click Yes to continue. 

10.Once the LUNs has been successfully added to storage group, click OK. You 
will see a window similar to Figure 8-38.

Figure 8-38   I82bi46: LUN Properties window
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11.Right-click LUN 896[896, RAID 5,FC] and select Properties. Ensure the LUN 
Name is correct and that you are set on the correct SP. In our example, we 
use SP A. Click OK. The window shown in Figure 8-39 should appear.

Figure 8-39   Connectivity Status window
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12.From the Enterprise Storage 1 window, right-click CX3-40-3[04:76][CX700] 
and click Connectivity Status. You will see a window similar to Figure 8-40.

Figure 8-40   Connectivity Status window
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13.From the Connectivity Status window, click Register to register your initiator 
record. You will see a window similar to Figure 8-41. In our example, 
20:00:00:09:6B:36:E1:B2:21:00:00:09:6B:36:E1:B2. 

Notice in the Registered column the initiator record displays No and the 
hexadecimal Server Name.

Figure 8-41   Register Initiator Record window

14.Ensure the Initiator Type, CLARiiON Open, is displayed. In the new Host 
Name field, type in the fully-qualified domain name and IP Address; in our 
example, they are I82bi46.lss.emc.com and 172.23.189.46. Click OK. You will 
see a window similar to Figure 8-42 on page 259.

QLogic QMC2462S
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Figure 8-42   Register Initiator Record window

15.Click Yes to continue with registration. You will see a window similar to 
Figure 8-43.

Figure 8-43   Connectivity Status window
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16.Notice the change in the Registered and Server Name columns once the 
record has been registered. Click OK and return to Enterprise Storage 1 
window (Figure 8-44).

Figure 8-44   Enterprise Storage 1 window

17.Right-click the I82bi46 group and select Connect Hosts. You will see a 
window similar to Figure 8-45 on page 261.
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Figure 8-45   I82bi46: Storage Group Properties window

18.Under the Host tab, select the available hosts you created and move it to the 
Host to be Connected window. You will see a window similar to Figure 8-45.

Figure 8-46   I82bi46: Storage Group Properties window
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19.Click Apply and then click Yes. You will see a window similar to Figure 8-47.

Figure 8-47   I82bi46: Storage Group Properties window

20.Once the operation is successful, click OK. At this time, refer to 8.9, “Blade 
server - QLogic HBA setup continuation” on page 262 and resume the setup 
of the QLogic HBA.

8.9  Blade server - QLogic HBA setup continuation
This section resumes the steps you begin in 8.6, “Blade server - QLogic HBA 
setup” on page 228. Complete the following instructions:

1. In Figure 8-48 on page 263, cursor down to (Primary) Boot Port Name, LUN: 
and press Enter. You will see a window similar to Figure 8-49 on page 263.
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Figure 8-48   Selectable Boot Settings window

Figure 8-49   Select Fibre Channel Device windows
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2. The CLARiiON Storage WWN is identified under Port Name. Highlight it and 
press Enter. You will see a window similar to Figure 8-50.

Figure 8-50   Selectable Boot Settings window

3. Highlight (Primary) Boot Port Name, Lun to ensure the CLARiiON Storage 
WWN bootable device appears. Press Esc twice to exit. Click Save changes.

8.10  Linux operating system install
There are no special instructions for the Linux operating system installation. 
Therefore, you may commence with installing the operating system at this time.

8.11  Windows 2000/2003 operating system install

In this section, we discuss the special instructions you will need to perform when 
loading the Windows 2000/2003 operating system. Complete the following steps:

1. Boot the blade server using the Windows 2000 or Windows 2003 installation 
CD and get ready to Press F6 immediately, as shown in Example 8-2.

Example 8-2   Windows Setup window

Press F6 if you need to install a third party SCSI or RAID driver.
264 IBM BladeCenter 4Gb SAN Solution



2. Install the FC HBA device driver using the diskette. The EMC compatible FC 
device driver is available at the following URL: 

http://support.qlogic.com/support/oem_product_list.asp?oemid=65

Figure 8-51 shows that the FC HBA device driver was correctly recognized for 
the HS20.

Figure 8-51   QLogic Fibre Channel Adapter window

Once the FC device driver and the operating system installation process 
completes, perform the following tasks:

1. Install the recommended service packs and reboot.

2. Install the EMC PowerPath driver, host agent, and other utilities. Refer to the 
EMC CLARiiON Installation and Setup documentation for more information.

3. Power down the HS20 blade server.

8.12  Failover and multipath configuration 
In this section, we discuss the failover and multipath configuration from the blade 
server to the EMC CLARiiON CX700 Storage Subsystem.

Figure 8-52 on page 266 illustrates the logical topology depicting the secondary 
path as well as additional paths from the host to the storage in order to achieve 
failover and multipathing.
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Figure 8-52   Blade server boot from CX700 primary-multi path

Notice that in Figure 8-52, the second link from EMC CLARiiON Service 
Processor B is connected to the fabric. In order to achieve load balancing from 
the host to the storage, one additional path is added from service processors A 
and B.

8.13  Configuration steps to enable additional paths 
Here are the configuration steps to enable additional paths from the Blade Server 
to the EMC CX700 Storage:

1. Verify, from the switch, that the second port on the Blade Server and the ports 
to be used on CX700 are logged into the fabric.

2. Create a zone for the secondary path:

a. WWN of the second HBA port on the blade server 

b. WWNs of one or more ports from the CX700 Service Processor B

3. Add one or more ports from the CX700 Service Processor A to the zone 
created initially for the primary path to install the operating system.
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4. Add the zone(s) to the corresponding zone set.

5. Activate the zone set.

8.14  Re-register of the Storage Group on CX700

The de-registration of the Storage Group requires the host to be shut down. The 
following section illustrates the steps to de-register the host and automatically 
register the two host HBA FC ports by installing the agent software:

1. Install the agent software. 

2. From the CX700 Enterprise Storage menu, select Storage Group and 
de-register the host.

3. Reboot the blade server.

4. Verify the login and registration status of the blade server FC ports by 
selecting the CX700 Enterprise Storage → Connectivity Status menu.

8.15  QLogic Fibre Channel HBA BIOS configuration
This section references those steps you need to perform your setup on the 
second FC HBA port. Complete the following:

1. Reboot the host to interrupt the boot sequence and enter the Fibre Channel 
BIOS by pressing the Ctrl-Q keys.

2. Enable the BIOS setting for the second port on the HBA to be zoned with the 
EMC CLARiiON Service Processor B.

3. Add the additional paths under the Selectable Boot Settings menu for both 
Fibre Channel ports

4. Save and exit.

Note: In this section, the host (the WWN of the first HBA port) registered 
initially on CX700 with the WWN of the storage group device will be 
unregistered temporarily. The new host registration process requires both 
ports from the Blade Server to be registered simultaneously and can be done 
automatically, provided the EMC's Navisphere agent is installed on the blade 
server.
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8.16  Failover test with EMC CX700 Storage
In this section, we discuss the failover of our multipath EMC CX700 environment.

1. Launch the PowerPath Administrator. Select Start → Programs → EMC → 
PowerPath → PowerPath Administrator.

Figure 8-53 displays the single active path topology from the blade server to 
the CX700 Service Processor A.

Figure 8-53   EMC PowerPathW2K3-32-bit window

2. In Figure 8-54 on page 269, the second path is added with active status from 
the Blade Server to the CX700 Storage. At this point, both paths are active 
and in optimal state, as shown in Figure 8-54 on page 269:

Note: It is assumed that the PowerPath software is already installed on the 
host and the following steps illustrate the host availability by disconnecting the 
primary path. The Load Balancing over multiple paths on the same Service 
Processor is also demonstrated.
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Figure 8-54   EMC PowerPath Management window

3. Figure 8-55 illustrates the primary path down due to the link failure injected by 
disabling the first HBA port on the blade server at the switch. The IO is 
rerouted via the alternate path (second HBA port on the blade server) with 
minimum delay, so high availability is achieved.

Figure 8-55   EMC PowerPath Management window

8.16.1  EMC PowerPath Path Management via Linux
In the section above, you see an example of how EMC PowerPath Path 
Management is performed via a Windows interface. The following images 
provide a similar view of how path management is performed via Linux.
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Figure 8-56 displays the paths and activity of blade server HBAs to Symmetrix 
and CLARiiON Storage Systems. In Figure 8-57, this is an example of a failure 
occurring (under the Summary column) with an HBA path connected to the 
CLARiiON subsystem. After resolving the error, the path is returned to an optimal 
status.

Figure 8-56   EMC PowerPath Management window

Figure 8-57   EMC PowerPath Management window

8.17  Conclusion
This concludes the step by step procedure for blade server Boot from SAN 
attached EMC CLARiiON CX700 Storage.
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Chapter 9. TotalStorage DS4100, 
DS4700, and DS4800 Boot 
from SAN

In this chapter, we discuss the benefits of a TotalStorage Boot from SAN solution 
and how to properly implement this environment. The steps to implement the 
TotalStorage Boot from SAN solution can be used to configure the DS4100, 
DS4700 and DS4800.

9
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9.1  Overview of IBM BladeCenter Boot from SAN

The following sections discuss the benefits and best practices procedures for the 
Boot from SAN technology on the IBM BladeCenter blade servers connected to 
any IBM or OEM storage subsystems.

The Boot from a SAN (storage area network) attached storage feature on the 
IBM BladeCenter Blade servers provides high availability, reduces cabling 
complexity, minimizes the downtime windows, and helps consolidate the IT 
infrastructure. 

9.1.1  Cost reduction
The BladeCenter architecture helps cut the equipment costs by reducing the 
number of moving parts such as fans, power supply, and internal disk drives 
when compared with the stand-alone servers. The BladeCenter architecture 
provides the capability to share the resources such as power, cooling, cabling, 
and IO paths among all the servers within the chassis and facilitates centralized 
management.

9.1.2  High availability
The system downtime is greatly minimized in situations where a critical 
component such as a processor, memory, or the system planar fails and needs to 
be replaced. The system administrator only needs to swap the hardware with 
similar hardware and install the same Fibre Channel Host Bus Adapter (HBA) on 
the blade server, thus making the system quickly available for production. In case 
of the HBA failure, the system administrator must replace the failed HBA and 
modify the zoning to include the WWPN of the new HBA in the active zone set 
and update the host configuration on the storage subsystem to make the system 
operational. Additionally, the user must update the HBA's BIOS boot 
configuration, via the Alt-Q utility, to point the HBA's boot LUN to the correct 
logical drive on the storage subsystem. The system image resides on the logical 
drive hosted by the storage subsystem connected to the SAN.

9.1.3  Centralized management
Centralized management can be achieved with a single blade server within the 
same chassis with management applications, such as IBM Director/RDM 
installed for remote deployment of the OS, or firmware updates for device 
peripherals over the local area network (LAN). 
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9.1.4  Redundancy
End-to-end redundancy is established across the Fibre Channel path from the 
host to the storage. The dual port HBA, redundant switch modules in the chassis, 
and a maximum of four paths on each DS4800 storage controller gives you the 
ability to route IO across the redundant paths. The RDAC multipath driver on the 
host and the Auto Volume Transfer feature on the storage subsystems both 
contribute to detecting path failures and rerouting the IO down an alternate path. 

In addition to the redundant architecture of the solution, the RAID (redundant 
array of inexpensive disks) technology, for example, RAID 10 (mirroring + 
striping), RAID 3 (striping and all parity stored on one disk per array), and RAID 5 
(striping and parity on all disks in an array) protect against data loss if only one 
disk per array has failed. Thus, RAID 5 plus a spare drive per array provides 
adequate protection against data loss and drive failures.

Enhanced performance can be achieved by exploiting the existing Fibre Channel 
bandwidth, a maximum speed of 4 Gbps end-to-end in conjunction with load 
balancing, using RDAC for Windows or Linux operating systems or the built-in 
failover/load balancing capabilities of the Linux device driver across four host 
channels per DS4800 storage controller. At a LUN level, the DS4800 storage 
subsystem operates in an active passive configuration, which means a LUN is 
always available via single or multiple paths on the active controller (preferred 
owner of that LUN), if the primary path fails, then the LUN is moved to the backup 
path regardless of the failing point, for example, the host, fabric, or the storage. At 
a controller level, both controllers may be active.
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9.1.5  Implementing Boot from SAN
The following sections briefly cover the workings of a Boot from SAN solution and 
the best practice procedures that ensure seamless integration of various 
components in addition to a clean deployment of the solution.

The architectural view in Figure 9-1 illustrates a most common software stack 
installed on the host in order for it to successfully boot from the DS4000 storage. 
The preliminary configuration is performed at the FC BIOS on the Fibre Channel 
HBA installed on the host to enable it to boot from the SAN attached storage. 
Once the connectivity to the fabric is established, storage is mapped to the host 
and selected as the boot device, and then the operating system is installed 
through the single path on the boot disk mounted from the DS4800 subsystem. 

Figure 9-1   Blade Server Boot from DS4800 Storage Architecture

The RDAC multipath driver is installed once the OS has been installed and prior 
to introducing alternate paths to storage. It maintains the path information and so 
if a link failure is detected on the active path, it notifies the storage controller to 
move the LUN(s) to the alternate path. This link failure detection and notification 
occurs with minimum delay before the IO is rerouted through the alternate path 
and the system becomes available to the user. The RDAC driver resides between 
the HBA's device driver and the OS managing the path that is presented to the 
OS, as shown in Figure 9-1. If the link failure is detected during the system 
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initialization, for example, when the OS is not loaded on the host, then Auto 
Volume Transfer (AVT) or Auto Disk Transfer (ADT) feature must be enabled on 
the storage subsystem and the boot LUN configured on both HBA ports to detect 
the link failure on the preferred path and move the LUN to the backup path. 
Table 9-1 shows the default and configured ADT status on the DS4800 storage 
subsystem.

Table 9-1   NVSRAM Host Type Index definitions

Zoning 
Zoning provides the segregation of devices at the fabric level by creating smaller 
virtual SANs within the fabric. Zoning logically manages access between devices 
within the same physical Fibre Channel fabric. In order for a host to gain access 
to the storage subsystem port, its host port(s) must be placed in the same zone 
as the corresponding target port(s) and this zone should be a member of the 
active zone set. Thus, zoning is a tool to permit or deny access to the devices 

INDEX ADT 
STATUS

TYPE

0 Disabled Default

1 
(Default)

Disabled Windows 2000/Server 2003 Non-Clustered

2 Enabled Windows 2000/Server 2003 Non-Clustered

3 Disabled Windows 2000/Server 2003 Clustered

4 Disabled AIX®

5 Enabled Linux

6 Disabled AIX

7 Enabled HP-UX

8 Disabled Solaris™

9 Enabled Windows 2000/Server 2003 Non-Clustered (supports DMP)

10 Disabled Irix

11 Enabled NetWare Failover

12 Enabled IBM TS SAN VCE

13 Disabled LNXCL

14 Enabled Solaris (with VERITAS DMP)

15 Enabled Windows 2000/Server 2003 Clustered (supports DMP)
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connected to the fabric, but it does not have the intelligence to apply controls 
beyond the fabric, for example, to present or hide the LUN to certain hosts. 

LUN masking 
The data integrity is ensured by applying the LUN level security; the DS4100, 
DS4700 and DS4800 storage provides the storage partitioning feature used to 
permit or deny a device access to the storage. Storage partitioning is 
independent of Fibre Channel zoning. Additionally, LUN masking capabilities are 
available within the SANSurfer management GUI to allow further control over a 
host's access to its storage LUNs. This is one example of LUN masking, at the 
controller level, while products such QLogic SANSurfer can do masking at the 
host level, and so on.

9.2  Boot from SAN configuration best practices
The best practices considerations shown in Table 9-2 are specified for the 
QLogic Fibre Channel 4 Gb Switch Module, McDATA 4 Gb Fibre Channel Switch 
Module, and the DS4000 storage subsystem.

Table 9-2   Minimum hardware configuration for setting up the Boot from SAN FC SAN 

Hardware list Quantity

BladeCenter chassis 1

Blade server 1

FC expansion card 1

FC SAN switch module 2

Storage Array Controller 1

External FC SAN switch <optional> 1
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9.3  Configuring Boot from SAN on TotalStorage DS4100 

In this section, we discuss and actually perform the Boot from SAN on the 
TotalStorage DS4100. However, you should note that these steps can be use to 
implement Boot from SAN on the DS4700 and DS4800 as well.

9.3.1  Blade server F1 setup 
This step should be performed when you are prepared to configure a Boot from 
SAN environment. Perform the instructions in 4.2, “Blade server F1 setup” on 
page 36 to disable the use of the IDE or SCSI drives that may be installed in the 
HS20, HS21, HS40, or LS20.

9.3.2  Blade server - QLogic HBA setup
This section discusses our setup of the QLogic Fibre Channel HBA establishing 
a connection with the TotalStorage DS4100 world wide name (WWN).

1. Start the BladeCenter HS20 to configure QLogic HBA. When you reach the 
Ctrl-Q application (Example 9-1), type Ctrl-Q and press Enter to access the 
QLogic Fast!UTIL.

Example 9-1   Ctrl-Q execute window

Broadcom NetXtreme Ethernet Boot Agent v3.1.15
Copyright (C) 2000-2002 Broadcom Corporation
All rights reserved.

Broadcom NetXtreme Ethernet Boot Agent v3.1.15
Copyright (C) 2000-2002 Broadcom Corporation
All rights reserved.

QLogic Corporation
QMC2462 PCI Fibre Channel ROM BIOS Version 1.04
Copyright (C) QLogic Corporation 1993-2005. All rights reserved.
www.qlogic.com

Press <CTRL-Q> for Fast!UTIL

BIOS for Adapter 0 is disabled
BIOS for Adapter 1 is disabled
ROM BIOS NOT INSTALLED

<CTRL-Q> Detected, Initialization in progress, Please wait...
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The window shown in Figure 9-2 should appear.

Figure 9-2   Select I/O Address window
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1. Select 0 ID and press Enter. You will see a window similar to Figure 9-3.

Figure 9-3   Configuration Settings window
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2. Select Configuration Settings. You will see a window similar to Figure 9-4.

Figure 9-4   Adapter Settings window

3. Under Configuration Settings, click Adapter Settings. You will see a window 
similar to Figure 9-5 on page 281.
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Figure 9-5   5 - Adapter Settings WWPN info and enable BIOS window

4. Ensure that the Host Adapter BIOS is Enabled, the Hard Loop ID is set to 
125, and Data Rate is set to 2 (auto detect). Press Enter to change settings 
and Esc to exit. Next, you will see a window similar to Figure 9-6 on page 282.

Note: You should make a note of the adapter port name (otherwise known 
as the world wide port name), so that it corresponds to the ID on the 
storage subsystem.
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Figure 9-6   Scan Fibre Devices window

5. Hit Esc (Figure 9-6), then scan the Fibre Channel devices to register it with 
the switch name server for zoning and with storage.

At this step, we are scanning the Fibre Channel SAN so that the HBA 
registers with the fabric to allow for zoning, since the device should be listed in 
the switches name server database (this is part of the scan FC devices 
process) so that the user does not have to manually enter its WWPN. You are 
now able to perform the zoning (assuming all equipment was wired/powered 
up before any of this was started). Also, this process registers the HBAs 
WWPN with the storage device so that the user does not have to manually 
enter this information when defining host partitions.

At this point, you should see the window shown in Figure 9-7 on page 283.
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Figure 9-7   DS4100 storage listed
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6. Select WWN 200400A0B812E053 and press Esc. You will see a window 
similar to Figure 9-8. The WWPN will not be the user’s, as it depends on the 
WWPN of their storage; think of WWPN as the serial number of the storage 
devices, thus it is unique to each storage port. 

Figure 9-8   Configuration Settings window

7. Select “Selectable boot settings” and press Enter. You will see a window 
similar to Figure 9-9 on page 285.

Note: The point of this step is to register the HBA with the fabric so that we 
can configure zoning and host partitioning without having to enter the 
WWPNs of the devices by hand.
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Figure 9-9   QLogic Fast!UTIL window

8. In the Selectable Boot Settings window, ensure Selectable Boot is set to 
Enabled (Do not press Enter). Stop at this point. Go to “Configure the QLogic 
Fibre Channel Switch Module” on page 288. 
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Figure 9-10   Select the boot device

9. Once you have completed your Zoning steps in “Configure the QLogic Fibre 
Channel Switch Module” on page 288 and “Storage” on page 303, you will 
return here. You should see the window shown in Figure 9-9 on page 285. 
Select Primary Boot Port Name, Lun and press Enter. You will see a window 
similar to Figure 9-10. Select the boot storage device’s WWPN and press 
Enter. Now, you are allowed to select a specific boot LUN. 

You will see a window similar to Figure 9-11 on page 287. In our example, we 
selected 200400A0B812E053. 

STOP: At this point, go to the zoning instructions now before proceeding to 
step 9. The point of this step is not to select the boot LUN quite yet; rather, 
it is just to register the HBA with the fabric. We will select the boot LUN 
later since we have not defined it yet. Now, you should start and complete 
the steps in 9.3.3, “Configure the QLogic Fibre Channel Switch Module” on 
page 288, at which point you will continue with the window shown in 
Figure 9-10.
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Figure 9-11   Selectable Boot Settings window

10.Press Esc and you will see a window similar to Figure 9-12.

Figure 9-12   QLogic Fast!UTIL window
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11.Press Enter to save your changes. You can begin the installation of your 
operating system once you have confirmed there is only one logical path from 
the server to the storage. 

9.3.3  Configure the QLogic Fibre Channel Switch Module 
In this section, we will access the QLogic SANbrowser to begin the configuring of 
zones for accessing storage LUNs on the TotalStorage DS4100.

1. To begin, enter the IP address of the QLogic Fibre Channel Switch Module for 
IBM BladeCenter into your Internet Explorer Web browser. You will see the 
Java Plug-in Version Check and after several seconds a window similar to 
Figure 9-13.

Figure 9-13   SAN browser window

2. Select Open existing fabric [requires IP address, login, and password] 
and click Proceed. You will see a window similar to Figure 9-14 on page 289.

Note: If the Java JRE™ is not installed, you will get a warning when you try 
to connect to the switch via a Web browser.
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Figure 9-14   Add a New Fabric window

3. Enter a name in the Fabric Name field. Continue to insert the IP address of 
the switch module and then your user ID and password. The default user ID 
and password is USERID and PASSW0RD (use all caps, and, in the 
password, insert 0 for O). In our example, we enter a fabric name of 
BladeCenter SAN 1. Click Add Fabric. You will see a window similar to 
Figure 9-15. 

Figure 9-15   Fabric specified window
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4. Click OK. You will see a window similar to Figure 9-16.

Figure 9-16   Topology window
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5. This is the topology window that includes the 4Gb QLogic Fibre Channel 
Switch Module and the QLogic SANBox 1404. Double-click 6 Port FCSM Bay 
3 and you will see a window similar to Figure 9-17.

Figure 9-17   Edit zoning window

Note: In this example, 6 Port FCSM Bay 3 is a logical name for the switch 
that we defined. This could be named something more significant for your 
environment. Also, the switch could reside in Bay 3 or Bay 4, which are 
both valid bays for the FCSMs.
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6. From the Edit Zoning dialog window, click the Zoning icon and then click Edit 
Zoning. You will see a window similar to Figure 9-18.

Figure 9-18   Zoning switches listed window
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7. From the Edit Zoning dialog window (Figure 9-19), click Zone Set → Create 
a zone set. You will see a window similar to Figure 9-20 on page 294.

Figure 9-19   Create zone set window
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Figure 9-20   Creating BladeCenter1 zone set window

8. In the Create a zone set dialog box, enter a name for the Zone Set Name field 
and click OK. In our example, we typed BLADECENTER1.
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9. Once the zone set has been created, you should create a zone. Right-click 
ZoneSet: BLADECENTER1 and select Create a Zone... (Figure 9-21). You 
will see a window similar to Figure 9-22 on page 296.

Figure 9-21   BladeCenter1 zone set created window
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10.In the Create a zone dialog box, enter a name in the Zone Name field and 
click OK (Figure 9-22). In our example, we typed BLADE4PORT0BOOT. Next, 
you will see a window similar to Figure 9-23 on page 297.

Figure 9-22   Creating blade4port0boot zone window
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Figure 9-23   blade4port0bootzone created window
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11.Hold Ctrl and select the devices meant for the zone with the left mouse 
button. In our example, we selected the FCSM WWN: 
21:00:00:e0:8b:95:36:1e (QLogic Corp.) and the storage path WWN: 
20:04:00:a0:b8:12:e0:53 (IBM 1724-100 FAStT (Rev. 0542) (Figure 9-24). 
Continue holding down the mouse button and drag the members to the zone. 
You will then see a window similar to Figure 9-25 on page 299.

Figure 9-24   Edit Zoning - SAN Browser window
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Figure 9-25   Edit Zoning - SAN Browser window
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12.Members were added to the zone. Click Apply to apply zoning changes. You 
will see a window similar to Figure 9-26.

Figure 9-26   Perform error check and save zoning

13.From the Save Zoning and Error Check dialog box (Figure 9-26), select 
Perform Error Check. Once the Error Check is complete and no errors 
appeared, select Save Zoning. You will see a window similar to Figure 9-27. 

Figure 9-27   Zone set activation window

14.Select Yes to activate your zone set(s) once the save is complete. You will see 
a window similar to Figure 9-28 on page 301.
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Figure 9-28   Select zone set to activate

15.Select the zone set to be activated and click OK. You will see a window similar 
to Figure 9-29.

Figure 9-29   Zone set activated
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16.Click the Close button to complete saving your zone. You are returned to a 
window that is similar to Figure 9-30.

Figure 9-30   Close edit zoning
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9.3.4  Storage
In this section, we will complete the necessary steps to access our storage 
server. Perform the following instructions: 

1. Click Start → All Programs → Storage Manager 9 Client to launch 
Storage Manager (Figure 9-31). You will see a window similar to Figure 9-32 
on page 304.

Figure 9-31   Start Storage Manager 9 client
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Figure 9-32   Load Storage Manager

2. Under Initial Setup, click Add Storage Subsystems. You will see a window 
similar to Figure 9-33.

Figure 9-33   Select Addition Method window
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3. Select Manual to specify storage subsystems and click OK. You will see a 
window similar to Figure 9-34.

Figure 9-34   Add Storage Subsystem

4. Enter the controller IP addresses of the storage server and click Add. You will 
see the connecting status. Afterwards, you will see a window similar to 
Figure 9-35.

Figure 9-35   Storage Subsystem Added window
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5. Click No. You do not want to add any more storage at this time. You will see a 
window similar to Figure 9-36.

Figure 9-36   Enterprise Management Window Task Assistant

6. Click Manage a Storage Subsystem. You will see a window similar to 
Figure 9-37.

Figure 9-37   Select Storage Subsystem window
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7. Specify which storage subsystem you plan to manage. In our example, it is 
the DS4100. Click OK. You will see a window similar to Figure 9-38.

Figure 9-38   Storage Subsystem Configuration window
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8. Click Configure Storage Subsystem. You will see a window similar to 
Figure 9-39.

Figure 9-39   Choose Configuration Task window
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9. Select Create individual logical drives and click OK. You will see a window 
similar to Figure 9-40.

Figure 9-40   Allocate Capacity for Logical Drive window
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10.Specify what space to use for LUN. In our example, we selected the RAID 0 
array. You will see a window similar to Figure 9-41.

Figure 9-41   specify lun capacity and lun name

11.Specify the LUN capacity and LUN name. In our example, the LUN capacity is 
10 GB and the LUN name is BLADE4OS. Under Advanced logical drive 
parameters, make sure User recommended settings is selected. Click Next 
and you will see a window similar to Figure 9-42 on page 311.
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Figure 9-42   Specify Logical Drive-to-LUN Mapping (Create Logical Drive) window

12.Specify the logical drive to LUN mapping, insuring you pick a type where 
AVT/ADT is enabled (see Table 9-1 on page 275). In our example, we 
selected Windows 2000/Server 2003 Non-Clustered. Click Finish to created 
the LUN. Next, you will see a window similar to Figure 9-43.

Figure 9-43   Creation Successful (Create Logical Drive) window
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13.Click No. You do not want to create any additional LUNs at this time. Next, you 
will see a window similar to Figure 9-44.

Figure 9-44   Completed (Create Logical Drive) window

14.Review the information in the window and click OK. You will see a window 
similar to Figure 9-45.

Figure 9-45   Cancel out to get out of configuration
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15.Click Cancel to exit configuration task. You will see a window similar to 
Figure 9-46.

Figure 9-46   Click on define hosts
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16.Click Define Hosts. Here you will define your host to your storage subsystem. 
You will see a window similar to Figure 9-47.

Figure 9-47   Introduction (Define Host) window
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17.Select Yes and click Next to use the storage partition on the selected 
subsystem. You will see a window similar to Figure 9-48.

Figure 9-48   Specify Host Name/HBA Attributes (Define Host) window
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18.Specify the name of your host. In our example, we selected BLADE4OS. 
Next, you will specify the WWPN of the HBA you intend to use. In our 
example, we selected 210000e08b95361e. Click Add. You will see a window 
similar to Figure 9-49.

Figure 9-49   Edit Identifier/Alias (Define Host) window
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19.In the Alias field, specify an alias for mapping. In our example, we typed 
BLADE4WINDOWS. Click OK to continue. You will see a window similar to 
Figure 9-50.

Figure 9-50   Specify Host Type (Define Host) window
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20.In this step, specify the host type (or the operating system) of your host. In our 
example, we specified Windows 2000/Server 2003 Non-Clustered. Click Next 
to continue. You will see a window similar to Figure 9-51.

Figure 9-51   Host Group Question (Define Host) window

21.Select No - this host will NOT share access to the same logical drives 
with other hosts. Click Next and you will see a window similar to Figure 9-52 
on page 319.
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Figure 9-52   Preview (Define Host) window

22.In Figure 9-52, you are able to verify the host information you have defined. 
Click Finish. You will see a window similar to Figure 9-53.

Figure 9-53   Creation Successful (Define Host) window
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23.After your host has been successfully created, click No to return the 
Subsystem Management Window Task Assistant window (Figure 9-54).

Figure 9-54   Subsystem Management Window Task Assistant window
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24.Select Create New Storage Partitions. You will see a window similar to 
Figure 9-55.

Figure 9-55   Storage Partitioning Wizard window
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25.Click Next to enter the wizard. You will see a window similar to Figure 9-56.

Figure 9-56   Storage Partitioning Wizard - Select Host Group or Host window

26.In this step, we will select the Host we have created for our configuration. 
First, select Host and then select BLADE4OS. Click Next. You will see a 
window similar to Figure 9-57 on page 323.
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Figure 9-57   Storage Partitioning Wizard - Select Logical Drives/LUNs window
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27.In the Logical Drive/LUN assignment view, select BLADE4OS 10.000GB as 
our logical drive. Assign LUN 0 and click Add. You will see a window similar to 
Figure 9-58. Listed in Table 9-3 are valid boot LUNs you may use.

Table 9-3   Operating system valid boot LUN

Figure 9-58   Storage Partitioning Wizard window

Operating system Valid Boot LUN

Linux 2.6 kernel (for example, RH4, SLES9) LUNs 0-7

Linux 2.4 kernel (for example, RH3, SLES8) LUN 0

Windows 2000/2003 LUN 0-15
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28.Click Finish to complete the logical drive mapping. You will see a window 
similar to Figure 9-59.

Figure 9-59   Define Storage Partitioning Wizard - Processing window
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29.Click OK. Next, you will see a window similar to Figure 9-60.

Figure 9-60   DS4100 - IBM TotalStorage DS4000/FAStT Storage Manager 9 (Subsystem Management) 

This step completes the storage configuration for blade4port0. After completing 
the steps in this section, you should return to step 9 on page 286 to configure the 
boot storage device’s WWPN for installing the operating system.

9.3.5  Configuring Boot from SAN on DS400
If you seek to implement a BladeCenter Boot from SAN utilizing the DS400, 
please review the QLogic white paper: 

Boot from SAN Part III: Technology update QLA4010/QMC4052/QLA234x/IBM 
FCEC/QMC2462 DS300/400/4x00 Configuration Guide

found at:

http://www.qlogic.com/documents/datasheets/knowledge_data/whitepapers/b
oot_from_SAN_pt3.pdf
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Appendix A. Brocade documentation and 
technical help

This appendix lists the Brocade documentation and technical help that you can 
access on the Web and other sources.

A
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Documentation for Brocade 4Gb SAN switch module
The following are included on the Brocade 4Gb SAN Switch Module for IBM 
BladeCenter Documentation CD-ROM, the IBM BladeCenter Web Site, the IBM 
TotalStorage SAN Switch Web site, or on the Brocade Web site, through the 
Brocade Connect site.

Fabric OS
The following are Brocade Fabric OS documents:

� Brocade Fabric OS Administrator's Guide

� Brocade Fabric OS Command Reference Manual

� Brocade Fabric OS System Error Message Reference Manual

� Brocade Fabric OS MIB Reference Manual

� Brocade Fabric OS v5.0.2 Release Notes

Fabric OS Features
The following are Brocade advanced features documents:

� Brocade Web Tools Administrator's Guide

� Brocade Fabric Watch Administrator's Guide

� Brocade Secure Fabric OS Administrator's Guide

Fabric Management Software
The Brocade Fabric Manager Administrator's Guide describes the setup and 
implementation of the Fabric Manager SAN software.

Brocade 4Gb SAN Switch Module for IBM BladeCenter 
(SilkWorm 4020)

The following are Brocade documents for the 4Gb SAN Switch Module 
(SilkWorm 4020):

� SilkWorm 4020 Hardware Reference Manual

� SilkWorm 4020 QuickStart Guide
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Additional resource information
For related information about very specific features or features, refer to the 
documents posted through the Brocade portal link on the IBM TotalStorage SAN 
Switch Support Web site:

Go to http://www.ibm.com/servers/storage/san/b_type/library.html and 
click the Fabric Operating System (FOS) Version 5.x Product Manuals link at 
the bottom of the page. At the redirected site, select Home → Technical 
Resource Center → Documentation Library → Best Practice Guides.

Current relevant titles include:

� 1 Gbit/sec to 2 and/or 4 Gbit/sec SAN Migration Diagram Version 1.3

� Cable Management Guidelines Version 1.0

� Firmware Downloads Best Practice Notes Version 2.0

� IBM BladeCenter Design, Deployment and Management Guide Version 1.0

� LAN Guidelines For Brocade SilkWorm Switches Version 1.4

� SAN Administrator's Bookshelf

� SAN Migration Guide Version 1.1

� SAN Security Best Practices Guide

The guides can also be obtained through the Brocade Connect Web site:

http://www.brocadeconnect.com

There are also white papers for Server and SAN Administrators provided on the 
Brocade Web site, which are an excellent resource for additional information:

http://www.brocade.com/san/white_papers.jsp

Relevant titles on the topics of SAN Basics, SAN Design, SAN Management, and 
SAN Solutions include:

� Brocade SAN Solutions: A More Effective Approach to Information Storage 
and Management

� Connecting SANs Over Metropolitan and Wide Area Networks

� Designing Next-Generation SANs with Brocade 4Gbit/sec Fibre Channel 
Solutions

� Benefits of Upgrading to 4 Gbit/sec Brocade SAN Infrastructure

� The Benefits of Upgrading a SAN Infrastructure Using Brocade Technology

� Zoning Implementation Strategies for Brocade SAN Fabrics

� Improving Business Continuity and Data Availability Using Brocade SAN
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For practical discussions about SAN design, implementation, and maintenance, 
you can obtain The Principles of SAN Design through:

http://www.brocade.com/products/sanadmin_bookshelf/index.jsp

For additional Brocade documentation, visit the Brocade SAN Info Center and 
click the Resource Library location at http://www.brocade.com.

Release notes are bundled with the Fabric OS.

Getting technical help for Brocade 4Gb SAN switch 
module

Contact IBM Support for hardware, firmware, and software support.

For support calls, have the following information available:

1. General Information

– Technical Support contract number, if applicable

– Switch model

– Switch operating system version

– Error numbers and messages received

– supportSave command output

– Detailed description of the problem and specific questions

– Description of any troubleshooting steps already performed and results

2. Switch Serial Number

The switch serial number and corresponding bar code are provided on the 
serial number label, on the side of the unit. The serial number is 12 characters 
long and looks something similar to this:

SN: ZXXXXX3WA069

The serial number label is located as follows:

SilkWorm 4020 switch: Side of switch module

It can also be obtained:

– From a telnet session to the switch by using the chassisshow command. It 
is located in the Serial Num: field.

– From a Web Tools session, where it is located in the Supplier Serial # field.

– From Fabric Manager, click the Switches tab. It is located in a column 
titled Supplier Serial Number.
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– From the IBM BladeCenter Management Module, click the Hardware VPD 
tab. It is located in a column titled FRU Serial No.

3. License ID Information (required to obtain or replace licenses)

– From a telnet session to the switch, use the licenseidshow command to 
display the license ID.

– In a Web Tools session, where is located in the LicenseID field.
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Related publications

The publications listed in this section are considered particularly suitable for a 
more detailed discussion of the topics covered in this IBM Redbook.

IBM Redbooks
For information about ordering these publications, see “How to get IBM 
Redbooks” on page 336. Note that some of the documents referenced here may 
be available in softcopy only. 

� IBM BladeCenter iSCSI SAN Solution, REDP-4153

� IBM eServer BladeCenter and Topspin InfiniBand Switch Technology, 
REDP-3949

� IBM TotalStorage DS300 and DS400 Best Practices Guide, SG24-7121

� IBM TotalStorage: SAN Product, Design, and Optimization Guide, SG24-6384

Other publications
These publications are also relevant as further information sources:

� McDATA 4Gb Fibre Channel Switch Module for IBM eServer BladeCenter 
Installation Guide

� McDATA 4Gb Fibre Channel Switch Module for IBM eServer BladeCenter 
Management Guide

� QLogic 4Gb Expansion Card for IBM eServer BladeCenter Installation Guide

� QLogic 4Gb Fibre Channel Switch Module for IBM eServer BladeCenter 
Installation Guide

� QLogic Fibre Channel Switch Module for IBM eServer BladeCenter 
Management Guide
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Online resources
These Web sites and URLs are also relevant as further information sources:

� Boot from SAN Part III: Technology update 
QLA4010/QMC4052/QLA234x/IBM FCEC/QMC2462 DS300/400/4x00 
Configuration Guide, found at:

http://www.qlogic.com/documents/datasheets/knowledge_data/whitepaper
s/boot_from_SAN_pt3.pdf

� Brocade Connect Web site.

http://www.brocadeconnect.com

� For additional Brocade documentation, visit the Brocade SAN Info Center and 
click the Resource Library location.

http://www.brocade.com

� Brocade Fabric Manager 5.0 (software product sold separately). More 
information regarding this product can be viewed at:

ftp://ftp.software.ibm.com/common/ssi/rep_sp/n/TSD00742USEN/TSD00742
USEN.PDF

� Brocade Web site - White papers for Server and SAN Administrators.

http://www.brocade.com/san/white_papers.jsp

� CLARiiON products.

http://www.emc.com/CX3

� DS4800 software downloads.

http://www-307.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-
62161

� DS4700 Storage Web site.

http://www-03.ibm.com/servers/storage/disk/ds4000/ds4700/index.html

� DS4800 Storage Web site.

http://www-03.ibm.com/servers/storage/disk/ds4000/ds4800/index.html

� EMC Approved Software: Symmetrix and CLARiiON.

http://support.qlogic.com/support/oem_product_list.asp?oemid=65

� EMC CLARiiON Support Services.

http://www.emc.com/global_services/support/clariion_support/index.js
p

� EMC Powerlink.

https://powerlink.emc.com/
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� EMC Topology Guide: This guide is available via Powerlink. Visit the following 
Web link to gain access to this material.

https://powerlink.emc.com/

� For more information regarding the Emulex technology, visit the following Web 
site: 

http://www.emulex.com/

� Feature activation keys (Activate a SAN Switch feature).

http://www.ibm.com/storage/key

� Fibre Channel Expansion Card Signed device driver for Microsoft Windows 
2000 and Windows Server 2003 - BladeCenter HS20, HS40 and LS20.

http://www-307.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-
53295

� Fibre Channel switches for BladeCenter.

http://www-03.ibm.com/systems/bladecenter/switch/switch_fibrechannel
_overview.html

� Web site to download files and for installation instructions for software and 
device drivers for IBM BladeCenter.

http://www-307.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-
63017

� IBM BladeCenter.

http://www-03.ibm.com/systems/bladecenter/

� IBM BladeCenter Alliance Program.

http://www-03.ibm.com/servers/eserver/bladecenter/alliance/

� IBM BladeCenter Chassis.

http://www-306.ibm.com/common/ssi/rep_ca/7/897/ENUS106-117/ENUS106-1
17.PDF

� IBM BladeCenter H Chassis.

http://www-306.ibm.com/common/ssi/rep_ca/1/897/ENUS106-161/ENUS106-1
61.PDF

� IBM ServerProven Program Web site. 
http://www-03.ibm.com/servers/eserver/serverproven/compat/us/

� IBM Storage for IBM BladeCenter.

http://www-03.ibm.com/servers/eserver/bladecenter/storage/

� IBM System Storage SAN10Q Web site. 
http://www-03.ibm.com/servers/storage/san/q_type/san10q/
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� IBM TotalStorage SAN Switch Support Web site.

http://www.ibm.com/servers/storage/san/b_type/library.html

� The Principles of SAN Design, found at:

http://www.brocade.com/products/sanadmin_bookshelf/index.jsp

� QLogic Switch Interoperability Guide v6.0, found at:

http://qlogic.com/interopguide/info.asp

How to get IBM Redbooks
You can search for, view, or download Redbooks, Redpapers, Hints and Tips, 
draft publications and Additional materials, as well as order hardcopy Redbooks 
or CD-ROMs, at this Web site: 

ibm.com/redbooks

Help from IBM
IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
336 IBM BladeCenter 4Gb SAN Solution

http://www.ibm.com/servers/storage/san/b_type/library.html
http://www.brocade.com/products/sanadmin_bookshelf/index.jsp
http://qlogic.com/interopguide/info.asp
http://www.redbooks.ibm.com/
http://www.redbooks.ibm.com/
http://www.ibm.com/support/
http://www.ibm.com/support/
http://www.ibm.com/services/
http://www.ibm.com/services/


Index

Numerics
10 Gb Ethernet   6
2,000-watt power modules   5
2-port PCI-X adapter   10
4Gb Linux® Driver Update Disks   12
4Gb SAN   1
4Gb SAN solution   49
4Gb SFP transceivers   112
4X Infiniband   6
50-micron cable   105
8843   10
8850   10

A
Advance Adapter Settings   42
Advanced Management Module (AMM)   5
Advanced Management Module (aMM)   6
Advanced Performance Monitoring   65
advanced SAN security   50
Advanced Web Tools   17, 28, 65
Advanced Zoning   65, 115
AMD Opteron   6, 10
ASIC-embedded memory   26
audit logging   17
Auto Disk Transfer (ADT)   275
Auto Volume Transfer (AVT)   275
Auto Volume Transfer feature   273
auto-negotiate link speed   16
auto-sensing   16

B
billing   27
BIOS   10
BladeCenter   5
BladeCenter architecture   272
BladeCenter H   5
BladeCenter Management Module   43
BladeCenter platforms   12
BladeCenter switch module options   11
BladeCenter T   5
blades   5, 10
Boot from SAN   10, 277
© Copyright IBM Corp. 2006. All rights reserved.
Boot from SAN environment   36
Boot from SAN function   222
boot LUN   222
Brocade   1, 10, 15, 225
Brocade 10-Port 4Gb SAN Switch Module   15
Brocade 10-Port Upgrade   17
Brocade 20-Port 4Gb SAN Switch Module   15
Brocade 4Gb FC Switch Module   17
Brocade 4Gb SAN Switch Module documentation   
328
Brocade 8 and 16-Port Upgrade   28
Brocade Advanced Performance Monitoring   17, 28, 
65
Brocade Advanced SAN Security   18, 28
Brocade Advanced Security   65
Brocade Advanced Zoning   17, 28
Brocade Dynamic Path Selection   17, 28
Brocade Extended Fabric   18, 28
Brocade Extended Fabrics   65
Brocade Fabric Manager 5.0   18, 28
Brocade Fabric Manager v5.x   66
Brocade Fabric Operating System (Fabric OS)   17, 
28
Brocade Fabric Watch   18, 28, 65
Brocade Inter-Switch Link (ISL) Trunking   27
Brocade ISL Trunking   17, 28, 65
Brocade Multi-protocol Router   54
Brocade Performance Bundle   17, 28, 65
Brocade SAN environment   55
Brocade SAN management   27
Brocade SilkWorm   17
Brocade technology   17, 50
Brocade Web Tools   64, 72
building zones   121
Business Partners   1

C
cable connector   105
cable seating   106
centralized management   272
chassis   6
Cisco   1, 21, 225
Clear Zone Database   74
 337



cluster members   122
clustering software   122
command line interface (CLI)   47, 64, 80
common fabric support   5
configDownload option   74
configUpload option   74
configUpload/Download function   74
configuration analysis report   133
configuration/setup utility menu   36
connectivity status window   258
core-to-edge SAN topologies   52
CRC error tracking   17, 28
Ctrl-Q utility   10
CX700 Storage   223

D
data   2
data mining   2
data warehousing   2, 27
density   5
diagnostics   43
diskette drive   5
domain   17
Domain ID field   61, 84
Domain ID lock   152, 174, 182
driver update disks   12
drivers   36
DS4000 Service Alert   30
DS4100   271
DS4700   271
DS4800   271, 273
dual controller   29
dummy zone   93
DVD   5
DVD drive   6
Dynamic Capacity Addition   30
Dynamic Path Selection (DPS)   16, 102
Dynamic Volume Expansion   30

E
EFCM Basic   26
e-mail   27
EMC   1
EMC CLARiiON   222, 224
EMC CLARiiON CX3 UltraScale Series   33
EMC CLARiiON CX700   224
EMC CLARiiON Release notes   223
EMC CLARiiON Storage Manager Client utility   250

EMC PowerPath driver   265
EMC PowerPath Path Management   269
Emulex   1
Emulex 4Gb SFF Fibre Channel Expansion Card   
12
Emulex HBAnyware management suite   13
Emulex technology   13
Enterprise Fabric Connectivity Manager (EFCM)   
26
enterprise workgroup market   1
enterprise-class applications   27
Environmental Service Module (ESM)   30
ERP   27
ESM Customer Replacement Unit (CRU)   31
Ethernet   16
EXP810 Storage Expansion Unit   30
external auto-sensing   21
external fibre channel SAN switches   23
external storage disk arrays   29

F
FA zones   131
fabric   205
fabric aggregate bandwidth   24
fabric latency   24
fabric mode   23
Fabric OS (FOS)   56
fabric port speed   24
Fabric Toolbar   93
Fabric Tracker tool   25
Fabric View   164
Fabric Zone configuration   224
fabric zoning   222
fabrics   6
fabric-wide snapshots   25
FAStT100   29
FC Arbitrated Loop (FC-AL)   32
FC expansion card   10
FC frame - DPS balances loads   102
FC HBA BIOS   222
Fcode   10
FC-SW-2 standard   22
feature activation key   67–68
Feature Activation License Key   88
fiber cable   113
Fibre Channel   2
Fibre Channel (FC)   32
Fibre Channel 4Gb expansion cards   10
338 IBM BladeCenter 4Gb SAN Solution



Fibre Channel BIOS   38
Fibre Channel Enhanced Disk Drive Modules 
(E-DDM)   30
Fibre Channel Expansion Card Signed device driver   
12
Fibre Channel ports   105
Fibre Channel SAN switch   16
Fibre Channel Switch Fabric   223
Fibre Channel switches   22
Firmware   36
firmware   10, 36
firmware-based architecture   13
flash memory   80
form factors   10
Frame-filtering technology   17

Advanced Performance Monitoring   17
Advanced Zoning   17

Full Fabric License   65
Full Ports on Demand license   65
fully redundant storage connectivity   2

G
graphical user interface (GUI)   24

H
hardware enforced zoning   50
Health Monitoring tools   50
hierarchical storage life cycle management strategy   
31
homogeneous and heterogeneous operating envi-
ronment   2
Host Adapter BIOS   41, 233
host agent   265
host bus adapter (HBA)   13, 222
Host Bus Adapter (HBA) Zones   121
host configuration   135
host definition   136
Host Group   136
host port definitions   222
hot code activation   16
Hot Code Activation Technology (HotCAT)   26
hot pluggable   2
HotCAT functionality   19
hot-swap   6
hot-swap blowers   5
hot-swap power modules   5
HS20   5–6
HS21   5

HS40   6
HyperTerminal   78

I
I/O Module Tasks   44
I/O StreamGuard   25
IBM BladeCenter   1–3, 35
IBM BladeCenter Alliance Program   2
IBM BladeCenter chassis   5
IBM BladeCenter H   3, 5–6
IBM BladeCenter Management Module   43
IBM BladeCenter T   5
IBM customer service   2
IBM Director   5–6, 272
IBM SAN10Q Rack Kit   24
IBM ServerProven® Program   6
IBM Storage for IBM BladeCenter   2
IBM System Storage DS4700 Express   29
IBM System Storage DS4800   31
IBM System Storage EXP810 Storage Expansion 
Unit   30
IBM System Storage SAN10Q   23–24, 196
IBM TotalStorage DS4100   29
IBM TotalStorage SAN32B-2 Fibre Channel Switch   
27
IBM TotalStorage® b-type SAN switches   17
IDE   226
IDE configuration menu   36
imagery   2
independent solution vendors (ISV)   1
information technology (IT)   1
initiator   121
Initiator/Target Accessibility Matrix   134
initiator-to-target traffic   17
input/output per second (IOPS)   30
Inter Switch Link (ISL)   50
internal auto-sensing   19, 21
Internet Explorer   57, 82, 250, 288
Intrepid Directors   152
IP address   44
ipAddrSet command   79
ISL Trunking   65, 101, 105
ISL Trunking and Advanced Performance Monitor-
ing   28
ISL Trunking license   16
ISL Trunking licenses   107
ISP2422 ASIC   10
ISV applications   1
 Index 339



J
Java plug-in 1.4.2_03   223
Java Plug-in version check   288
JavaScript™   56
JS20   5–6
JS21   5–6

L
large Fibre Channel SAN environment   236
LED   43
license key upgrade   20
Light path diagnostic panel   5
light path diagnostics   6
link failure   275
Linux   224
Linux 2.4 kernel   324
Linux 2.6 kernel   324
load balancing   16, 268
long wavelength (LWL)   102
LS20   6
LUN capacity   310
LUN level security   276
LUN masking   276
LUN name   310
LUN(s)   55

M
Management Module Advanced IO setting   71
Management Module GUI   63, 106
maximum frame sizes   24
McDATA   1, 10, 21, 225
McData 10-port 4Gb Fibre Channel Switch Module 
for IBM eServer BladeCenter   19
McData 20-port 4Gb Fibre Channel Switch Module 
for IBM eServer BladeCenter   19
McDATA 4Gb Fibre Channel Switch Module   147
McDATA Edge Switch Sphereon 4400   156
McDATA Fabric Mode   22, 239
McDATA fabrics   21
McDATA Fibre Channel Switch Module   234
McDATA Mode   22
McDATA Mode Firmware Key Upgrade   22
McDATA Mode Firmware Upgrade   21
McDATA SANbrowser   153, 234
McDATA SANBrowser Web application   19
McDATA SANtegrity Enhanced Activation   20
McDATA SANtegrity Security Suite software   19
McDATA Sphereon 4400   26

McDATA Sphereon switch   152
McDATA switch modules   18
McDATA tools   225
McDATA Web Interface   223
McDATA's FlexPort technology   26
media tray   6
megabytes per second (Mbps)   30
mesh-to-edge SAN topologies   52
mid-plane   5
midplane   6, 13
midsized organization   27
modular design enclosure   5
Mozilla   57, 82
MRP   27
multi-boot option ROM   10
multi-platform support   13

N
nameserver table   114, 225
Navisphere Management Agent   223
network environment   23
network switch   5–6
networking options   3
Non-Disruptive Code Load and Activation (NDCLA)   
25
NTP server   65
NVSRAM host type index definitions   275

O
Open Fabric Mode   22
Open Firmware Fcode   10
Opteron   6
Option License Paper-Pak   66

P
Paper-Pak   68
Paper-Pak forms   73
pass-through devices   6
pass-through module   5
pay-as-you-grow scalability   15, 20
per-port buffering   24
Planar SCSI option   38
port   17
port configuration   158
port number   117
port properties   176, 201
Port Upgrade license   16
340 IBM BladeCenter 4Gb SAN Solution



Ports on Demand   16, 27, 71
Ports on Demand Upgrade license   90
PowerPC based   10
PowerPC®   6
preferred path   275
primary IDE channel   37
public loop mode   23

Q
QLogic   1, 10, 225
QLogic 10-port 4Gb Fibre Channel Switch Module 
for IBM eServer BladeCenter   20
QLogic 20-port 4Gb Fibre Channel Switch Module 
for IBM eServer BladeCenter   20
QLogic 4Gb Fibre Channel expansion cards   10
QLogic 4Gb Fibre Channel Switch Modules   169
QLogic 4Gb Standard and Small Form-Factor (SFF) 
Fibre Channel Expansion Card   11
QLogic 4Gb Standard and Small Form-Factor (SFF) 
Fibre Channel Expansion Cards for IBM Blade-
Center   10
QLogic 4Gb Standard Fibre Channel Expansion 
Card   11
QLogic Fibre Channel 1404   169
QLogic Fibre Channel 5602   169
QLogic Fibre Channel HBA   277
QLogic ISP2422 4Gb Fibre Channel dual port ASIC   
10
QLogic licenses   219
QLogic SANbox 5600 Stackable Switch   24
QLogic SANSurfer   276
QLogic SANsurfer Management Suite   10, 21
QLogic/McDATA 10-port Upgrade   20, 22
QuickLoops   131

R
Radius support   17
RDAC multipath driver   274
Redbooks Web site   336

Contact us   xii
redundancy   5
redundant array of independent disks (RAID)   222, 
273
redundant power modules   6
release lever   43
remote boot   2
Remote Deployment Manager   5–6
remote management   2, 223

RJ-45 connector   78
role based access control (RBAC)   17
routing   13
RS-232 serial port   78
RSCN suppression   25

S
SAN administrator   74
SAN check   195, 219
SAN design   52–53
SAN fabric   75
SAN technology   1
SAN256B enterprise director   52
SANsurfer Express software   23
SANsurfer Switch Manager   171, 196
SANsurfer Switch Manager Faceplate   175
SANsurfer Switch Manager open management sys-
tem   25
SANtegrity Security Suite   26
scalability   50, 54
scale-out   1
SCSI disks   38
SCSI Reads and Write   17
secondary IDE channel   37
secure device connectivity   17
secure shell (SSH)   17
segmentation   62
Selectable Boot Settings   285
serial connection   79
ServerProven® Program   6
Service Processors   222
SFF expansion card   10
SFP transceiver   106
SFP transceivers   105
short wavelength (SWL)   102
SilkWorm 4020   56
single controller   29
single management interface   10
small form factor   23
Small Form Factor Pluggable (SFP)   31
small form-factor pluggable (SFP)   25
small organizations   27
small private SAN groups   74
small to mid-sized businesses (SMB)   1
small-to-medium SAN fabrics   52
small-to-medium SAN topologies   52
SMB   1
SNMPV3   17
 Index 341



SSL/HTTPS   17
standard distance trunking   103
storage area network (SAN)   2, 5, 13, 29, 115, 221, 
272
Storage Disk Arrays   29
storage group   267
storage partitioning   143, 276
storage subsystem   135, 222
storage switch   5
storage switches   6
streaming video on demand applications   2
Subsystem Management Window Task Assistant   
320
swappable   2
switch fabric configuration   223
switch module's IP address   47
Switch PID Format   62
switch properties   198
syntax tsclockserver   65

T
Telnet   25
terminal emulator   79
terminal emulator application   78
topology   54
TotalStorage Boot from SAN   271
TotalStorage DS4100   277, 288
TotalStorage SAN32B-2 4Gb switch   75
Trunk Groups   104, 110
tsclockserver command   65, 81
tsTimeZone command   81

U
Unique Domain ID   152, 174, 182, 198
unique domain numbers   60
universal boot   13
U-port initialization   16
USB inputs   6
USB port   5

W
Web Tools   81
Web Tools management software   56
Web Tools Zone Admin   75
Windows 2000   224
Windows 2003 Advance Server   224
wizards   25

world wide name (WWN)   228
World Wide Name WWN   66
World Wide Node Name (WWNN)   17
World Wide Port Name (WWPN)   41
world wide port name (WWPN)   281
Writing License Activation Keys   73

X
Xeon MP   6
Xeon® DP   6

Z
zone   116, 224
Zone Admin module   131
Zone Administration module   93
Zone Administration window   120
zone alias   117
zone change   122
zone configuration   116
zone configuration summary   132
zone management   225
Zone Management tool   106
zone name   167
zone objects   116
zone set   155, 180, 204, 210
Zone Set Name   294
zones   131
Zoning   224, 275
zoning   74, 92, 282
Zoning Wizards   130
342 IBM BladeCenter 4Gb SAN Solution



(0.5” spine)
0.475”<

->
0.875”

250 <
->

 459 pages

IBM
 BladeCenter 4Gb SAN Solution







®

SG24-7313-00 ISBN 0738494860

INTERNATIONAL 
TECHNICAL
SUPPORT
ORGANIZATION

BUILDING TECHNICAL
INFORMATION BASED ON
PRACTICAL EXPERIENCE 

IBM Redbooks are developed by 
the IBM International Technical 
Support Organization. Experts 
from IBM, Customers and 
Partners from around the world 
create timely technical 
information based on realistic 
scenarios. Specific 
recommendations are provided 
to help you implement IT 
solutions more effectively in 
your environment.

For more information:
ibm.com/redbooks

IBM BladeCenter 
4Gb SAN Solution
New 4Gb Fibre 
Channel SAN 
technology

ServerProven 
BladeCenter FC 
switch modules

Simplification and 
lower 
cost-of-ownership to 
the data center

This IBM Redbook focuses on the 4Gb end-to-end Fibre 
Channel (FC) SAN solution for the IBM BladeCenter in the 
small to mid-sized businesses (SMB) and enterprise 
workgroup market.

In this IBM Redbook, we discuss the elements for 
constructing a BladeCenter SAN environment. We talk about 
the supported FC daughter cards, FC switch modules, 
external FC switches, and storage systems used in our lab 
environment. These items were used to construct an OEM 
environment to demonstrate the use of our storage vendor 
products and the interoperability of the IBM BladeCenter FC 
switch modules.

This IBM Redbook discusses the prerequisites, the 
installation, and the configuration of QLogic, McData, and 
Brocade switch modules in a homogeneous environment, as 
well as heterogeneous environments.

Back cover

http://www.redbooks.ibm.com/
http://www.redbooks.ibm.com/
http://www.redbooks.ibm.com/

	Front cover
	Contents
	Notices
	Trademarks

	Preface
	The team that wrote this IBM Redbook
	Become a published author
	Comments welcome

	Chapter 1. Executive summary
	Chapter 2. IBM BladeCenter
	2.1 IBM BladeCenter
	2.2 IBM BladeCenter H
	2.3 The IBM ServerProven Program

	Chapter 3. Elements of the IBM BladeCenter 4Gb SAN solution
	3.1 Fibre Channel 4Gb expansion cards
	3.1.1 QLogic 4Gb Standard and Small Form-Factor (SFF) Fibre Channel Expansion Cards for IBM BladeCenter
	3.1.2 Emulex 4Gb SFF Fibre Channel Expansion Card

	3.2 Integrated Fibre Channel switch modules
	3.2.1 Brocade 10-Port and 20-Port 4Gb SAN Switch Module
	3.2.2 McDATA 10-Port and 20-Port 4Gb Fibre Channel Switch Module
	3.2.3 QLogic 10-Port and 20-Port 4Gb Fibre Channel Switch Module

	3.3 External Fibre Channel SAN switches
	3.3.1 IBM System Storage SAN10Q
	3.3.2 QLogic SANbox 5600 Stackable Switch
	3.3.3 McDATA Sphereon 4400 Switch
	3.3.4 IBM TotalStorage SAN32B-2 FC Switch (SilkWorm 4100)

	3.4 External Storage Disk Arrays
	3.4.1 IBM TotalStorage DS4100
	3.4.2 IBM System Storage DS4700 Express
	3.4.3 IBM System Storage DS4800
	3.4.4 EMC CLARiiON CX3 UltraScale Series


	Chapter 4. IBM BladeCenter setup and configuration
	4.1 Supported environments for Windows and Linux operating systems
	4.1.1 Firmware and drivers

	4.2 Blade server F1 setup
	4.3 QLogic Fast!Util setup
	4.3.1 Configure the HS20 blade server Fibre Channel BIOS

	4.4 4Gb Fibre Channel switch module implementation
	4.4.1 FC switch module configuration through the Management Module
	4.4.2 Setting the switch module IP Address and enabling external ports


	Chapter 5. Brocade SAN configuration
	5.1 Building an enhanced 4Gb SAN solution on Brocade technology
	5.2 SAN design with Brocade 4Gb SAN switch modules
	5.2.1 Small-to-medium SAN topologies
	5.2.2 Building medium-to-large SAN topologies using the Brocade 4Gb SAN switch modules

	5.3 Brocade 4Gb SAN Switch Module configuration
	5.3.1 Fabric OS requirements
	5.3.2 Launching Brocade Web tools for initial setup

	5.4 IBM TotalStorage SAN32B-2 Switch setup and configuration
	5.4.1 Installing the SAN32B-2 in an EIA cabinet
	5.4.2 Configuring the SAN32B-2

	5.5 Building the Brocade SAN fabric
	5.5.1 Brocade ISL Trunking
	5.5.2 Dynamic Path Selection (DPS)
	5.5.3 Trunking criteria
	5.5.4 Connecting Brocade 4Gb SAN Switch Module to SAN32B
	5.5.5 Using ISL Trunking (optional)

	5.6 Connecting storage and servers to SAN fabric
	5.6.1 Connecting DS4800 to SAN fabric
	5.6.2 Connecting server blades to the SAN fabric

	5.7 Zoning to control device connectivity
	5.7.1 Zoning overview
	5.7.2 Managing zones with Web Tools
	5.7.3 Building zone aliases
	5.7.4 Building zones
	5.7.5 Building and enabling zone configurations
	5.7.6 Using additional zoning tools

	5.8 Mapping a logical disk to server blades
	5.8.1 Host definition
	5.8.2 Defining a host group
	5.8.3 Defining hosts
	5.8.4 Define storage partitioning


	Chapter 6. McDATA SAN configuration
	6.1 IBM BladeCenter configuration
	6.2 McDATA 4Gb Fibre Channel Switch Modules setup
	6.3 McDATA Edge Switch Sphereon 4400 configuration

	Chapter 7. QLogic SAN configuration
	7.1 IBM BladeCenter configuration
	7.2 QLogic Fibre Channel Switch 5602 setup and configuration
	7.3 QLogic 4Gb FCSM connectivity to 5602 and SAN environment
	7.4 IBM System Storage SAN10Q (QLogic SB1404) setup/configuration
	7.5 QLogic 4Gb FCSM connectivity to 1404 and SAN environment
	7.6 QLogic licenses

	Chapter 8. EMC Boot from SAN
	8.1 Boot from SAN overview
	8.2 Pre-configuration checklist
	8.3 Configuring Boot from SAN
	8.3.1 Configure the Primary Boot Path from the HS20 blade BIOS
	8.3.2 Fabric Zoning configuration

	8.4 Blade server F1 setup
	8.5 Configure a startup device for an HS40 blade only
	8.6 Blade server - QLogic HBA setup
	8.7 Configure McDATA Fibre Channel Switch Module
	8.8 EMC CLARiiON storage configuration
	8.9 Blade server - QLogic HBA setup continuation
	8.10 Linux operating system install
	8.11 Windows 2000/2003 operating system install
	8.12 Failover and multipath configuration
	8.13 Configuration steps to enable additional paths
	8.14 Re-register of the Storage Group on CX700
	8.15 QLogic Fibre Channel HBA BIOS configuration
	8.16 Failover test with EMC CX700 Storage
	8.16.1 EMC PowerPath Path Management via Linux

	8.17 Conclusion

	Chapter 9. TotalStorage DS4100, DS4700, and DS4800 Boot from SAN
	9.1 Overview of IBM BladeCenter Boot from SAN
	9.1.1 Cost reduction
	9.1.2 High availability
	9.1.3 Centralized management
	9.1.4 Redundancy
	9.1.5 Implementing Boot from SAN

	9.2 Boot from SAN configuration best practices
	9.3 Configuring Boot from SAN on TotalStorage DS4100
	9.3.1 Blade server F1 setup
	9.3.2 Blade server - QLogic HBA setup
	9.3.3 Configure the QLogic Fibre Channel Switch Module
	9.3.4 Storage
	9.3.5 Configuring Boot from SAN on DS400


	Appendix A. Brocade documentation and technical help
	Documentation for Brocade 4Gb SAN switch module
	Getting technical help for Brocade 4Gb SAN switch module

	Related publications
	IBM Redbooks
	Other publications
	Online resources
	How to get IBM Redbooks
	Help from IBM

	Index
	Back cover

